Contact Information

Triton© Headquarters and Manufacturing Plant
21405 B Street
Long Beach, MS 39560 USA
1 (866) 259-4866
(228) 575-3101 (fax)

Triton Technical Services Department
technsv@triton.com
1 (800) 259-6672 (opt 3)

Manufacturer warrants that the products delivered to a distributor will perform in accordance with the Manufacturer’s published specifications for thirteen months from date of shipment from Long Beach, MS.

Manufacturer’s warranty shall not apply to any damage resulting from abuse, negligence or accident, or to any loss or damage to the product(s) while in transit. Written notice and explanation of circumstances surrounding any claims that the goods have proved defective in material or workmanship shall be given promptly from the distributor to the manufacturer. No claim may be made, or action brought, by or through a distributor after the expiration of 14 months following any alleged breach of warranty.

Distributor’s sole and exclusive remedy in the event of defect is expressly limited to the replacement or correction of such defective parts by manufacturer at its election and sole expense, except there shall be no obligation to replace or repair items which, by their nature, are expendable.

These terms and conditions shall be governed by and construed in accordance with the provisions of the Uniform Commercial Code as adopted by the State of Mississippi.

For detailed warranty information by unit, Software End-User Agreement, access to ADA compliance statement, PCI v3 EPP certifications, card reader TQM certifications, EMV certifications and more, please visit www.tritonatm.com. Click Service & Support.

PURPOSE

This guide covers the operating information and installation procedures for Triton Connect 6.2 and SP1.

SCOPE

This manual applies to all service personnel involved in installing, configuring, or upgrading software on Triton ATMs nationwide and abroad.

APPLICATION

This user guide provides information, methods, and easy-to-follow instructions for operating Triton Connect 6.2 monitoring software. The manual contains information regarding initial set up of Triton Connect 6.2, navigation of important features, and basic usage instructions.
# Table of Contents

REVISION HISTORY ........................................................................................................... 2
PURPOSE ............................................................................................................................. 2
SCOPE ................................................................................................................................. 2
APPLICATION ...................................................................................................................... 2
GLOSSARY ............................................................................................................................ 12

## CHAPTER 1 - INTRODUCTION

WHAT IS TRITON CONNECT? ............................................................................................ 13
TERMINAL MANAGER ......................................................................................................... 14
DATA MANAGER .................................................................................................................. 15
CALL MONITOR ................................................................................................................... 15
CALL VIEWER ..................................................................................................................... 16
ALARM MONITOR ............................................................................................................... 16
WHAT IS NEW FOR TRITON CONNECT 6.2, SP1 ............................................................ 17
WHAT WAS NEW FOR TRITON CONNECT 6.1, SP1, SP2, AND SP3 .............................. 18
WHAT WAS NEW FOR TRITON CONNECT 6.0, SP1, SP2, SP3, SP4, AND SP5 ............... 19

## CHAPTER 2 - INSTALLATION

TRITON CONNECT SYSTEM CONFIGURATION ................................................................... 21
STANDALONE CONFIGURATION .......................................................................................... 22
   RECOMMENDED SYSTEM CONFIGURATIONS ................................................................ 22
   MODEM COMMUNICATIONS .............................................................................................. 23
INSTALL TRITON CONNECT ................................................................................................ 25
   STAND ALONE INSTALLATION ....................................................................................... 25
UPGRADE FROM TRITON CONNECT 6.1 SP3 .................................................................... 30
UPGRADE FROM TRITON Connect 6.0 ................................................................................ 34
UPGRADE FROM TRITON CONNECT 5.X OR 4.4 ................................................................. 39
SECURITY ............................................................................................................................. 42
   DEFAULT PASSWORDS ...................................................................................................... 42
TERMINAL MANAGER ACCESS .......................................................................................... 42
   USER-LEVEL PRIVILEGES ................................................................................................. 42
   CHANGING USER/SUPERVISOR PASSWORDS .................................................................. 43
COMLOC EXPIRATION ......................................................................................................... 43
   UPDATE COMLOC REMOTE CLIENT ............................................................................... 44
NEW SERVER INSTALLATION 6.2 ......................................................................................... 45
CLIENT INSTALLATION 6.2 ................................................................................................... 48
DASHBOARD ........................................................................................................................ 52
   STORE TERMINAL PARAMETERS IN SQL ....................................................................... 55
   TERMINAL CONFIGURATION OVERVIEW ...................................................................... 56
   SUPPORT LICENSING ....................................................................................................... 58
   MIGRATE JOURNAL ARCHIVES TO SQL ........................................................................ 59
   COMBINE TRITON CONNECT DATABASES ....................................................................... 59
CHAPTER 3 - CALL MONITOR

INTRODUCTION .............................................................. 60

OVERVIEW OF CALL MONITOR FUNCTIONS .................. 60

START THE CALL MONITOR ........................................... 62

SHUT DOWN THE CALL MONITOR .................................. 63

CONFIGURE MAXIMUM NUMBER OF CALL PROCESSORS ....... 63

ENABLE/DISABLE CALL VIEWER ....................................... 64

CONFIGURE DATABASE SETTINGS ..................................... 64

DATA MANAGER OPERATIONS ......................................... 65

START THE DATA MANAGER ........................................... 65

SCAN FUNCTION ............................................................ 66

HIDE THE DATA MANAGER ............................................. 66

SHUT DOWN THE DATA MANAGER .................................... 66

RESTART THE DATA MANAGER ......................................... 67

CONFIGURE TCP/IP SETTINGS .......................................... 67

FIRST JOURNAL TIMEOUT ................................................... 68

CONFIGURE TERMINAL ORIGINATED CALL EXPIRATION TIME .... 68

ADD AND REMOVE A CALL PROCESSOR ............................ 69

ENABLE/DISABLE EXTENDED STATUS TEXT UPDATING ......... 69

VIEW CALL PROCESSOR ACTIVITY IN A SEPARATE WINDOW .... 69

VIEW CALL PROCESSOR ACTIVITY IN A SINGLE FRAME ......... 70

DISPLAY HEX DATA ON SCREEN ....................................... 70

CAPTURE CALL PROCESSOR DATA TO A FILE .................... 70

REDIRECT THE CALL PROCESSOR DATA LOCATION ............... 70

RESERVE A CALL PROCESSOR FOR INCOMING CALLS ......... 71

CONFIGURE THE COMMUNICATIONS TIMEOUT DURATION ......... 71

DATA MANAGER .............................................................. 71

SAVE FLAT FILES ............................................................ 71

LOG DATA MANAGER ACTIVITY TO A FILE ....................... 71

OUTPUT TO CSV FILES .................................................... 72

OUTPUT TO TAPE FORMAT FILES ..................................... 72

EXPORT JOURNALS ........................................................... 72

SELECT A CALL PROCESSOR SETTINGS DIALOG ................. 72

CONFIGURE CALL PROCESSOR SETTINGS ......................... 73

CALL PROCESSOR (1 TO 20) ............................................. 73

ENABLE CALL PROCESSOR ............................................... 73

START A CALL PROCESSOR .............................................. 73

VIEW CALL PROCESSOR ACTIVITY .................................... 74

CONNECTION TYPE ......................................................... 74

RETRY CALLS WITH WRONG TID ....................................... 77

SHORT CHALLENGE/RESPONSE TIMEOUT .......................... 77

SHORT MODEM INITIAL TIMEOUT ...................................... 77

FORCE OLD ISO FORMAT (Z-180s) .................................... 77
CYCLE CALL PROCESSORS
RSF REMOTE STATUS FEED
CALL MONITOR AS A WINDOWS SERVICE
CHAPTER 4 - TERMINAL SETUP
INTRODUCTION
ADD A NEW TERMINAL
ACCESS THE ADD NEW TERMINAL FUNCTION
DATA-ENTRY FIELDS
DELETE A TERMINAL
ACCESS THE DELETE TERMINAL FUNCTION
SELECT A TERMINAL FOR DELETION
DELETE A TERMINAL
BULK DELETE TERMINALS
MODIFY A TERMINAL RECORD
ACCESS THE MODIFY TERMINAL FUNCTION
SELECT A TERMINAL RECORD TO MODIFY
MODIFY THE RECORD
VIEW TERMINAL SETUP
PURPOSE
ACCESS THE TERMINAL SETUP FUNCTION
SELECT A TERMINAL
SET THE PC TIME ZONE
PURPOSE
ACCESS THE PC TIME ZONE FUNCTION
CONFIGURE USER FIELDS
ACCESS CONFIGURE USER FIELDS FUNCTION
CHANGE A USER FIELD NAME
RESET THE USER FIELD NAMES
SORT TERMINALS BY
ACCESS/CHANGE THE ‘SORT TERMINALS BY’ SETTING
MODIFY STATUS MESSAGE SETTINGS
ACCESS THE MODIFY STATUS MESSAGE SETTINGS FUNCTION
ALTERNATE ACCESS METHOD
SCHEDULE DATABASE BACKUP
ACCESS THE SCHEDULE DATABASE BACKUP FUNCTION
REPAIR/COMPACT/REPLACE DATABASE
ACCESS THE REPAIR/COMPACT/REPLACE DATABASE FUNCTION
REPAIR/COMPACT DATABASE
REPLACE DATABASE WITH BACKUP
SERIAL FILE TRANSFER OVER TCP/IP
ADD NEW TERMINAL DIALOG
MODIFY TERMINAL DIALOG
CHAPTER 5 - GET TERMINAL DATA ................................................................. 97
INTRODUCTION ....................................................................................... 97
ACCESS THE GET TERMINAL DATA FUNCTION ..................................... 97
SELECT A TERMINAL ............................................................................. 97
SELECT MULTIPLE TERMINALS .......................................................... 98
SELECT A DATA OPTION ....................................................................... 99
GET TERMINAL PARAMETERS ............................................................... 99
GET JOURNAL DATA .............................................................................. 99
SYNCHRONIZE DATE & TIME ............................................................... 100
GET ERROR STATUS ............................................................................. 100
GET SELECTABLE COUPON DATA ....................................................... 100
GET SELECTED PARAMETERS ............................................................. 100
GET FILE FROM TERMINAL ............................................................... 101
CALL SCHEDULING ............................................................................... 101
EXAMPLE TABLE CALL SCHEDULING ................................................. 102

CHAPTER 6 - STATUS MONITORING ....................................................... 103
INTRODUCTION ....................................................................................... 103
VIEW TERMINAL STATUS ..................................................................... 103
ACCESS THE TERMINAL STATUS FUNCTION ..................................... 103
VIEW THE CALL LIST ........................................................................... 104
CALL DELAY .......................................................................................... 104
ACCESS THE CALL LIST FUNCTION .................................................... 104
VIEW CALL LIST INFORMATION ........................................................ 104
DELETE INDIVIDUAL CALL LIST ENTRIES ........................................ 106
CLEAR THE CALL LIST .......................................................................... 106
VIEW THE CALL ERROR LIST ............................................................. 106
ACCESS THE CALL ERROR LIST FUNCTION ....................................... 106
VIEW CALL ERROR LIST INFORMATION ............................................. 106
RESCHEDULING CALLS ......................................................................... 107
CLEAR THE CALL ERROR LIST ............................................................ 108
USING THE CALL VIEWER ...................................................................... 108
ACCESS THE CALL VIEWER ............................................................... 108
CONNECT TO THE CALL MONITOR .................................................... 109
MANAGE VIEWER WINDOWS .............................................................. 109
ALARM MONITOR .................................................................................. 110
ACCESS THE ALARM MONITOR FUNCTION ....................................... 110
VIEW ALARM MONITOR INFORMATION ............................................. 110
VIEW THE STATUS MESSAGE LOG ...................................................... 111
ACCESS THE STATUS MESSAGE LOG ............................................... 111

CHAPTER 7 USING FILTERS ..................................................................... 112
INTRODUCTION ....................................................................................... 112
THE FILTERS MENU ............................................................................... 112
ACCESS THE FILTERS FUNCTION ........................................................ 113
# Chapter 8 - Terminal Parameters

## Introduction

- **Access Terminal Parameters**
  - Select a Terminal - General Procedure
  - Select Multiple Terminals for Broadcast Feature
  - Set Terminal Parameters

- **Messages/Coupons**
  - About Messages and Coupons
  - Change Messages

- **Status**
  - About Status
  - Read-Only Values
  - Clear Errors and Reset the ATM
  - Terminal Service Status
  - View Vend Mate Status
  - NMD Status

- **ISO No./Owner Info**
  - Owner Identification
  - Override ISO Action
  - View / Modify ISO Numbers

- **EMV Settings**

- **Comm**
  - About Communications Parameters
  - Predial
  - Modem Init. String
  - Phone Numbers
  - Parity Selection
  - Remote Key Transfer (RKT) Support
  - About Terminal Totals

- **Terminal Totals**

- **Text Ad Screens**
  - About Text Ad Screens
  - Display of Text Ad Screens
  - Amounts
  - About Amounts

- **Cassette Stat**
REPORT FORMAT ................................................................. 172
TRANSACTION RESPONSE CODES ................................. 173
VIEWING ARCHIVED JOURNAL DATA ............................. 174
MASK JOURNAL DATA (PAN DATA) ................................. 175
USE JOURNAL ARCHIVE FILE FOR JOURNAL DATA REPORT 176
DATA MANAGER WILL RESPECT DATABASE SIZE LIMIT .... 176
End of Journal Data ......................................................... 176

CHAPTER 10 .............................................................................. 177

CHAPTER 11 - REPORT MANAGER ........................................... 178

INTRODUCTION ........................................................................ 178
ACCESSING THE REPORTS MANAGER ........................... 178

VIEWING REPORTS .............................................................. 178
CHANGING REPORT CRITERIA ........................................... 178
REPORT VIEWER ................................................................. 181
CALL FAILURES REPORT .................................................... 182
CALL LIST REPORT ............................................................ 182
CASSETTE CLOSE REPORT ................................................. 183
CASSETTE STATUS REPORT ............................................... 184
CHECK DIGITS ................................................................. 185
CHECK DIGITS TRIPLE DES ............................................... 185
COUPON REPORT ............................................................... 186
DENIED TRANSACTIONS REPORT .................................... 187
DAY CLOSE REPORT .......................................................... 187
DOWN TIME PER ERROR ................................................... 188
EMV DATA ......................................................................... 188
ISO NUMBERS REPORT ....................................................... 188
JOURNAL DATA REPORT .................................................... 189
JOURNALS DOWNLOADED .............................................. 190
JOURNALS NOT DOWNLOADED ........................................ 190
MOST COMMON STATUS MESSAGES ............................ 190
SCHEDULED CLOSE REPORT ............................................. 190
TERMINAL CONFIGURATION REPORT ............................ 191
TERMINAL DOWN TIME REPORT ...................................... 191
TERMINAL FILES ............................................................... 191
TERMINAL STATUS REPORT .............................................. 191
TERMINAL STATUS MESSAGES REPORT .......................... 192
TERMINAL TEXT MESSAGES ............................................. 192
TERMINAL TOTALS REPORT .............................................. 192
TRITON CONTACT NUMBERS ............................................ 193
VERSION NUMBERS REPORT ........................................... 193

CHAPTER 12 - SOFTWARE DOWNLOAD ................................. 194

INTRODUCTION ................................................................. 194
ACCESS THE SOFTWARE DOWNLOAD FUNCTION ................ 194
DOWNLOADING SOFTWARE ................................................................. 194
EPROM ACCESS CODE ......................................................................... 194
DOWNLOAD OPTIONS Z180 ATM ONLY ................................................ 195
INCLUDE EEPROM PARAMETERS ......................................................... 195
RECOGNIZING TERMINAL TYPES .......................................................... 195
ERASE EEPROM PRIOR TO LOAD ....................................................... 195
FORCE TRICOMM DOWNLOAD ............................................................. 195
TRICOMM DOWNLOADS ..................................................................... 195
LOAD FILE FORMAT ............................................................................. 196
TERMINAL SPECIFIC LOAD FILE SELECTION ....................................... 196
FILE FORMAT VALIDATION .................................................................. 196
CHAPTER 13 - AD DESIGNER ................................................................. 197
INTRODUCTION ...................................................................................... 198
AD SCREEN CHARACTERISTICS ............................................................ 198
AD SCREEN SIZE .................................................................................. 198
ACCESSING THE AD DESIGNER ........................................................... 199
AD DESIGNER FEATURES ..................................................................... 199
CREATING TEXT ...................................................................................... 200
CREATING AN AD SCREEN ................................................................... 201
GRAPHIC SIZES .................................................................................... 204
CHAPTER 14 - COUPON UTILITY ............................................................ 206
INTRODUCTION ...................................................................................... 206
ACCESSING THE COUPON UTILITY ..................................................... 207
COUPON IMAGE CHARACTERISTICS .................................................... 207
COUPON UTILITY FEATURES ................................................................. 207
DISPLAY WINDOW .................................................................................. 208
CREATING A TRITON CONNECT COUPON FILE ...................................... 208
CHAPTER 15 - SSL SUPPORT ................................................................. 211
INTRODUCTION ...................................................................................... 211
CREATING A CERTIFICATE SIGNING REQUEST (CSR) ......................... 212
IMPORT CERTIFICATE SIGNING REQUEST ......................................... 213
SELECT CERTIFICATE FOR SSL CONNECTIONS .................................. 214
SET PORT FOR SSL CONNECTIONS .................................................... 214
ENABLE OR DISABLE SSL ..................................................................... 215
ACCEPT SSL CONNECTION REQUESTS .............................................. 215
TERMINAL PARAMETERS TABLE .......................................................... 216
### GLOSSARY

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>Alternating Current</td>
</tr>
<tr>
<td>ATM</td>
<td>Automated Teller Machine</td>
</tr>
<tr>
<td>CAT-5</td>
<td>Category 5 (ethernet)</td>
</tr>
<tr>
<td>EMV</td>
<td>Europay, Mastercard, and Visa</td>
</tr>
<tr>
<td>EPP</td>
<td>Encrypting Pin Pad</td>
</tr>
<tr>
<td>FCC</td>
<td>Federal Communications Commission</td>
</tr>
<tr>
<td>PCI</td>
<td>Payment Card Industry</td>
</tr>
<tr>
<td>SSL</td>
<td>Secure Socket Layer</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>TLS</td>
<td>Transport Layer Security</td>
</tr>
</tbody>
</table>
CHAPTER 1 - INTRODUCTION

WHAT IS TRITON CONNECT?

Triton Connect allows users to remote-manage one or many Triton Systems ATMs. Advantages include increased efficiency and reduced costs associated with managing your ATMs. Triton Connect provides a proven ATM monitoring solution, which currently manages thousands of Triton ATMs throughout the United States and worldwide.

FLEXIBILITY

Install the Triton Connect software on a single PC as a stand-alone configuration for a single point of administration, or install on multiple PCs as a network configuration which allows the distribution of management tasks to multiple personnel. Triton Connect can manage a fleet of ATMs of virtually any size.

CONVENIENCE

Triton Connect software enables the user to perform a wide range of monitoring and control functions from the convenience of a central location. In many cases, the software eliminates the cost of a technician traveling to the terminal location to perform configuration or data retrieval functions. Triton Connect can access terminals via dial-up telephone service, TCP/IP land-line, or wireless connections.

SECURITY

Multiple levels of password protection prevent unauthorized individuals from using Triton Connect. The software uses cryptographic protocols, such as SSL or TLS certificates, which provides authentication and data encryption between servers, terminals, and the Triton Connect application.

FEATURES

Triton Connect offers a wealth of features to maximize the value of your investment in Triton Systems ATM products. The software application groups these features within the following program blocks below.

- Terminal Manager
- Data Manager
- Call Monitor
- Call Viewer
- Alarm Monitor
**TERMINAL MANAGER**

The Terminal Manager application supports remote terminal configuration, data retrieval and storage, and status monitoring.

**REMOTE CONFIGURATION**

The Terminal Manager allows the user to set, monitor, and change terminal parameters from the convenience of a PC. The following lists examples of these parameters.

- Fast Cash Amounts and Withdrawal Limits
- Text or Graphics Advertising Screens
- Display and Coupon Message Text
- Surcharge Amounts

**DATA RETRIEVAL AND STORAGE**

The Terminal Manager contains a powerful feature to retrieve, store, and manipulate terminal data in databases. The following lists examples of the types of data maintained in the databases.

- Terminal Identification information
- Terminal Configuration parameters
- Electronic Journal transaction data

**STATUS MONITORING**

Triton Connect can schedule periodic calls to the terminals and retrieve the most current status information. The terminal sends detected error conditions to Triton Connect in real time. Once stored in the database, the appropriate Terminal Manager function retrieves the data and the user can view it at their convenience. The following lists examples of available status information.

- Terminal Error conditions.
- Cassette Status (cash loaded, remaining).
- Status of Last Dispense operation.
The Data Manager application manages many of the data-processing functions previously handled by the Call Monitor and Call Processors, thus improving the speed and functionality of those applications.

**CALL MONITOR**

The Call Monitor gives Triton Connect the ability to calls the terminals—call-out operations—and to receive calls from terminals—call-in operations—using a combination of dial-up, TCP/IP, or wireless connections. The Call Monitor exercises overall control of all call activity by assigning each communication line to a Call Processor. Each Call Processor monitors and controls the calling activity of its associated line. The Call Processor will make calls to terminals, answer calls from terminals, provide indications of the activities taking place during a call, and terminate the connection after a call. The Call Monitor gives a standalone PC the ability to handle a high volume of call activities.
CALL VIEWER

The Call Viewer displays the activities of all active Call Processors from a licensed workstation on the network. A Call Processor acts as an interface between the Call Monitor application and the communications hardware; modems, telephone lines, and TCP/IP.

ALARM MONITOR

The Alarm Monitor checks incoming calls for alarm conditions reported by the terminals, and provides visual indications of such conditions. The Terminal Manager maintains a printable report of the alarm conditions.
WHAT IS NEW FOR TRITON CONNECT 6.2, SP1

The following lists the features either new or modified to the latest release of Triton Connect 6.2 SP1:

1. Adds ability to show new EMV details in Journal.
2. Adds support for Advanced Status Monitoring.
3. Verifies available space before sending software update.
4. Adds support for internal anti-skim card reader.
5. Adds ability to skip to particular journal record.
6. Applies filter functionality to dashboard.
7. Adds support for contact-less reader.
8. Adds support for PNG AD-graphic.
10. Adds ability to schedule a call to the ATM that will wait for the ATM to call in.
12. Resolves Filter by parameters issue corrected.
14. Resolves Get Terminal Data drop down box when setting up a broadcast issue corrected.
15. Resolves Unexpected behavior while ATM is in TC generated error state.
17. Resolves NMD Status button intermittently appears on wrong tab.
18. Resolves Terminal Parameters, Surcharge tab: Tiered Surcharge Add/Delete menu available and active from Withdrawal/Balance dialogs.
19. Resolves Test connection functionality checked wrong location for reports.
20. Resolves Balance surcharging not properly ported to SQL for full extended amounts.
21. Resolves Issue with migrating parameters to SQL with Australian regional settings.
22. Resolves Run-time error when building broadcast list for changing terminal parameters.
23. Resolves Mark entries as printed checkbox has no effect.
24. Resolves Setting the cycle call processors amount to 0 causes unstable behavior.
25. Resolves Keyboard short-cut for pasting TID did not work.
26. Resolves Configurable status history limit.
27. Resolves Error message generated if error status received for an ATM prior to receiving parameters for an ATM.
28. Resolves EPROM Access Code could be erroneously changed.
29. Resolves Overflow error may be generated when rescheduling a call from error call list.

The following lists the features either new or modified to the latest release of Triton Connect 6.2:

1. Adds ability to run Call Monitor as a Windows service.
2. Adds last contacted date and time from Triton Connect to the Cassette Status report.
3. Adds support for TLS1.2 between TC and SQL.
4. Adds file date and time to Terminal Files report for when files were created or last modifies.
5. Adds more SSL security options for email alerts.
6. Updates ISO Numbers report to include a column for ISO Value.
7. Adds support for Tiered Surcharging.
8. Adds a message when attempting to reset error condition 924 – Counterfeit Note Detected.
9. Journal Data Changes: Due to changes in ATM software version 4.2.2 and later, Triton Connect 6.2 is needed to correctly reflect the Day Close settlement amount and Cassette Close multiple amounts properly in the journal. Earlier versions will show N/A for these fields.
10. Corrects Terminal Status Reports excluding TID.
11. Corrects the confusion of checkboxes indicating the selected user’s permissions would not be updated properly in some circumstances.
12. Resolves: Cannot change max withdrawal amount on US dollar-dispensing ATMs in Mexico.
13. Resolves sporadic issue where changing passwords on ATM from Triton Connect would fail.
14. Resolves calls erroneously rejected due to no available call processors even though the call processors were available.
15. Resolves: Erroneously message “Warning voltage must not be greater than detection voltage!” received when attempting to change and save a value on the Extended Parameters screen.
16. Resolves the Incorrect behavior when replacing a z180 ATM with a CE-based ATM.

**WHAT WAS NEW FOR TRITON CONNECT 6.1, SP1, SP2, AND SP3**

The following lists the features either new or modified to the latest release of Triton Connect 6.1 SP3:
1. Adds support for TLS 1.2 between Triton Connect and SQL Server.

The following lists the features either new or modified to the latest release of Triton Connect 6.1 SP2:
1. Updated the background graphic on the main Terminal Manager.
2. Adds a new report detailing how long terminals were out of service with individual error codes across a selectable date range.
3. Restores a feature to allow the user to view and modify EFLAG values.
4. Added message showing the IP Address of the client attempting to connect on the port configured for SSL.
5. Resolves the issues of individual call processors could cause the CPU usage to spike and remain maxed for the duration of the TCP/IP connection.
6. Resolves software downloads to a Z180 terminal starting at the wrong location after a broken connection resumed.
7. Resolves empty message, welcome message, causing a partial display of the terminal configuration overview.
8. Resolves missing terminal IDs when attempting to locate a terminal for a software download broadcast.
9. Resolves issues of incorrect journal results based upon a PC with a date range set in day/month/year format.
10. Resolves the issues of an OCX file not registering properly during installation.

The following lists the features either new or modified to the latest release of Triton Connect 6.1 SP1:
1. Resolves the issue of Triton Connect moving a scheduled call to the error call list, if the PC language was set to Spanish.
2. Resolves the issue of Triton Connect broadcasting a load file to multiple ATMs.

The following lists the features either new or modified to the latest release of Triton Connect 6.1:
1. Adds a dashboard to view terminal status, the call list, as well as the ability to view call processors.
2. Parameters will be stored in SQL. If default settings are used and the automatic database upgrade processes are performed at the end of installation, the parameters will automatically be copied to SQL.
3. More information has been added to Triton Connect’s Configuration Overview for terminals. The data added to the overview is as follows: Terminal Messages, EMV Info, Coupon Info, Default Transaction, Default Account, Default Language, Scheduled close enabled status and time, and Screen File.
4. Adds support for licensing based on the number of terminals in Triton Connect.
5. Removes Status history limit that resulted in lost and erroneous reports.
6. Beginning with this release of Triton Connect does not need to be uninstall to upgrade.
7. Resolves PIN Unlock reported incorrectly in Triton Connect when viewing journals.
8. Resolves not able to view entire dispenser error details in Terminal Status Messages report.
9. Resolves Call Processors set for outgoing only, then accepts incoming calls.
10. Corrected Terminal Manager crashes if Config Overview is minimized.
11. Updated wording on the Mail Server Settings dialog, the wording for the from address was updated from “Email Address for Undeliverable Mail” to “From Email Address”.
12. Resolves potential problem, If the ‘Use Incoming IP Address’ option is enabled for a terminal, under certain conditions.
circumstances there is a possibility that the wrong IP address could be updated for the ATM.

13. Changes: UAC will no longer be disabled nor will the user require administrator privileges. During the installation and upgrade process, a directory called TritConn will be created in the ProgramData folder and all users will be granted full control of the TritConn directory. If the automatic upgrade processes are completed at the end of installation, a copy of all files that Triton Connect both reads and writes to will be made and placed in the new ProgramData\TritConn directory, and those files will be used from that location.

14. Since the archive journals functionality no longer applies, the option was removed from the File menu.

15. Resolves the Journal Data Report from an archive functionality not working.

**WHAT WAS NEW FOR TRITON CONNECT 6.0, SP1, SP2, SP3, SP4, AND SP5**

The following lists the features either new or modified to the latest release of *Triton Connect 6.0 SP5:*

1. Includes support for ATMs equipped with an anti-skim card reader.
2. Resolves the issue of Triton Connect calling an ATM more than the set number of retries for failed calls.
3. Resolves the issue of missing information from exported .csv file about bills dispensed from cassettes 2, 3, and 4 when using a G60 recycling dispenser.
4. Resolves EMV Data Report not showing ATM with EMV enabled, but all EMV applications are disabled.
5. Resolves the issue of not properly merging two databases using the Triton Connect Database Utility.
6. Resolves the issue of overflow error when attempting to place a call through Triton Connect.
7. Resolves the issue of Call Monitoring crashing under a heavy load of TCP/IP connection requests.

The following lists the features either new or modified to the latest release of *Triton Connect 6.0 SP4:*

1. Includes all Optional Screens in Config Overview omitted in the Triton Connect.
2. Fixes the issue of getting an error message when selecting a file for a software download.
3. Fixes the issue error occurring when pasting in a large number of ISO bins.
4. Resolves the issue of an error indicating a database item was not found when a flat file is being processed.
5. Resolves the issue of the new price per gallon not being sent when a price per gallon update is rescheduled.
6. Allows the perimeters to be viewed or changed when using full extended amounts on the ATM.
7. Includes the Triton Connect Manual in installation.
8. Increases the number of ATMs for a Bulk Delete.
9. Resolves the issue of the journal table remaining after an ATM was deleted.
10. Resolves EMV data not copied when two databases are merged using the Triton Connect Database Utility.

The following lists the features either new or modified to the latest release of *Triton Connect 6.0 SP3:*

1. Performance enhancements when opening and performing operations within the Terminal Manager.
2. Resolves error report stating no data is available when attempting to run Triton Connect numbers report.
3. Resolves the issue of an error message given, preventing a file from being selected to send to the ATM.
4. Fixes the problem of not populating fields for the SPED and dispenser during the Version Numbers Report.
5. Resolves the issue on the Call Viewer crashing when being restored after being minimized.
6. Resolves price per gallon not sent when call to update price per gallon rescheduled from the call error list.

The following lists the features either new or modified to the latest release of *Triton Connect 6.0 SP2:*

1. Increases the number of ATMs for a Bulk Delete.
2. Gives email alerts higher priority than calls to an ATM.
3. Added support for T9 error codes.
4. Added the ability to send load files to CE6 and CE7 ATMs.
5. Added maximum withdraw amount ISO. ATM support for this is dependent upon ATM software version.
6. Prohibits emails erroneously sent to ATM IP address.
7. Prohibits calls to ATMs from being placed at incorrect times.
The following lists the features either new or modified to the latest release of **Triton Connect 6.0 SP1**:  
1. Increases the number of ATMs for a Bulk Delete.  
2. Adds ability to enable or disable SSL for sending email alerts and accepts self-signed certificates.  
3. Removes journals from tc_main after migration.  
4. Resolves the issue of Triton Connect not placing a call without restarting the Call Monitor.  
5. Resolves every other record not printed when journals printed to paper in extended format.

The following lists the features either new or modified to the latest release of **Triton Connect 6.0**:  
1. Increases the number of ATMs for a Bulk Delete.  
2. Ability to filter by parameters.  
3. Support for email with user name and password.  
4. Ability to combine Triton connect databases.  
5. Terminal Manager expiration.  
6. Added support for more users.  
7. Added more settings for user permissions.  
8. Added ability to use Comloc on network.  
9. Ability to migrate journal archives to SQL Support enabling /disabling protocol reversals.  
10. Ability to import ATM user password from file.

**END OF INTRODUCTION**
Triton Connect has two deployable configurations:
1. Network.
2. Standalone

**NETWORK CONFIGURATION**

See the Network Configuration diagram below to view a typical network configuration. For installation purposes the user needs to understand the roles played by the Database File Server, Operator Workstation (or Client PC) and the Call Monitor PC.

**DATABASE FILE SERVER**

The software installs Triton Connect into the Call Monitor PC and creates databases accessible to the client and Call Monitor PC. Allowable network PCs will access and update data to the databases.

**MAIN APPLICATION PC**

The Main Application PC manages the processing of calls across the communication interfaces connecting the Triton Connect host installation to the remote terminals. The software installs Terminal Manager (TM), Alarm Monitor (AM), and Call Monitor (CM) onto the Main Application PC.

**CLIENT OPERATOR WORKSTATION PC**

Each Operator Workstation needs the program code, which performs terminal monitoring and control operations via the Terminal Manager and Alarm Monitor applications.
STANDALONE CONFIGURATION

See the diagram below. In a standalone configuration, a single PC hosts all the Triton Connect applications and associated functions, to include database storage and call monitoring.

The standalone configuration handles communications with remote terminals via TCP/IP, one modem, or a modem pool as shown in the diagram. The Modems are telephone modems with Ethernet connections.

RECOMMENDED SYSTEM CONFIGURATIONS

Triton systems has tested and recommends the following PC hardware configurations for Triton Connect 6.2.

**Note**

Triton Connect 6.1 added support for TLS 1.2. If the PC supports this version of TLS, it will automatically be generated. Windows versions prior to 7 do not support TLS 1.2.

Network Configuration
(Used for database storage only)

2. Window Server 2008 thru 2019 to operating system.
3. Pentium 4 equivalent or faster CPU.
4. 4 GB or higher RAM.
5. 20GB Free hard drive space.
6. Dedicated a USB port (for Comloc device).

Operator Workstation
(Manages the Terminal Manager and Alarm Monitor applications)

2. Pentium 4 equivalent or faster CPU.
3. 4 GB or higher RAM.
4. 20GB Free hard drive space.
5. Dedicated USB port (for Comloc device)
Main Application PC  
(Manages the Call Monitor application)

2. Pentium 4 equivalent or faster CPU.
3. 4 GB or higher RAM.
4. 20GB Free hard drive space.
5. Dedicated a USB port (for Comloc device)

Standalone PC Configuration

Triton Connect 6.1 allows it to perform in a standalone configuration; however, the additional enhancements to the current release makes more demands on the system hardware. The minimum system requirements for a single PC/single modem configuration are listed below.

2. Pentium 4 equivalent or faster CPU.
3. 4 GB or higher RAM.
4. 20GB Free hard drive space.
5. Hard disk with a minimum of 20GB of free space.
6. Dedicated a USB port (for Comloc device).

MODEM COMMUNICATIONS

MODEM SELECTION

In either a network or standalone environment, the type of modem to use for dial-up communications is an important consideration. See the next page for information concerning modem selection.

Each telephone line connected to Triton Connect will require a modem as the interface between the analog telephone system and the PC. Triton Connect supports either the Universal Serial Bus (USB) or standard modems with RS-232 serial interface protocol.

Most modern PCs have one or two USB and/or serial ports, accessible from the rear panel of the main unit. If the need for additional telephone lines exceed the number of available PC ports, connect a multi-port interface card or device to the PC and add addition lines to the multi-port.

**Note**
Triton Connect supports communications using up to 20 modem connections.

USB MODEMS

If the user requires USB modems, they should only connect to USB ports or a USB hub. The hub allows multiple modems connections to a single physical PC port. Triton does not recommend the use of any USB to Serial adapters due to the potential of increase of data corruption.
STANDARD MODEM

If using standard serial modems instead of USB modems, add a multi-port adapter module for additional ports. With a variety of multi-port, I/O devices on the market, many fail the demands of large scale serial communications with Triton Connect. If the PC needs a multi-port adapter, DigiAccelePort 8em PCI Host Adapter meets the performance requirements.

Follow the manufacturer’s instructions for installing and configuring the multi-port hardware.

MODEM SELECTION

Triton recommends the following modems, which have been tested with Triton Connect.

1. 3COM (U.S. Robotics) Courier V Everything 56K (RS-232 serial)
2. MultiTech Systems MultiModem V.90 Data/Fax Modem with USB.
3. MultiTech Systems MultiMobile 56K Data/Fax Modem (USB)

These external modems connect to the PC using either a RS-232 serial cable (3COM V Everything) or a USB cable (Multitech MultiModem and MultiMobile modems.)

Triton recommends the US Robotics model 5699B for PC internal slots.

Caution

For correct operation, the dip switches on the bottom of the 3COM V Everything modem chassis must match the settings shown below.

**Note**

Whichever modem selected, insure the PC has the latest modem drivers available for your operating system.

MODEM CONFIGURATION SWITCHES

<table>
<thead>
<tr>
<th>SWITCH #</th>
<th>FUNCTION</th>
<th>OFF</th>
<th>ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DTR NORMAL</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>VERBAL RESULT CODES</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>DISPLAY CODES</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>4</td>
<td>ECHO OFFLINE COMMANDS</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>SUPPRESS AUTO ANSWER</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>6</td>
<td>NORMAL CARRIER DETECT</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>DISPLAY ALL RESULT CODES</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>ENABLE AT COMMAND</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>DISCONNECT WITH +++</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>LOAD NVRAM DEFAULTS</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
INSTALL TRITON CONNECT

This section covers the actions needed to install the Triton Connect program on your network or a standalone system. You must have a USB Comloc device.

Caution

The Triton Connect feature of the ATM must be ENABLED and configured with the correct phone numbers or TCP/IP information to allow communications with your Triton Connect host system. See your ATM Operation Manual for instructions on enabling the Triton Connect feature and entering the appropriate information.

STAND ALONE INSTALLATION

These instructions perform a fresh Triton Connect installation on a single PC. Triton Connect will update the Windows Installer and .Net Framework, if required. SQL Server 2012 R2 Express available with this program.

Perform the following steps to install this release of Triton Connect as a single-PC new installation.

1. Run setup.exe for this release of Triton Connect as administrator.

2. When presented with requirements of additional software, click the Install button.

3. When prompted to install or upgrade SQL Server Express, click the Yes button.

4. Proceed with the SQL Server 2012 Express installation with default options.
Read and accept the license terms. Click the Next button to continue.

ON the next six screens, leave the default options and click the Next button.
5. On the welcome to the installer Wizard screen, click the Next button.

6. Read and accept the license agreement. Click the Next button.

With SQL install complete, click the Close button to continue the Triton Connect installation.

7. Enter User Name and Organization (optional). Click the Next button.
8. Leave installation type as *Complete* and click the *Next* button.

9. Click the *Install* button.

10. Once complete, click the *Finish* button.

11. On the Comloc installation utility, select **USB Dongle GREEN**, for Dongle Type and **Standalone, RED**, for Installation Type.

12. Click *Begin Install* and follow any on-screen instructions.

13. When prompted to perform automatic database upgrade processes, click the *Yes* button.
14. When prompted to perform parameter migration with default settings, click the **Yes** button.

15. Once the automatic upgrade and migration processes are complete, click the **Migrate** button for journal data.

16. Once the journal data migration has completed, **RED**, close the Triton Connect Database Migration Utility.

17. Triton Connect is ready to use.
UPGRADE FROM TRITON CONNECT 6.1 SP3

Note: These instructions assume that SQL Server Express 2008 R2 is installed as included in a previous Triton Connect installation. These instructions assume that the existing SQL Server instance will be upgraded to SQL Server Express 2012. However, Triton Connect is still capable of using SQL Server Express 2008 R2. If TLS1.2 between SQL Server and Triton Connect is not required, the upgrade to SQL 2012 Express may be skipped.

Perform the following steps to upgrade to Triton Connect 6.2.

1. Run setup.exe for this release of Triton Connect as administrator.

2. When prompted to perform an upgrade of Triton Connect, click the Yes button.

3. When presented with the screen listing other software requirements, click the Install button.

4. When prompted to upgrade SQL 2008 Express to SQL 2012 Express, click the Yes or No button based on your needs.

5. If upgrading SQL 2008 Express to SQL 2012 Express, follow the on-screen prompts.

Read and accept the license terms. Click the Next button to continue.
On the next 6 screens, leave the default options selected and click the **Next** button. On the sixth screen click the **Close** button.
6. Once the installation process has returned to the Triton Connect installer, the SQL Server Native Client 11 will be installed in the background, if needed.

7. To install Triton Connect, click the Next button.

8. When the Wizard completes the install, click the Finish button.

9. Click the Exit button when the Comloc install utility opens.
10. When prompted to perform automatic database upgrade processes, click the **Yes** button.

11. Once the database upgrade completes, close the **Triton Connect Database Migration Utility**.

12. Triton Connect should now be ready to run.
UPGRADE FROM TRITON CONNECT 6.0

This process assumes a single-computer installation with SQL Server Express 2008 installed on the local PC. Upgrading to SQL Server 2012 Express is optional.

Perform the following steps to upgrade to Triton Connect 6.2.

1. Run setup.exe for currently installed Triton Connect 6.0.
2. Click the Next button to continue to the Program Maintenance Screen.
3. Select Remove, then click the Next button.
4. Click the Remove button.
5. Click the Finish button once the uninstall process is complete.
6. Run setup.exe for this release of Triton Connect 6.2 as administrator.
7. When presented with the screen listing other software requirements, click the **Install** button.

8. When prompted to upgrade SQL Server 2008 Express to SQL Server 2012 Express, click the **Yes** or **No** button based on your needs.

9. If upgrading SQL Server Express versions, follow the on-screen prompts.

Read and accept the software license, then click the **Next** button to continue.
10. With the completion of the SQL Server Express installation, click the Close button to continue the Triton Connect installation.

11. Once the installation process has returned to the Triton Connect installer, SQL Server Native Client 11 will be installed in the background, if needed.

12. When the Welcome to install the Triton Connect screen opens, Click the Next button.
13. Read and Accept the license agreement. Click the **Next** button.

14. Enter **User Name** and **Organization** (optional). Click the **Next** button.

15. Select **Complete** and click the **Next** button.

16. To install Triton Connect, Click the **Install** button.
17. When the Wizard completes the install, click the Finish button.

18. Click the Exit button when the Comloc install utility opens.

19. When prompted to perform automatic database upgrade processes, click the Yes button.

20. When prompted to perform parameter migration with default settings, click the Yes button.

21. Once database upgrade and migration processes are complete, the Triton Connect Database Migration Utility can be closed.

22. Triton Connect should be ready to run.
UPGRADE FROM TRITON CONNECT 5.X OR 4.4

These instructions assume a single-PC installation upgrade from 5.x or 4.4 to this release of Triton Connect. These instructions also assume that the Comloc driver is already installed.

Microsoft SQL Server will not successfully install on a disk that is either compressed or encrypted.

**Note**

If upgrading from a Triton Connect version prior to 4.4, The user must install either 4.4 or 5.x prior to installing this release.

Perform the following steps to upgrade to Triton Connect 6.2.

1. Make a backup copy of the contents of the Triton Connect directory (optional).
2. Run setup.exe for this release of Triton Connect as administrator.
3. If presented with requirements of additional software, click the Install button.
4. Install SQL Server Express, if needed, using default settings.
5. At the initial Triton Connect install Wizard screen click the Next button.
6. Read and accept the license agreement. Click the Next button.
7. Enter a User Name and Organization (optional). Click the Next button.

10. In the previous image, click the down arrow for Database and select “This feature will not be available.” Click the Next button.

11. Click the Install button.

8. Select Custom and click the Next button.

9. Select Main and verify that the “Install to” path is the location of the previous Triton Connect version. Click “Change…” to change the install location if needed.

12. Once completed, click the Finish button.
13. Click the **Exit** button, when the Comloc install utility opens.

14. When prompted to perform automatic database upgrade processes, click the **Yes** button.

15. When prompted to perform parameter migration with default settings, click the **Yes** button.

16. Once the automatic upgrade and migration processes are complete, click the **Migrate** button for journal data.

17. Once the journal data migration is completed, the word “Done” appears at the end of the list. Close the Triton Connect Database Migration Utility.

18. Triton Connect is ready to use.
SECURITY

Triton Connect uses a two-level password protection scheme. The first level provides five User Passwords (User 1, User 2, User 3, User 4, and User 5), and grants access that does not require control of sensitive features such as software download or terminal password management.

The second, higher level password referred as the Supervisor Level Password, gives complete control to trusted personnel whose responsibilities require full access to all Triton Connect features.

DEFAULT PASSWORDS

The default Supervisor password is: 'connect'.
The default User 1 password is: 'triton'.
The default User 2 password is: 'software'.
Password is lower case without the parenthesis.

The supervisor level password will assume its default value of 'connect' until modified.

Caution

Remember to change the default passwords as soon as possible after completing the installation.

TERMINAL MANAGER ACCESS

A password entry window appears, when the Terminal Access Manager application starts for the first time.

At this point, you have the option of entering the Terminal Manager as a User, or as a Supervisor. The level of access granted depends upon the User ID: User 1, User 2, User 3, User 4, User 5, or Supervisor.

USER-LEVEL PRIVILEGES

Individuals with User 1 or User 2 access cannot perform these actions below.

1. Cannot change the Supervisor password.
2. Cannot perform software downloads.
3. Cannot alter certain terminal parameters, which depends upon the operating software installed in the terminal.

The above functions can only be performed by personnel with Supervisor access.

The User ID appears in the title bar of the Terminal Manager window.
CHANGING USER/SUPERVISOR PASSWORDS

After installing Triton Connect, immediately change the default passwords. Enter the Terminal Manager using the Supervisor password. Click the Security option on the menu bar. The Manage User Account(s) screen should appear.

Under **Select User**: use the down arrow to select a User. Click the Change Password option. Enter a new password in the top text box. On your keyboard press the Tab key and enter the new password in the Verify New Password text block. Click the **OK** button.

A successfully written password to the Comloc device generates a ‘User#/Supervisor password updated’ message or a ‘Did not change password’ message. Click the **OK** button to dismiss the message box.

COMLOC EXPIRATION

Call Monitor 6.0 and higher will expire according to the expiration on the Triton Connect Comloc. After expiration, the Call Monitor will not operate until the Comloc expiration has been updated. The Terminal Manager will continue to function as normal after expiration.

When the license for the Comloc’s expiration date falls to 30 days or less, the Call Monitor will display a notice upon the startup, or if the Call Monitor remains open for an extended period, the notice appears once per day.

Notice of expiration at 11 days or less, top image. Notice of expired Comloc license, bottom image.
To extend the expiration date, the Comloc needs an ability for remote updates. The Triton Connect installation contains a Comloc Remote Update Client utility. The user must contact Triton Technical Support to use the utility.
Perform the following steps to install as a server.

1. Run setup.exe for this release of Triton Connect as administrator.

2. If presented the requirements of additional software, click the Install button.

3. When prompted to install SQL Server Express, choose based on if this or another version of SQL Server will be used. If installing this version, Click the Yes button and proceed through setup according to your environment.

4. For the Triton Connect installation type, choose Custom and click the Next button.

**Note**

This installation is for a server that will host the database and the Comloc. Client computers will run the Triton Connect application and connect to this server to access the databases and the Comloc. This document cannot cover the SQL server configuration due to the server's varying operating environment. Use either the version of SQL Server Express included with the Triton Connect installation or a full version of SQL Server. This server may or may not run the Triton Connect application. These instructions assume a fresh installation of Triton Connect.

These instructions do not cover setting up a shared directory on a network or other required processes depending on operating environments. These instructions assume that the default SQL connection string and the default database and installation paths are all applicable.

**Caution**

Microsoft SQL Server will not successfully install on a disk that is either compressed or encrypted.
5. Verify/update the installation path and click the Next button.

6. Click the Install button.

7. Once complete, click the Finish button.

8. For Dongle Type select **USB Dongle RED**.
9. For Installation Type select the **Server** radio button, **PURPLE**.
10. Click the Begin Install button and follow the on-screen instructions.

11. Click the Close button on success message.
12. When prompted to perform automatic database upgrade processes, click the **Yes** button.

13. When prompted to perform parameter migration with default settings, click the **Yes** button.

14. Once the automatic upgrade and migration processes are complete, click the **Migrate** button for journal data.

15. Once the journal data migration has completed, close the Triton Connect Database Migration Utility.

16. The server setup should now be complete.
Perform the following steps to install the client installation.

1. Run setup.exe for this release of Triton Connect as administrator.

2. If presented the requirements of additional software, click the Install button.

3. When prompted to install or upgrade SQL Server Express, click the No button.

4. On the Welcome to the Installer screen, click the Next button.

5. Read and accept the license agreement, click the Next button.
6. Enter a *User Name and Organization* (optional). Click the **Next** button.

7. Leave installation type as **Complete**. Click the **Next** button.

8. Click the **Install** button.

9. Once complete, click the **Finish** button.
10. When the Comloc install utility opens, click **Client** under **Installation Type**, RED rectangle.

11. Click **Set Server (Optional)** button in the **Server Selection for Client** section ORANGE rectangle.

12. Click the **Manual server selection by Name OR IP Address** radio button and enter the IP address of the Comloc server.

13. Click the **OK** button.

14. Click the **Begin Install** button and follow any on-screen instructions.

15. When prompted to perform automatic database upgrade processes, click the **No** button.
16. If this is the first version of Triton Connect 6.1 or 6.2 to be installed on this client, click the **Perform File Migration** button when the Triton Connect Database Migration Utility appears.

17. Once the file migration has completed, see **ORANGE** rectangle in previous image, verify or update the TC_Main Path and click the **Save** button.

18. Verify or update the SQL Connection String for Journals. Click the **Initialize** button, then click the **Save** button, **RED** rectangle.

19. Verify or update the SQL Connection String for Parameters. Click the **Initialize** button, then click the **Save** button, **RED** rectangle.

20. Close the Triton Connect Database Migration Utility.

21. Triton Connect should now be ready to use on the client computer.

**Note**

The default installation location will generally be C:\Program Files (x86)\TritConn\. After installation, C:\ProgramData\TritConn\. will contain files frequently read from and written to. The user can install the application to locations other than the default location. If Program Files or Program Files (x86) does not contain Triton Connect, the ProgramData path no longer applies. To install Triton Connect to a location other than the default, choose Custom installation type and click Next. Click Change and enter or select the location where Triton Connect will be installed. Then proceed with the installation as normal.
DASHBOARD

View the Terminal Status, Call List, and the Call Processors via the Triton Connect Dashboard; disabled by default. To enable the dashboard settings, launch the Triton Connect Terminal Manager, open the Setup menu, click Options, and click Dashboard Configuration.

Three sections exist on the dashboard configuration screen, one for each of the following dashboard components: Terminal Status, Call List, and Call Viewer. Enable or disable one, two, or all independent components on the dashboard.
A check in the Enabled box activates the Terminal Status components to include the Table Name field, Height percent field, Show grid lines check-box, and Show only terminals with an error code check-box.

The Table Name field becomes important in an environment when multiple client Triton Connect installations access the same database. Assign a unique value in the field for each terminal.

The Height field sets the height of the Terminal Status at a percentage of the Terminal Manager screen.

Check the 'Show grid lines' block to add lines around each data block similar to a spreadsheet. Check the 'Show only terminals with an error code' block to display only terminals with an error code.

The Field Width sets the percentage of width for each component data shown in the dashboard. The sum of the fields may exceed one hundred percent.

To enable the Terminal Status portion of the dashboard, check the Enabled check-box in the Terminal Status section then click the OK button on the Dashboard Configuration window.

From the Terminal Status component of the dashboard, right-click on a TID terminal to present shortcuts to Modify Terminal, Get Terminal Data, Set Terminal Parameters, View Terminal Parameters, View Journal Data, and Software Download.
The Call List section of the Dashboard Configuration window contains the check box to enable the Call List dashboard component, along with a height percent field, a show grid lines check box, and the field width percent settings for several fields shown in the dashboard. The sum of the fields may exceed one hundred percent.

To enable the Call List, check the Enabled check box in the Call List section of the Dashboard Configuration screen and click OK.

In the Call List section of the dashboard, right-click on a call to present the option to delete the call.
The Call Viewer section of the Dashboard Configuration window contains the check box to enable the Call Viewer dashboard component, the height percent setting, and the IP address and port settings for connecting to the Call Monitor.

To enable the Call Viewer, check the Enabled check box in the Call Viewer section of the Dashboard Configuration window, enter the IP address and port number, and click OK.

Double-click on a Call Processor will cause that Call Processor to fill the Call Viewer area and display detail information, as shown below. Right-click on the screen will present the option to pause or resume. To return to viewing all Call Processors, double-click anywhere within the Call Processor.

STORE TERMINAL PARAMETERS IN SQL

SQL database stores the Triton Connect parameters. If upgrading Triton Connect from a version earlier than 6.0 and using the default settings, the automatic database upgrade processes performed at the end of installation, will automatically copy the parameters to SQL.
TERMINAL CONFIGURATION OVERVIEW

If a user needs the current configuration of a specific terminal, the Configuration Overview will provide the details. Perform the following steps.
1. Navigate to the Terminal Manager > Terminal Data > View Terminal Parameters.
2. Click View Parameters button.
3. If the Select Terminal ID: does not show the terminal needed, click the down arrow and click the desired terminal ID. In the upper right corner of the Terminal Parameters' screen, the TID: shows the terminal ID selected.
4. Click the Version Numbers tab. In the lower left corner, click the View Config. Overview button.

**Note**
The Configuration Overview in version 6.1 provides more information: Terminal Messages, EMV Info, Coupon Info, Default Transaction, Default Account, Default Language, Scheduled close enabled status and time, and Screen File.
At the bottom of the Configuration Overview screen, click the **Copy Text** button. Open a text editor program. Paste and Save the overview in the document for future reference. Saving this document as soon as the ATM goes online will help establish the ATM's baseline.
SUPPORT LICENSING

NUMBER OF TERMINALS,

Triton Connect 6.1 includes support for licensing based on the number of terminals in Triton Connect. To view the number of terminals supported by your license, from the Terminal Manager Navigate to Setup > Options > Comloc Information.

Once the license reaches the maximum number of terminals supported and the user attempts to add a terminal to Triton Connect, a message will indicate no terminal added and contact Triton Technical Support to update the license.

LICENSES, USERS, AND AUTHORIZATIONS (LUA)

The Comloc stores the licenses, users, and authorization (lua) information, along with number of terminals. An lua is used for each instances of Call Monitor and Terminal Manager running. These items determine the Comloc's pricing as per the customer's needs.
**MIGRATE JOURNAL ARCHIVES TO SQL**

*Note*
Merge any databases prior to using this feature. After completing the mergers and setups, migrate the journal archives at any time.

Follow the steps below to migrate a journal archive to SQL.
1. Locate the TC Database Utility.exe program located in the installation folder.
2. Click the Migrate Journal Archive tab.
3. Enter or browse for the TC_Main.mdb database.
4. Enter or browse for the journal archive file.
5. Click the **Begin** button.

**COMBINE TRITON CONNECT DATABASES**

Use this feature on databases from Triton Connect 5.x and above. Both the source and the destination databases require the same Triton Connect version for compatibility purposes. A copy of source database contents will transfer into the destination database.

*Note*
As part of the merge process, all journal data removed from the source and destination databases convert to archives. Use the Migrate Journal Archive functionality to import the archives into SQL, if desired.

Combine databases by performing the steps below.
1. Close any Triton Connect components that may access either the source or the destination database.
2. Launch TC Database Utility.exe (located in the installation folder).
3. Navigate to the Merge Databases tab.
4. Enter or browse for the destination database location.
5. Enter or browse for the source database location.
6. Click **Start**.
7. Time to complete the merge will vary. Any feedback or errors will be shown in the lower half of the Triton Connect Database Migration Utility window.

**END OF INSTALLATION**
CHAPTER 3 - CALL MONITOR

INTRODUCTION

The Call Monitor application configures and monitors communications with Triton Connect devices.

OVERVIEW OF CALL MONITOR FUNCTIONS

The Call Monitor connects to Triton Connect remote terminals, using standard dial-up, TCP/IP, wireless, or VSAT communication connections. Call Monitor gives Triton Connect the ability to make calls to terminals (call-out operations) and receive calls from terminals (call-in operations).

The Call Monitor exercises overall control of all call activity by assigning each telephone line, TCP/IP connection or VSAT satellite link (as applicable) to an application called a Call Processor. Each Call Processor will monitor and control the calling activity of its associated connection. The Call Processor will make calls to terminals, answer calls from terminals, provide indications of the activity taking place during a call, and terminates the connection after a call.

The Triton Connect design allows for a greater data-handling capacity. A single PC, running a single Call Monitor and using 20 Call Processors, can handle in-coming and outgoing calls for up to 1000 terminals. In extreme large-scale operations, Triton Connect can meet the requirements for additional terminal-handling capacities.

Primary functions of the Call Monitor listed below.

• Call Processor startup and shutdown.
• Data Manager startup and shutdown.
• Routing of Call Processor activity data to the Call Viewer.
• Coordination of Call Processor and Data Manager activities.
• Receive calls if other parts of the program shut down.
• Manage communications between remote terminals and the Triton Connect Host Installation.

CALL PROCESSOR STARTUP AND SHUTDOWN

Once the Call Monitor starts, the Call Processors will start after a twenty-second countdown. Users may also start the Call Processors manually, either as a group or individual.

MANAGE COMMUNICATIONS BETWEEN REMOTE TERMINALS AND HOST INSTALLATION

Approximately every 15 seconds the Call Monitor reads the entries in the Call List database. The Call List database shows when to make the call and which terminal to call. When the scheduled time arrives for an out-going call, the Call Monitor assigns an available Call Processor to handle the call.
DATABASE MANAGER STARTUP AND SHUTDOWN

The Data Manager processes the raw data received and stored by each running Call Processor. It saves the processed data to the appropriate Triton Connect database. The Data Manager starts when the Call Monitor starts and shuts down when the Call Monitor and any active Call Processors shuts down.

**Note**
If the Database Manager shuts down with the Call Processors running, the Manager will not process the flat file data until it restarts. This means that until the Data Manager restarts and processes the data, the databases and any reports generated from this data will not be current.

COORDINATE ACTIVITIES BETWEEN CALL PROCESSORS AND DATA MANAGER

The Call Monitor assigns one or more available Call Processors to monitor calls from the terminals. As these complete the incoming calls, the Call Monitor directs the Data Manager to process the received raw data and store it in the Triton Connect database.

A Call Processor receiving data from a terminal saves that data to a raw data file called a “flat file.” This flat file temporarily resides in a sub-folder of the Data folder in the Triton Connect installation directory or other user-specified location. Each terminal sends data to its own designated sub-folder named with the Terminal’s ID.

The Data Manager deletes the flat file after the database saves the data. Sometimes the user may wish to save this data for later review. Do not access the raw data flat files during normal operations. Use the Save Flat Files function on the Call Monitor Diagnostics/Data Manager Settings menu to save archive files for later review.

**Note**
The Call Monitor communicates with the Data Manager using the TCP/IP protocol connection. For proper communications install the Call Monitor PC and workstation on the same LAN or WAN.
ROUTE CALL PROCESSOR ACTIVITY DATA TO THE CALL VIEWER APPLICATION

The PC running the Call Monitor can view the activity of each active Call Processor. In locations with a network installation of Triton Connect, the computer running the Call Monitor may not be readily accessible to operator personnel.

In such cases, any operator workstation running a legal-licensed copy of Triton Connect with Comloc can view the Call Processor’s activities via the Call Viewer application. The Call Monitor communicates to the Call Viewer with a TCP/IP connection.

**Note**
To monitor the Call Processor activities through the Call Viewer, enable the Call Viewer function from the Call Monitor/Diagnostic screen. See description in the Enable Call Viewer section for more information.

The Call Monitor allows several ways to view the Call Processor activities.

1. Summary single-line status: The Call Monitor dialog offers a single-line status entry for each Call Processor.
2. Single Frame: Call Processor activity displays in a frame that overlays the Call Monitor main dialog.
3. Separate Frames: The activity of each Call Processor displays in its own dialog window—the default view.

START THE CALL MONITOR

Access the Call Monitor application from the Start/Programs/Triton Connect menu in the Windows task bar or Windows 10 Start/Triton Systems. Click the Launch Call Monitor option.

**Note**
You may wish to place a shortcut to the Call Monitor application in the Windows Startup folder. This will allow the application to start, once the PC running the program boots up.

When the Call Monitor starts, a twenty-second countdown begins.

When the countdown reaches zero, all enabled Call Processors will start. Click the Stop command button to terminate the countdown or click the Start command button to start the call processors immediately.

Once either the Call Processors starts, or the countdown terminates, the Call Monitor’s screen appears.
The user may change all processors at once by clicking on either the Start All Processors button or the Stop All Processors button.

**SHUT DOWN THE CALL MONITOR**

On the Call Monitor screen, click the Quit Program command button to shut down the program.

The user can select the Exit option from the File menu on the Call Monitor menu bar.

**Note**

When the Call Monitor shuts down, all associated components—Database Manager and any active Call Processors—will shut down.

**CONFIGURE MAXIMUM NUMBER OF CALL PROCESSORS**

The Call Monitor can configure up to 20 Call Processors. The monitor will display the default number of 8 processors. To add more Call Processors, navigate to the Call Monitor > Settings and click Add a call Processor (20 Max).

To change the number of displayed processors, navigate to the Call Monitor > View and click Maximum Call Processors. Use the up or down arrows to set the maximum number of Call Processors displayed on the Call Monitor screen. Select a value from 1 to 20. Click the OK button. The Call Monitor will display the number of Call Processors specified.
**ENABLE/DISABLE CALL VIEWER**

To enable or disable the Call Viewer, navigate to the Call Monitor > Diagnostics menu.

A check mark shows an active option. The Call Viewer establish a TCP/IP connection with the Call Monitor to receive Call Processor activity data. Click the option to remove the check mark and disable the Call Viewer.

If the Terminal Manager does not display the Call Viewer, Navigate to the Terminal Manager > Setup > Options > Dashboard Configuration option. Click the Call Viewer Enable box. Click the OK button. The terminal Monitor screen should display the Call Viewer.

**CONFIGURE DATABASE SETTINGS**

**Note**

The following instructions assume the user can navigate folders on a computer running Windows XP, 7, 8, or Windows 10 operating system. On a network installation, IT personnel should change these settings with adjustments made to workstations. Locate all databases in the same folder. In a standalone installation and most network installations, the default settings allow the program to operate. Incorrect settings will prevent correct program functionality.

Navigate to the Call Monitor > File > Database Settings option menu.

**Note**

The Database Settings option becomes available if all the Call Processors have stopped running.

Click Database Settings. A warning message appears. Read it careful before clicking the OK button.

**Caution**

Before changing database settings, make sure all other Triton Connect programs—Terminal Manager, Alarm Monitor, Call Viewer—have been shut down.

This dialog lets you specify the location of the Triton Connect databases.

- Main (main.mdb)
- Call List (callist.mdb)
- Error List (errlist.mdb)
- Reports (reports.mdb)
- Reports Blank (rptblk.mdb)
- Status (status.mdb)
- Status History (stathis.mdb)
- Terminal (termerr.mdb)

The default Triton Connect installation folder stores the databases. If the default location does not contain the databases, use this function to record the new location so the Triton Connect applications will locate the databases. Click the Browse command button to bring up a file browse dialog.
The Database Manager starts when the Call Monitor starts, and shuts down when the Call Monitor shuts down.

Clicking the Launch Data Manager option in the Windows Start/Programs/Triton Connect menu, will also start the Data Manager.

The Data Manager displays this dialog box for the following reasons.

- The user starts the Data Manager manually with the Call Monitor not running.
- No TCP/IP connection between the Data Manager and the Call Monitor.

Click the Connect button to start the Data Manager application.

The RED indicator chip in the lower left corner of the Data Manager dialog box starts as RED. It will remain RED, until the Call Monitor starts and connects to the Data Manager via a TCP/IP connection. The indicator chip will turn GREEN for a good connection.
SCAN FUNCTION

Under some circumstances the Data Manager will become visible. When it does, the Manager has not processed the flat-file data. Although the Data Manager will perform this operation several times per hour, the user may wish to initiate the process function.

With a visible Data Manager dialog, click the Scan button to manually initiate the processing of any received flat-file data not yet processed and stored in the databases.

A VERIFY WARNING screen will appear. Please read and understand the warning before clicking on the OK button to shut down the Data Manager.

Caution
With the Data Manager shut down, the Triton Connect databases will not update even though it still receives data from the terminals. The Call Processor (CP1) window displays the Data Manager scan results.

If the Call Monitor terminates without notifying the Data Manager, the Manager becomes visible and the user can click the Exit button to close the dialog.

SHUT DOWN THE DATA MANAGER

Navigate to the Call Monitor > File > Shutdown Data Manager option to manually shut down the Data Manager.

A VERIFY WARNING screen will appear. Please read and understand the warning before clicking on the OK button to shut down the Data Manager.

This option changes to Restart Data Manager after the Data Manager shuts down.

Caution
With the Data Manager shut down, the Triton Connect databases will not update even though it still receives data from the terminals. The Call Processor (CP1) window displays the Data Manager scan results.

If the Call Monitor terminates without notifying the Data Manager, the Manager becomes visible and the user can click the Exit button to close the dialog.

HIDE THE DATA MANAGER

After the Call Monitor starts and a TCP/IP connection connects between the Data Manager and the Call Monitor, the indicator chip will turn GREEN and the Hide command button will appear on the dialog.

Click the Hide button and the Data Manager will hide in the background until an event occurs to bring it to the front. Recommend hiding the Data Manager for normal operations.

On the Call Monitor screen click the Have Data Manager Scan for Flat Files button to initiate the Data Manager’s flat-file scan.
**RESTART THE DATA MANAGER**

If the Data Manager shuts down or does not communicate with the Call Monitor, Navigate to the Call Monitor > File and click the Restart Data Manager option.

**CONFIGURE TCP/IP SETTINGS**

Access the TCP/IP Settings option from the Call Monitor > Settings menu.

The Call Monitor communicates with various Triton Connect components using the TCP/IP communications protocol. The connection with each component requires a Port Number. The Call Monitor creates a default Port Number for each connection; however, your network administrator can configure the Port Numbers manually, if required to avoid conflicts with existing network settings.

The TCP/IP settings displays the IP Address, port numbers and timeout while the Call Processors run, but the port numbers become available for change after all Call Processors stop.

In a standalone installation and most network installations, the default TCP/IP settings do not require alterations. Incorrect settings will prevent correct program operations.

Selecting the TCP/IP Settings option brings up the TCP/IP Settings dialog.

The dialog allows the user to enter or modify TCP/IP port entries for the following connections.

- Call Monitor to Data Manager.
- Call Monitor to Call Viewer.
- Inbound calls from terminals using TCP/IP communications. The port number serves the equivalent of a Triton Connect “phone number.”
- Inbound SSL Port:

**Note**

The TCP/IP Settings dialog box displays the TCP/IP address of the computer running the Call Monitor application. The Call Viewer requires the IP address, along with the Call Monitor to Call Viewer port number, to ensure correct Call Viewer operation.
**FIRST JOURNAL TIMEOUT**

Navigate to the Call Monitor > Settings > First Journal Timeout option.

This option becomes available, when all Call Processors stop running. Selecting this option brings up the following dialog.

The user sets the duration in intervals of hours, days, months, or years. Change the settings as needed and click the **OK** button.

From the time of creation, the Call Monitor watches the life of each Terminal Originated Call entry in the Call List. When the interval time expires, the Call Monitor removes the entry from the Call List.

**CONFIGURE TERMINAL ORIGINATED CALL EXPIRATION TIME**

Only terminal’s that support the Terminal Originated Call will have this feature.

Navigate to the Call Monitor > Settings > Terminal Originated Call Settings option.
ADD AND REMOVE A CALL PROCESSOR

Navigate to the Call Monitor > Settings > Add a Call Processor and Remove a Call Processor options from the menu.

**ADD A CALL PROCESSOR**

Click the Add a Call Processor (20 Max.) option to add a Call Processor to the available list up to the maximum allowable number of twenty. If necessary, the Call Monitor dialog window can scroll to provide access to any additional Call Processors.

**REMOVE A CALL PROCESSOR**

Click the Removes a Call Processor to remove a Call Processor from the available list. The list will always have a minimum of one.

ENABLE/DISABLE EXTENDED STATUS TEXT UPDATING

Navigate to the Call Monitor > View > Update Status Text option menu.

A check mark indicates an active option. Extended status information, in addition to the summarized information that normally appears, will display in the single-line status view on the Call Monitor main dialog.

**VIEW CALL PROCESSOR ACTIVITY IN A SEPARATE WINDOW**

Navigate to the Call Monitor > View > Display each view in separate window option menu.

A check mark indicates an active option. Click the View command button for a Call Processor and the activities for that processor will display in a separate status window. The separate status window is the default selection.
**VIEW CALL PROCESSOR ACTIVITY IN A SINGLE FRAME**

Navigate to the Call Monitor > View > Display a single frame for views option menu.

A check mark shows an active option. When the user clicks the View command button for a Call Processor, a window replaces the normal Call Monitor dialog and displays the activity of the single Call Processor. If both separate window and single frame options have check marks, The Call Monitor presents both views.

**DISPLAY HEX DATA ON SCREEN**

Do not use this option unless directed to do so by technical support personnel. Use this option for diagnostic purposes only.

Navigate to the Call Monitor > Diagnostics > Display Data on Screen option.

A check mark indicates an active option. The Call Monitor creates a data file for each Call Processor in the Triton Connect program folder (output1.DAT, output2.DAT, etc.).

This data file records a copy of the associated Call Processor's activity display. Use a text editor or word processor program to view the data file contents.

**CAPTURE CALL PROCESSOR DATA TO A FILE**

This option can create very large files, so do not use unless directed by technical support personnel.

Navigate to the Call Monitor > Diagnostics > Capture to File option.

A check mark indicates an active option. This function enables each Call Processor port to send all transmitted and received data in hex code. This data will appear in the applicable Call Processor’s activity window.

**REDIRECT THE CALL PROCESSOR DATA LOCATION**

Do not use this option without a thorough understanding of the program. No further information provided.
**RESERVE A CALL PROCESSOR FOR INCOMING CALLS**

Navigate to the **Call Monitor > Settings > Reserve a CP for incoming calls** option.

This option reserves exclusive use of one available Call Processor for incoming calls from a terminal having problems reaching an available Call Processor in very a busy location.

**CONFIGURE THE COMMUNICATIONS TIMEOUT DURATION**

Navigate to the **Call Monitor > Settings > Communications Timeout** option.

Select the time—in seconds—the Call Processor will wait before reporting a failed callback attempt from a remote terminal. A check mark shows the current selected value of 10, 20, 40, or 80 seconds with a default value of 20 seconds. International locations with dial-up connections may require a longer timeout setting to prevent excessive failed call reports.

**DATA MANAGER**

After opening the Call Monitor, in the background the Data Manager processes data received from terminals.

**SAVE FLAT FILES**

Navigate to the **Call Monitor > Settings > Data Manager > Settings** option. Click the **Save Flat File** option.

A check mark indicates an active option. Instead of deleting the file after processing the data, the Data Manager will save each Call Processor flat file to a separate folder and give a name consisting with the year, month, and day on which the Manager receives the terminal data, as an example 20191101.

Use a text editor or word processor program to view the Hex data.

**LOG DATA MANAGER ACTIVITY TO A FILE**

Navigate to the **Call Monitor > Diagnostics > Data Manager Settings** option. Click the **Enable Logging to File** option.

A check mark indicates an active option. The Data Manager will log its activity to the file DM.log in the Triton Connect application folder. Use a text editor such as Notepad or other word processing program to open and view this log.
Navigate to the **Call Monitor > Diagnostics > Data Manager Settings** option. Click the **Output to CSV (Comma Separated Value) Files** option.

A check mark indicates an active option. The Data Manager saves the incoming journal data to the CSV folder, located in the same folder location as the Data folder. Each terminal will have its own file in this folder.

The Data Manager saves the data in a (CSV) format. CSV allows for easy importing into spreadsheets and database programs.

**OUTPUT TO TAPE FORMAT FILES**

Navigate to the **Call Monitor > Diagnostics > Data Manager Settings** option. Click the **Output to Tape Format Files** option.

A check mark indicates an active option. The Data Manager saves the incoming journal data to a Tape folder named Tape, located in the same folder location as the Data folder. Each terminal will have its own file in this folder.

The Data Manager saves the data in the same report style format used by the terminal to print journal reports.

**EXPORT JOURNALS**

Navigate to the **Call Monitor > Diagnostics > Data Manager Settings** option. Click the **Export Journals** option.

A check mark indicates an active option. The Data Manager will export journals into another database named ExpJrnls.mdb in an expanded format.

**SELECT A CALL PROCESSOR SETTINGS DIALOG**

Navigate to the **Call Monitor > Settings > Call Processors** option.

The Call Processor Settings dialog opens. This screen allows the user to configure each Call Processors not in use. On the Call Monitor screen, the user can configure or access a stopped Call Processors by selecting **Settings** for individual Call Processors.

**Note**

A grayed out **Settings**, available **Stop** button, and the individual Call Processor activity box shows “Call Processors not in Use”, means this processor is stopped.
**CONFIGURE CALL PROCESSOR SETTINGS**

The Call Processor > Settings dialog allows the user to enable and configure any available Call Processors. For dial-up communications, the user must have one available analog modem and a phone line for each Call Processor the user wish to configure.

For TCP/IP communications, one (1) connection can use up to twenty (20) TCP/IP connections.

**Note**
Users can only select a Call Processor not running.

Use either of the following methods to open the Call Processor Settings dialog.

- On the Call Monitor main dialog, click the Settings command button for the Call Processor the user will configure.
- Select the Call Processor option from the Settings menu on the Call Monitor menu bar. When the dialog appears, click the down arrow to select the specific Call Processor the user will configure.

The Call Processor Settings dialog appears.

Use the dialog to enable and configure the settings for any available Call Processor. The following sections will explain the various configuration settings.

**CALL PROCESSOR (1 TO 20)**

The drop-down list shows all available Call Processors currently not running. Select a Call Processor from the list.

**ENABLE CALL PROCESSOR**

Click the check box to enable/start the Call Processor shown in the drop-down list.

**START A CALL PROCESSOR**

Each Call Processor entry on the Call Monitor main dialog has a Start button.

With the Call Processor enabled and properly configured, click the Start button for the Call Processor.
**VIEW CALL PROCESSOR ACTIVITY**

In addition to single-line status available from the Call Monitor main dialog, you can click the **View** button to display activity data for any Call Processor according to the current viewer settings: separate window, single frame, or both.

Either type of viewing window provides two command buttons.

- **Close.** Close the viewer window. If a Single Frame, will return to the default Call Monitor dialog window.
- **Pause/Resume.** Pause or Resume the operation of the Call Processor.

**CONNECTION TYPE**

This drop-down list allows the user to pick the type of connection this Call Processor will use for terminal communications.

1. **Phone Line:** With this option the user must select an available modem in the Modems Available drop-down list, before the Call Processor can start.
2. **VSAT X.121:** With this option select an available COMM port in the Comm Port Selected drop-down list sill connect to the VSAT communication device.
3. **TCP/IP:** With this option the Call Processor will use the IP Address and Port settings in the Call List to contact a terminal with a TCP/IP connection.
4. **Radio Pad:** With this option the user selects the comm port the modem will connect to the radio Pad device.

**ATM CONNECTION TYPES**

All Triton ATMs except RL/FT5000 XP/PC-based units can use the Dial-up phone line connection type.

ATMs with either TCP/IP capable (ARGO/FT or RL/FT5000/RT2000) or have the (optional) External Ethernet module installed (91XX/97XX/96XX) can use the TCP/IP connection type.

ATMs that support Very Small Aperture Terminal (VSAT) satellite-based communications can use the VSAT connection type. VSAT supports a wide range of communication protocols.
COMMUNICATION DIRECTION

A series of option buttons lets the user choose the direction type of calls this Call Processor will handle.

1. Select the In option and the Call Processor will handle in-bound calls ONLY.

2. Select the Out option and the Call Processor will handle out-bound calls ONLY.

3. Select the Both (In and Out) option and the Call Processor will handle both in-bound and out-bound calls (the default option for normal operations).

4. Select the Alarms Only option and the Call Processor will handle on in-bound calls that carry terminal alarm status ONLY.

DIAL MODIFIER

With the Connection Type set to Phone Line, the Dial Modifier becomes available. Enter any special dialing codes required when dialing out from your system, such as a dial-out prefix of ‘9.’

MODEM SELECTED

Modem Selected shows the currently selected modem this Call Processor will use when placing Phone Line calls.

MODEMS AVAILABLE

When the Connection Type selects Phone Line feature, the Modem Available provides a list of available modems.

**Note**

Do not configure more than one (1) Call Processor for each available modem.
**Modem Settings**

Modem Settings allows access to modem properties.

**Properties**
- Allows user to select Country/Region:, Area code:, Phone number:, and Connect using: preferences.

Click the **Configure** button to set the modem hardware settings. Click **OK** to save the settings.

**Note**
The default settings are normally correct.

**Comm Port Selected**

When the user selects the VSAT/Radio Pad, the **Connection Type** displays the **Comm Port Selected** text, which provides the current PC COM port connected to the VSAT/Radio Pad communications hardware.

**Prev:** Click the (<<Prev) command button or press Alt+P on the keyboard to access the settings for the previous available Call Processor.

**Next:** Click the (Next>>) command button or press Alt+N on the keyboard to access the settings for the next available Call Processor.

**Save:** Click the (Save) command button or press Alt+S on the keyboard to save the settings changes for the current selected Call Processor and remain in the Settings dialog.

**OK:** Click the (OK) command button or press Alt+O on the keyboard to save the settings changes for the current selected Call Processor and exit the settings dialog.

**Cancel:** Click the (Cancel) command button or press Alt+C on the keyboard to exit without making any changes to the Call Processor settings.
### RETRY CALLS WITH WRONG TID

<table>
<thead>
<tr>
<th>Triton Connect Call Monitor</th>
<th>File</th>
<th>Diagnostics</th>
<th>View</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Processors</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redirect Data (Stop all CPs to enable)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCP/IP Settings</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTCC Settings (Stop all CPs to enable)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communications Timeout</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Journal Timeout</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserve a CP for incoming calls</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum Call Attempts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add a Call Processor (20 Max.)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove a Call Processor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU Delay (slows down CPs)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Retry Calls with Wrong TID</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short Challenge/Response Timeout</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short modem initial timeout</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Force old ISO Format (z-180s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cycle Call Processors</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SSL Settings</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Challenge/Response communications between the ATM and Triton Connect may change due to interference and corrupt the TID data. Instead of deleting the call, Triton Connect assumes a communication problem and keeps the call list entry.

### SHORT CHALLENGE/RESPONSE TIMEOUT

A default timeout of 20 seconds occurs between packets. Sometimes Triton Connect will send the first data packet before the ATM is ready to receive it. Triton Connect will set the initial timeout to 5 seconds for the first packet attempt, then 10 seconds for the second attempt, then 15 for the third, and so on.

### SHORT MODEM INITIAL TIMEOUT

When the Call Monitor and Call Processors start, the Processors begin an 80 second “Waiting for call” state. This prevents collisions with inbound calls and outbound calls when the call processors start. The option—used for testing—reduces the delay time to 10 seconds.

### FORCE OLD ISO FORMAT (Z-180S)

This option forces Triton Connect to send the ISO numbers in the old format (100, 10-digit ISO numbers), even though the terminal indicates it supports the X-scale format.
This option allows the user to schedule a Cycling (stopping and restarting) of all call processors at a specific interval. This option assist users with larger system having communication issues.

Navigate to the Call Monitor > RSF option to allow a 3rd party interface to receive the ATM’s status information via TCP/IP. The screen opens.


IP Address: IP Address of Remote Status Monitor when connected.

Port: The IP Port Triton Connect will listen for connection with Remote Status Monitor.

10 characters of Terminal ID: Protocol limits the use of only 10 characters of the Terminal ID. Select either the Leftmost or the Rightmost 10 characters.

**END OF CALL MONITOR**
CALL MONITOR AS A WINDOWS SERVICE

This version of Triton Connect adds the ability for a Windows service to launch the Call Monitor, thus removing the need for a user to log into the PC for the Call Monitor to function.

Windows provides many ways to configure a service. A complete overview of configuring the Windows services exceeds the scope of this document. However, consider the important items below:

1. Before using the Call Monitor as a service, a user must configure the Call Monitor by opening the application and configuring the various types of communications, port numbers, and other settings required.
2. To change the Call Monitor’s configuration, a user must log into the PC, stop the Tccm Controller service, launch the Call Monitor, then change the desired options.
3. The configured service running the account must access the SSL/TLS certificate location for a proper functioning SSL/TLS feature. This may require exporting the certificate w/private key and then importing it into a proper location for the service account, such as the Machine personal certificate store.
4. To view and configure the service, open the **Start menu**, right-click Computer, click Manage, expand **Services and Applications** on the left-most pane of the screen, click Services, and locate **Tccm Controller**.

5. When in normal operation with the Call Monitor running as a service, the **Windows Task Manager** can verify the active operation of the Call Monitor (**Tccm.exe**) and verify the user name under which it runs, along with **DataManager.exe** and one **Tccp.exe** for each running Call Processor.
6. The service may not allow access to mapped drive letters, so accessing network resources use the network paths. As a result, if the database is on a network share, configure the Call Monitor to use the network path and not a drive letter.
To achieve this configuration, with the service stopped and all other Triton Connect processes closed:

- Launch the **Call Monitor**, navigate to File > Database Settings.
- Click **Browse**.
- In the address bar at the top of the path window, enter the desired network location and press **Enter**.
- Select *TC_Main.mdb* and click the **Open** button.
- Click the **Apply** button and then click the **OK** button.
- Verify the ability to place a call to an ATM, to test.
- Close the Call Monitor, start the service, and then place another test call to an ATM.
7. Because the service does not see the mapped drives, software updates residing on a network location must use the network path when scheduling the updates to an ATM. To schedule a software update call to an ATM, from the Load Terminal Software screen, proceed as follows:
   - Select the desired Terminal ID.
   - Click Select File.
   - Enter the desired network location in the address bar.
   - Click the file to send to the ATM and click Open.
   - Click Send File.

**End of Window Service Call Monitor**
CHAPTER 4 - TERMINAL SETUP

INTRODUCTION

This chapter covers the functions to create, modify, delete, and view terminal records in the Triton Connect main database through the Terminal Manager application. In addition, the Terminal Manager sets up terminal data, database management, and automatic alarm message transmission.

Load each Terminal into the Triton Connect terminal database. Triton Connect uses the information it needs to identify and contact the terminal, and its associated data in the database.

ADD A NEW TERMINAL

This function operates as a data interface for the Triton Connect database. The screen consists of fields that make up a database record.

Caution

Never attempt to access the Triton Connect database directly or alter the information other than through the Terminal Manager. The user may cause the program to become inoperable.

ACCESS THE ADD NEW TERMINAL FUNCTION

1. Navigate to the Terminal Manager > Setup > Add New Terminal option.

2. The Add New Terminal window appears.

DATA-ENTRY FIELDS

1. As a minimum to save a new terminal record, enter data into the Terminal ID field. Under the ATM Connection Type, select a connection type. Enter a phone number or address in the Terminal Phone Number/IP Address field.

2. The Terminal ID converts to the uppercase when saved to the database.

TERMINAL ID

Your processor or service provider assigns a Terminal Number to the terminal during the physical installation. Enter the Terminal Number into the Terminal ID: block.
Caution

The Terminal ID must match the value assigned to the Terminal Number parameter in the terminal. The Terminal ID can only be 17 alphanumeric characters.

If a new terminal of a different type replaces a terminal at a location, and the new terminal uses the same Terminal ID, for instance, replacing a Model 9600 with a Model RL5000, archive the current information from the old terminal, before contacting the new terminal. Otherwise, the information for the new terminal may not display correctly.

LOCATION NAME

The Location Name identifies the name of the establishment with the physical terminal.

ADDRESS

Enter the address of the establishment identified under Location Name.

CONTACT 1/2

In the optional fields, enter the names of individuals or organizations who act as a point of contact at the address specified above.

CITY, STATE, ZIP CODE

Enter the requested information to complete the address data.

TERMINAL PHONE # / IP ADDRESS

A terminal connected to the standard telephone system, requires the complete telephone number that services the terminal at the operating location.

A terminal connected to the TCP/IP or CDMA (wireless) network, requires an IP Address provided by the host processor organization or service provider.

**Note**

The address includes a two-part entry. The first part consists of four groups of numbers in typical IP Address format. Each group contains a number, (0 to 255). A period, dot character, separates each number group, example: 123.221.01.99.

The second part of the IP Address, Port Number, consists of 1 to 5 digits.

PORT NUMBER

Your host processor organization or service provider specifies the Port Number and any additional data routing information which allows Triton Connect to communicate with the selected terminal on the TCP/IP or wireless network.

USER 1-4

These four optional fields provide additional terminal identifying information to the database record. The Filter capabilities of Triton Connect makes the User 1-4 fields a powerful tool to organize and group many terminals. Three examples: special requirements, additional contact information, terminal’s technician’s name.

Use the Configure User Fields function, located later in this chapter, to change the default labels of the User fields.

JOURNAL CLEARING

Select either Manual or Automatic to clear the terminal's Electronic Journal.

Select Manual, if the terminal operator at the operating location will manually clear the terminal's Electronic Journal.

Select Automatic, if Triton Connect will initiate journal clearing after the Get Journal Data function successfully downloads the terminal’s journal.
The Electronic Journal cannot hold an unlimited number of entries. The 8-bit machines (9100/96XX/97XX/Mako/SS) can hold at most 2045 journal entries. The 32-bit machines (ARGO Series, FT/RL/RT/Traverse) can hold 32,768 entries. If the journal entry reaches the size limit, the terminal will enter an OUT OF SERVICE condition and will remain in this state until a user clears the journals.

**Caution**

With the Journal Clearing set to Manual any records received will not be marked as audited/cleared in the ATM. If the user does not clear the Electronic Journals before the next Get Journal Data command is issued, the received data will contain old journal entries. These old entries could duplicate the stored entries in the database received under the Manual download.

**ATM CONNECTION TYPE**

Select the correct connection type or the modem speed used by the terminal.

![ATM Connection Type](image)

**TIME ZONE**

Click the down arrow on the Time Zone block and select the time zone for the terminal’s operating location.

![Time Zone](image)

**USE DAYLIGHT SAVINGS TIME**

Click the Use Daylight Savings Time check box, if used at the terminal’s operating location.

![Use Daylight Savings Time](image)

The program will verify the terminal ID does not have a duplicate ID in the database. If it does, it prompts to change the Terminal ID to a unique identifier. If no duplicate ID exists, the operation will continue.

**EPROM ACCESS CODE**

The user may enter the access code in the EPROM Access Code window at this time and click the Enter button.

![Enter EPROM Access Code](image)

The Screen displays the code character with asterisks for security reasons to verify a correct entry, a second prompt will appear for the user to enter the access code again. The user may choose not to enter a code and leave the EPROM Access Code entry blank. Click the Skip Step button.

**Note**

For ARGO, Traverse, RL1600, RL/FT5000, RL/RT2000 model ATMs, assign the Triton Connect access code at the terminal and enter as the EPROM Access Code on Triton Connect for that unit. The access codes must match on the ATM and Triton Connect.
DELETE A TERMINAL

Use this function to remove terminal records from the database.

**Caution**

A terminal deleted, also removes all information concerning the terminal from the database, including any Journals related to the terminal. If deleted by mistake, add the terminal back in as a new terminal with no information and Journals.

ACCESS THE DELETE TERMINAL FUNCTION

1. Navigate to the Terminal Manager > Setup > Delete Terminal option.

2. The Delete Terminal Screen appears.

A prompt appears with instructions in red to select a field to search.

Click the mouse cursor on the field to search, the following dialog box appears.

The information entered depends on the kinds of data contained in the field. For example, assume you have clicked on the Terminal ID field. You want to locate the record that contains a terminal ID of Test 12. Enter the text “Test 12” in the search box. Click the OK button.

If there is a valid data record for Test 12, it will appear in the applicable fields. If the search function cannot locate a record that contains the exact text entered in the selected field, the Manager displays the following message.

SELECT A TERMINAL FOR DELETION

Click the down arrow in the Terminal ID block. Select the ID from the drop-down list. The list will close and highlight the selected ID.
**Note**
The character “space” is not a valid character, so the space before the “12” makes “Test 12” not a valid ID.

Another method for selecting terminals involves the use of filters, which displays only terminal records that fit some specific criteria. See chapter 8 for the use of filters.

**SELECT A TERMINAL ID**

Type the first letter of a Terminal ID and a list of IDs starting with the chosen letter appears. Typing additional letters further refines this process and eliminates all, but the one desired Terminal ID.

**DELETE A TERMINAL**

Click the **Delete** button to remove the current terminal information.

A confirmation message appears.

Click the **Yes** button to continue with the delete action. A confirmation message of the Deletion appears.

**BULK DELETE TERMINALS**

1. Navigate to the *Terminal Manager > Setup > Bulk Delete* option.

2. The Bulk Delete Terminals dialog box appears.

3. Click the check box(s) to delete the terminal(s).
4. Click the **Clean** button.
5. Click the **Yes** button to delete all terminals with a checked box.
On the bulk delete dialog, click the **Select Input File** button. Browse the PC file system to locate and open an input file. The bulk delete application will evaluate the input file using the following criteria:

- The file is a simple text file with a .TXT extension.
- The file contains a list of Terminal IDs.
- Each line contains no more than one Terminal ID.
- Each Terminal ID consist of up to a maximum of 16 characters in length.

**Note**
If the bulk delete application has problems processing the text file due to corrupt or no data, the application will display the warning message.

The bulk delete application will compare the input file to the current database. If the application does not find a corresponding match in the database for each terminal in the input list, it will display the invalid Terminal IDs in a dialog box.

**Note**
The ### symbols following the names of the first 3 tables denotes multiple tables with the same name. Each one of the tables is associated with a terminal ID.

<table>
<thead>
<tr>
<th>DATABASE</th>
<th>TABLE</th>
<th>DELETION TARGET</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC_MAIN</td>
<td>ADDATA###</td>
<td>Entire Table</td>
</tr>
<tr>
<td>JOURNAL##</td>
<td>Entire Table</td>
<td></td>
</tr>
<tr>
<td>PARAMETERS###</td>
<td>Entire Table</td>
<td></td>
</tr>
<tr>
<td>CONFIGURE</td>
<td>Record matching specific ID</td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td>Record matching specific ID</td>
<td></td>
</tr>
<tr>
<td>FeatureSettings</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>ScheduleReboot</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>ExtErrorInfo</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>EMVData</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>EMVParameterDataAppList</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>EMVParameterDataBoolean</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>LCCassStructure</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>LCDayStructure</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>LCEEValues</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
<tr>
<td>SurchargeScreen</td>
<td>Records matching specific ID</td>
<td></td>
</tr>
</tbody>
</table>

**CONFIRM COMPLETION**

After the terminals deletion, a message box will confirm task completion.

Triton recommends running the Repair/Compact/Replace Database function after performing a bulk delete operation. Look under the Terminal Manager File menu for this function.

If the bulk delete application runs into a problem processing the Terminal IDs, the application will annotate these errors in a log file.

**LOGGING ACTIVITY**

The Bulk Delete application will keep a log file named Delete.log of its actions in the current directory, typically the Triton Connect installation directory.
MODIFY A TERMINAL RECORD

Use the Modify Terminal function to change an existing terminal record.

ACCESS THE MODIFY TERMINAL FUNCTION

1. Navigate to the Terminal Manager > Setup > Modify Terminal option.

2. The Modify Terminal window appears.

SELECT A TERMINAL RECORD TO MODIFY

Use one of the following methods to select a record.
1. Select from the Terminal ID field’s drop-down list.
2. Type a letter or two in the Terminal ID field.
3. Use the Search button to find the Terminal ID.
4. Use filters.

For detailed descriptions of the various methods for selecting a terminal, refer to the previous section, “Deleting a Terminal”.

MODIFY THE RECORD

Once the screen fills with the selected terminal data, alter the data in a field. Refer to the earlier section on Adding Terminal Records for detailed descriptions of the fields. The following features are specific to this function: Reset, Update, Options, and Change EPROM Password.

RESET

Click the Reset button to clear any changes and restore the fields to their original contents from the last Save.

UPDATE

Click the Update button to save the current field data to the database.

CHANGE EPROM PASSWORD

Click the Change command button to bring up the following dialog box.

Use this data entry box to initially enter or modify the copy of an existing EPROM Access Code in the database. The code entered does not alter the Access Code at the terminal, thus the access code must match between the ATM and Triton Connect.
OPTIONS

Click the **Options** command button to access the **Modify Status Message Settings** for the currently selected terminal. See the **Modify Status Message Settings** topic later in the chapter.

**VIEW TERMINAL SETUP**

**PURPOSE**

Use this function to view the information for a selected terminal in the database.

**ACCESS THE TERMINAL SETUP FUNCTION**

Navigate to the **Terminal Manager > View > Terminal Setup** option. The read-only Terminal Setup window appears.

![Terminal Setup Window](image)

**SELECT A TERMINAL**

Select a terminal to view using the procedures given in the section, “Deleting a Terminal,” earlier in this chapter.

To change the data in the fields, use the **Modify Terminal** function, covered earlier in this chapter.

**SET THE PC TIME ZONE**

**PURPOSE**

This function enables Triton Connect to account for the time zone differences between the local PC and the remote terminal when scheduling calls. This function includes all international time zones and a Daylight-Saving Time option.

**TERMINAL TIME ZONE**

The PC Time Zone function affects the time zone of the Triton Connect PC itself. Triton Connect knows the time zone of the terminal’s location via the database containing the terminal’s time zone and daylight savings time data. Refer to “Adding a New Terminal” earlier in this chapter.

**ACCESS THE PC TIME ZONE FUNCTION**

1. Navigate to **Terminal Manager > Setup > Options > PC Timezone** option. The PC Parameters window appears.

![PC Parameters Window](image)

Click the drop-down list for the Local Time Zone and select the time zone of the PC’s location.
THE DAYLIGHT SAVINGS TIME OPTION

If the PC’s location follows daylight savings time, check the box.

☑ This PC location uses Daylight Savings Time.

CONFIGURE USER FIELDS

The database provides four, free-form entry fields, User 1-4. The user’s discretion will determine the information contents of the User Fields.

During the creation or modification of a terminal record, one or more of these fields can help to differentiate the terminal from the others in the database. Also, grouping terminals with a common name and content in the User Field can extended this function’s usefulness.

For example, change the name of the “User 1” to “Promotion,” which creates a commonality to all or certain terminals. Add contents to the Promotion field like “Summer Madness Sale”, for some terminals and for other terminal’s “Winter Sale” or some other message, in essence creating a group of terminals associated with the sale.

This feature’s usefulness when combined with the Triton Connect filters can extend the previous example by assuming that a created filter selects only those terminal records that include the “Promotion” field and the contents “Summer Madness Sale” in the field. Activating such a filter would display only those terminal records that matched this criteria in the various terminal management functions.

The default name of each User Field is User 1, User 2, User 3, and User 4. Use the Configure User Fields function to change the default name.

ACCESS CONFIGURE USER FIELDS FUNCTION

Navigate to Terminal Manager > Setup > Options > Configure User Fields option. The Configure User Fields window appears.

CHANGE A USER FIELD NAME

Perform the following steps to change the User Field’s default name.

1. Highlight the field name.
2. Type the new name for the field.
3. Delete any characters from the old name that may be present in the field.
4. Repeat steps 1 to 3 for the other user fields.
5. Click the Save command button.

A confirmation prompt appears.

6. Click the Yes command button to save the change.
**RESET THE USER FIELD NAMES**

This function restores the contents of all User Fields to their last saved values. If the user clicks the Save button by mistake, use the Change a User Field Name procedure from above to correct the User Fields.

**SORT TERMINALS BY**

This function establishes a default listing order for Terminal IDs in the following Terminal Manager functions.

1. Add New Terminal
2. Modify Terminal
3. Terminal Setup
4. Terminal Status
5. Get Terminal Data
6. Set Terminal Parameters
7. View Terminal Parameters
8. View Journal Data

The initial default state sorts by Terminal IDs.

**ACCESS/CHANGE THE ‘SORT TERMINALS BY’ SETTING**

To access and change the default terminal sort order, perform the following steps.

1. Navigate to Terminal Manager > Setup > Options > Sort Terminal by option.

2. Select either of the two options.
   - Date They Were Added
   - Terminal ID

3. A check mark appears next to the current default sort order choice. To change the sort order, click on the other option.
**MODIFY STATUS MESSAGE SETTINGS**

This feature reports terminal status messages to one/two service providers via alphanumeric pager or email. For each service provider to receive status message notifications, enter one/two pager numbers and (or) one/two email addresses.

Trion Connect will send a message to the service provider immediately after it receives the status message from the terminal. The message will include the terminal ID, terminal model, terminal location, time, the Status Code and Status Description. Trion Connect will make five attempts to send this message. The Terminal Manager's Alarm Monitor and View Terminal Status screens will display the status messages.

**ACCESS THE MODIFY STATUS MESSAGE SETTINGS FUNCTION**

Perform the following to access the Modify Status Message Settings.

Navigate to Terminal Manager > Setup > Options > Modify Status Message Settings option. The following dialog appears.

1. **Terminal(s)**
   - The **Terminal(s) block** displays the terminal ID affected by the specific settings, and accesses the Mail Server Settings.

   ![Terminal Settings Dialog](image)

   - **View Settings for Terminal** contains a drop-down list showing the terminal IDs affected by the message settings. The list consists of all Terminal IDs currently loaded in the database unless an active filter specification restricts the number of entries.
   - A check in the **Route Error Messages to Email / Pager** check box, enables the routing of notification messages to the applicable pager numbers or email addresses. No check in the check box disables the notification function. The messages are still logged in the Status History feature, if enabled.
   - The **Mail Server Settings** sets and views the Mail Server parameters.

2. **Routing**
   - This section allows setting up routing for terminal status messages.

3. **Error Control**
   - This section controls how error messages are handled.

4. **Status Settings**
   - This section sets the status codes and descriptions.

**ALTERNATE ACCESS METHOD**

You can also access the Modify Status Message Settings function from the Modify Terminal screen. Click the **Options** command button. Using this will save the selected options only for that terminal.

The **Modify Status Message Settings** window covers these sections.
The Mail Server Settings screen allows the user to configure the email settings required to enable the email-based message notification function.

1. **SMTP Mail Server:** Enter the name of the Simple Mail Transfer Protocol (SMTP) Mail Server on your network. Typically, the email configuration settings of the existing email client software installed on the PC lists the Mail Server information. Contact your network administrator for assistance in obtaining the server name.

The Internet email standard SMTP Mail Server manages incoming and outgoing email traffic. Government and education facilities widely uses SMTP for reliable and efficient email transfer.

2. **From Email Address:** In most cases, if an outgoing email message fails to deliver to the target email address, a failure message returns to the sending email address. Enter a valid email address to receive undelivered mail notifications.

3. **Mail Server Port:** Enter the port number (default 25) for the email communications. In case of a conflict, obtain a valid port number from your network administrator. They will determine which SSL option to select (Automatic, Implicit, Explicit, or No SSL) and if the Accept Self-Signed Certificates requires a check mark in the boxes.

4. **Email Username:** Enter the email account’s username.

5. **Email Password:** Enter the email account’s password.

6. **Mail Server Connection Type:** Select the type of connection between the Triton Connect PC and Mail Server. On LAN-based systems select the Local Area Network option. If the connection requires dial-up, select the Dial-up Connection option.

7. **Dial-up Connection:** With the Dial-up Connection selected in the Mail Server Connection Type block, enter the complete telephone number required to call the Mail Server.

Click the **Save** button to accept the current Mail Server Settings.
Click the **Reset** button to restore all fields to the contents from the last save.
Click the **Cancel** button to return to the Modify Status Messages main window.

**ROUTING**

This block allows for one or two Service Providers. Enter applicable pager ID and telephone numbers for pager calls, or email addresses for email-based notification.

1. **Phone Number or Email Address #1:** This applies to Service Provider #1. If using pager calls, enter the pager phone number. If using email messaging, enter the applicable email address.

2. **Unique Pager ID #1:** This applies to Service Provider #1. If using pager calls, enter the pager ID number. If using email messaging, leave this field blank.

3. **Phone Number or Email Address #2:** This applies to Service Provider #2. If using pager calls, enter the pager phone number. If using email messaging, enter the applicable email address.

4. **Unique Pager ID #2:** This applies to Service Provider #2. If using pager calls, enter the pager ID number. If using email messaging, leave this field blank.

**Note**

To setup a single service provider with email and a pager, add the pager information to one of the Service Provider #n and add the email information to the other Service Provider #n.
ERROR CONTROL

Select the status messages reported to a service provider. Select any or all of the available Terminal Status Codes reported to Service Provider #1, Service Provider #2, or both.

1. **Apply To:** Select the Service Provider who will receive a notification of the status messages in the Active list.
2. **Active:** A list of terminal status codes reported to the service provider selected in Apply To.
3. **Inactive:** A list of terminal status codes not reported to a service provider.

To move a status code from the Inactive list to the Active list, click the code, then click the **<< Add** button. To move all status codes in the Inactive list to the Active list, click the **<< Add All** button.

To move a status code from the Active list to the Inactive list, click the code, then click the **Remove >>** button. To remove all status codes from the Active list, to the Inactive list, click the **Clear All >>** button.

STATUS

Click the **Save** button to save the current settings. Click the **Reset** button to restore all fields to the settings from the last save.

Click the **Clear** button to exit the screen and return to the Terminal Manager. If the user clicks the **Clear** Button before clicking the **Save** button, they will lose all changes.

SCHEDULE DATABASE BACKUP

The function creates a terminal database backup file and establishes a database backup schedule.

Caution

The backup process will not occur until all Triton Connect applications close.

ACCESS THE SCHEDULE DATABASE BACKUP FUNCTION

Perform the following steps to access the Schedule Database Backup function.

1. Navigate to **Terminal Manager > Setup > Options > Schedule Database Backup** option.

2. The following dialog appears.

3. Click the **Select Backup Filename** command button. A file navigation dialog box appears.

**Note**

The screen automatically enters a default name (DB-Backup) in the File name block. The user may keep the name or enter a different file name. Save the file to the default file location in the Triton Connect installation directory, or navigate to a location of your choice. Click the **Save** button to save the file.
4. Check the **Backup Database at Scheduled Time** check box to enable backups. Uncheck the box to disable backups.

5. Determine the number of days between backups and enter this number in the *Number of Days Between Backups* field.

6. After configuring the database backup settings, click the **Done** command button to save the information and schedule the next backup (Date of Next Backup). Otherwise, click the **Cancel** command button to cancel any changes and return to the Terminal Manager screen.

Once the Date of Next Backup arrives and the user exits the Terminal Manager, a prompt will open for the user to click on either the **Yes** or **No** buttons to backup the database.

If the user selects “Yes”, Triton Connect will backup the database and schedules the next backup date. If the user selects “No”, the Terminal Manager will exit, but will continue to prompt the user upon subsequent exits with the same message until the prompt receives a “Yes” or the user unchecks the *Backup Database at Schedule Time* box.

The *Date of Last Backup* shows the date the backup occurred. If this date shows after the *Date of Next Backup*, the user selected “No” to the backup prompt. The *Number of Days Between Backups* determines the next calculated backup date.

---

**REPAIR/COMPACT/REPLACE DATABASE**

This function repairs or compacts the terminal database, or replaces the terminal database with a previously created backup file.

**ACCESS THE REPAIR/COMPACT/REPLACE DATABASE FUNCTION**

Follow these steps to access the Repair/Compact/Replace Database functions.

1. Navigate to the **Terminal Manager > File > Repair/Compact/Replace Database** option.

   ![File Menu](image)

2. The Repair/Compact or Replace Database screen appears.

   ![Repair/Compact/Replace Screen](image)

Select either the **Repair/Compact Database** button or **Replace Original Database with Backup** button to start the process.

---

**REPAIR/COMPACT DATABASE**

This function corrects errors that may occur in the Triton Connect main database. After completion of the repair operation, the database compacts, if possible. This can often speed up access to the database.
**Caution**

All other Triton Connect applications must close, before the repair/compact will start.

Click the **Repair/Compact Database** command button. The database repair/compacting operation will start. No further input required. The Terminal Manager main screen will return at the conclusion of the operation.

**REPLACE DATABASE WITH BACKUP**

If the Repair/Compact Database function does not fix the problem, the user can replace the existing database with a backup.

**Note**

Users will lose any database information received since the last backup.

Follow these steps to replace the existing main database with a backup copy.

1. Click the **Replace Original Database with Backup** command button.
2. A warning message will appear. Proceed only if the existing database requires reverting to an earlier version of the database. Click the **OK** button.
3. A file navigation dialog box appears. Locate and highlight the desired backup file. Click the **Open** button.
4. The database replace process will begin. Message boxes will report the progress and successful conclusion of the process. Click the **OK** button to return to the Terminal Manager main screen.

**SERIAL FILE TRANSFER OVER TCP/IP**

Triton Connect can send files to the ATM using serial file transfer mode over TCP/IP, excluding terminals using a serial communications device, such as Radio PAD.

**ADD NEW TERMINAL DIALOG**

The user can enable the Serial File Transfer for a terminal when added to Triton Connect.

1. Navigate to the **Terminal Manager > Setup > Add New Terminal** option.
2. With the ATM Connection Type set to TCP/IP, click the check box for **Use Serial File Transfer Protocol**.
3. Continue configuring the ATM in Triton Connect as normal.

**MODIFY TERMINAL DIALOG**

If the ATM has a connection to the Triton Connect database, use the Modify Terminal screen to setup the **Serial File Transfer Protocol**. To modify a terminal to use Serial File Transfer, perform the following steps.

1. Navigate to the **Terminal Manager > Setup > Modify Terminal**.
2. Select the desired ATM from the list.
3. Click the check box for **Use Serial File Transfer Protocol** option.
4. Click the **Update** button.

**END OF TERMINAL SETUP**
CHAPTER 5 - GET TERMINAL DATA

INTRODUCTION

After installing Triton Connect, configure the Call Monitor application; add terminals to the database; and schedule calls to those terminals. Triton recommends collecting data from each terminals to obtain a reference or baseline prior to any future changes.

The Get Terminal Data function provides several options to retrieve specific kinds of data from the selected terminals. The options fall into these categories:

- Get Terminal Parameters
- Get Journal Data
- Synchronize Date and Time
- Get Error Status
- Get Selectable Coupon Data
- Get Selected Parameters
- Get File from Terminal

ACCESS THE GET TERMINAL DATA FUNCTION

1. Navigate to the Terminal Manager > Terminal Data > Get Terminal Data option.

   ![Terminal Manager Screen](image)

2. The Get Terminal Data screen appears.

   ![Get Terminal Data Screen](image)

SELECT A TERMINAL

The Get Terminal Data fields help to identify a particular terminal. They provide the criteria for the search and filter capabilities of Triton Connect to locate, identify, and group terminals.

The Terminal ID: provides the user a list of available terminals to select.

![Terminal ID Selection](image)

The Search feature provides an efficient means of selecting a terminal, instead of scrolling through a long list. Utilize the Filters function to arrange terminals into smaller groups, according to specific criteria.
SELECT MULTIPLE TERMINALS

Click the **Broadcast** button and select multiple terminals that meet the data retrieval request.

The **Build Broadcast List** appears.

Highlight the terminals from the Available list.

To highlight a group of terminals, click on the first terminal, then press the (SHIFT) key and click on the last terminal in the group. This will highlight the first, the last, and all terminals in between.

To highlight multiple terminals that do not fall neatly into a group, press and hold down the (CTRL) key while clicking on terminals in the list.

Click the **<-Add** button to add the highlighted terminals to the Broadcast list.

If the user needs to broadcast to all terminals in the Available List, click the **<-Select All** button and all terminals will move to the Broadcast list in a single step.

Click the **Clear All ->** button to move all terminals from the Broadcast list back to the Available List.

If the user needs to remove a selected terminal from the Broadcast List, Click the file(s), then click the **Remove ->** button to return the selected terminal to the Available List.
When the user selects a terminal, in either the Broadcast or Available Lists, the terminal’s address fills the data blocks on the lower part of the screen.

**SELECT A DATA OPTION**

Click all required check boxes under the Select Options area to retrieve the data from the terminal. Uncheck the boxes of data not needed.

**Note**

Unselect all options to display functions—grayed out—not supported by the specific terminal.

**GET TERMINAL PARAMETERS**

Triton Connect will obtain all terminal parameter data for the selected terminal(s).

**GET JOURNAL DATA**

This function will obtain all journal data for the selected terminal(s). Click this option and the following screen will open.

Select Retrieve all the Journal entries for all Journal entries, or select Retrieve the last number Journal entries and enter a number of desired entries. Click the OK button. On the Get Terminal Data screen, click the Get Data button and the following window appears.

Enter the Date/Time interval to obtain the journal data. See the Example on the above window. By not adding the last two characters and the two commas, the data retrieval will run only once.

**JOURNAL CLEARING**

The Journal Clearing set to “Auto” causes the terminal to clear and audit its Electronic Journal after each scheduled Get Journal Data command activity. If the uncleared journal size reaches the terminal's limit, the terminal will enter and remain in an OUT OF SERVICE condition until the user clears the journal.

With “Manual” selected and the terminal’s Electronic Journal not cleared before the next Get Journal Data command, the journal will contain previously saved
entries, which when downloaded and stored in the journal database will cause duplicate entries.

**Synchronize Date & Time**

Select the Synchronize Date & Time option.

This function sets the selected terminal’s date and time to match the Triton Connect PC date and time. This will account for time zone and daylight savings differences, if any.

**Get Error Status**

Select the Get Error Status option.

Triton Connect will obtain all terminal error status information for the selected terminal(s). When the user clicks Get Terminal Parameters, the Select Options function automatically checks the Get Error Status option. If the user does not want to obtain error status, Click the Get Error Status to uncheck the box.

**Note**

To get only the error status, uncheck the Get Terminal Parameters and click the Get Error Status.

**Get Selectable Coupon Data**

Select the Get Selectable Coupon Data option.

This function retrieves the number of coupons dispensed totals. Check the Get Selectable Coupon Data box and a message box appears.

Click the Yes button to clear stored coupon totals after retrieving the coupon data. Click the No button to retain the previous totals after retrieving the coupon data.

**Number of Coupon Dispenses**

The terminal can track up to 99,999 coupon dispenses. The Get Selectable Coupon Data retrieves the totals and provides it for analysis in the Coupon Report function of the Reports Manager.

**Get Selected Parameters**

Select the Get Selected Parameters option.

This option allows the user to retrieve selected parameters instead of the entire parameter list. Click the Get Data button.

**Note**

The user must uncheck the Get Terminal Parameters option to select Get Selected Parameters.

Highlight the required parameter. Press and hold the Control key (CTRL) to select more than one option.

Click the Add button to move the selected parameters to the Parameters to Receive column and click the OK button.
Click the *Get File from Terminal* option and the following window appears.

![Get File from Terminal](image)

This option will retrieve the terminal's recycling dispenser G60 Log File, if the terminal has this type of cash deposit and cash dispensing dispenser.

### CALL SCHEDULING

Select the terminal(s) and specify the data options required. Click the *Get Data* button and a scheduling window appears.

![Scheduling Window](image)

The scheduling window provides a means to choose a date, time, and contact interval when calling the terminal(s).

The scheduler appears with the current date and time already loaded. It provides a quick way to schedule a one-time-only call to the selected terminal(s). Click the *OK* button and the scheduled call activates immediately.

The scheduler window offers all the information needed for the user to create a customized contact time, including a breakdown of the scheduling format and an example entry.

As an additional aid in understanding and composing call times, the next page includes a table, which provides an additional example, as well as a breakdown of each part of the contact time. The table also provides space for the user to write in the values for a contact time, if desired.

**Triton Connect 6.2, SP1:** *(Schedule the action to be performed on an incoming call)* At the scheduled time, Triton Connect will look for a check in the box. If no check, the event is processed as normal. If check in the box, Triton Connect will wait for the ATM to call it, before processing the event.

Click the *OK* button to accept the scheduled time. Status Monitoring in the next chapter covers the various ways to view the call status.

### PERSISTENT CALLS

These calls repeat on a continuing basis.

The values assigned to Interval Count and Interval specify when to contact the terminal on a repeating basis. An Interval Count and Interval of *(2,d)* for example, tells Triton Connect to make calls every two days, until you change the contact schedule.

As additional examples, *(4,h)* specifies a call, every four hours; *(3,d)* specifies a call, every three days; *(2,w)* specifies a call, every two weeks; and *(6,m)* specifies a call, every six months.

**Note**

When entering Persistent Calls values, ensure the time contains no spaces between the AM/PM, commas, and values.
Call the terminal on December 5, 1996, at eight thirty in the morning, then two days later, at the same time. Continue making calls every two days.

```
12/5/96 8:30 AM, 2, d
```

### Table: Call Scheduling

<table>
<thead>
<tr>
<th>Month</th>
<th>Day</th>
<th>Year</th>
<th>Hour:Minute</th>
<th>AM/PM</th>
<th>Interval Count</th>
<th>Interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>5</td>
<td>96</td>
<td>8:30 AM</td>
<td>AM</td>
<td>2</td>
<td>d</td>
</tr>
</tbody>
</table>

### VALUES

- **Month**: Use 1-12, corresponding to the months January through December.
- **Day**: Use 1-31, as appropriate for the month in question.
- **Year**: Valid for years 1980 through 2080.
- **AM/PM**: Hours in standard 12-hour time format. Minutes can be 0-59.
- **Interval Count**: Select an Interval Count appropriate to the Interval type chosen. The Interval Count represents the number of Intervals between calls, beginning at the start day and time you specified. For one-time-only calls, do not include an Interval Count.
- **Interval**: Valid intervals are: H=Hours, D=Days, W=Week, M=Month. For one-time-only calls, do not include an Interval.

### End of Getting Terminal Data
CHAPTER 6 - STATUS MONITORING

INTRODUCTION

There are several ways to monitor Triton Connect activities as it performs call operations. These methods exist throughout the suite of Triton Connect applications. For example, The Call Monitor, provides two methods of monitoring Call Processor operation covered in Chapter 4, Call Monitor Setup.

In addition to those methods, others can be found in the Terminal Manager, Call Viewer, and Alarm Monitor applications. These methods enable the user to monitor call activities and see the results of status queries to the terminal, including errors detected during attempted calls and terminal error conditions. In this chapter, we will cover these methods.

VIEW TERMINAL STATUS

This function enables you to see the last error code received from a terminal, along with a description of that error code. In this section you will learn how to access and view the status information provided by this function.

ACCESS THE TERMINAL STATUS FUNCTION

Navigate to the Terminal Manager > View > Terminal Status option.

The Terminal Status window provides information in a tabular format. Note the column headings.

<table>
<thead>
<tr>
<th>Terminal ID</th>
<th>Error Code</th>
<th>Error Desc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE</td>
<td>0</td>
<td>No Errors</td>
</tr>
<tr>
<td>TEST1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>TEST2</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

This column will list the IDs of every terminal contacted by Triton Connect and has returned status information.

<table>
<thead>
<tr>
<th>Terminal ID</th>
<th>Error Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE</td>
<td>0</td>
</tr>
<tr>
<td>TEST1</td>
<td>0</td>
</tr>
<tr>
<td>TEST2</td>
<td>0</td>
</tr>
</tbody>
</table>

This column will hold the last status code received from the terminal. Unless an error has occurred, this code will be zero (0).

<table>
<thead>
<tr>
<th>Terminal Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal ID</td>
</tr>
<tr>
<td>SAMPLE</td>
</tr>
<tr>
<td>TEST1</td>
</tr>
<tr>
<td>TEST2</td>
</tr>
</tbody>
</table>

This column will hold a description of the last status code received from the terminal. Unless an error has occurred, the block displays the code “0 - No Errors”.
MESSAGE SENT TO

This column indicates a paging message sent to the e-mail address or the pager as configured in that status message setting and the success or failure of sending the message.

REFRESH / AUTO REFRESH

Auto Refresh - A check mark indicates the screen updates each time the Data Manager has new information for this function.

Refresh - With Auto Refresh unchecked (Disabled), click the Refresh button to update for new information.

VIEW THE CALL LIST

When the user schedules a terminal for contact, the call moves to the Call List, which holds a record of the request, waiting until the scheduled call time occurs. At that time, Triton Connect attempts to place the call to the terminal, using an available Call Processor to handle the communication details involved.

CALL DELAY

A non-changeable fifteen (15) second delay takes place between consecutive outgoing calls. This delay provides a “window of opportunity” to receive incoming calls from terminals.

**Note**
If the ATM does not or will not call back, Triton Connect will wait up to an hour before picking up the next call in the call list.

If while monitoring the call list, the user observes an unusually long delay in receiving a return call from a terminal. The user may delete the call from the list, so the affected telephone line can process other calls.

In such cases, troubleshoot the affected terminal’s return call delay problem.

The Call List provides information concerning each call. The tabular layout makes it easy to check the call status of a terminal. In this section, you will learn how to access and interpret the information provided by the Call List.

ACCESS THE CALL LIST FUNCTION

Navigate to the Terminal Manager > View > Terminal Call List option. The Call List window opens.

**Note**
Click on a field heading to sort the column in ascending and descending order.

VIEW CALL LIST INFORMATION

The Call List uses a table approach to present information. It provides a single-line entry for each terminal ID scheduled for contact. On each line, column headings identify the types of information available in the entry. To see all the column headings, scroll the display horizontally, as in the following examples.
The following paragraphs discuss these headings.

**Terminal ID.** The name Triton Connect uses to identify this terminal in the database.

**Time to Call.** The time of the next scheduled call to this terminal.

**Attempt.** The number of attempts Triton Connect has made to contact this terminal. Triton Connect will make up to five attempts to reach the terminal before reporting a call error.

**Time Contacted.** The time the terminal achieved a successful call.

**Called.** The flag indicates the result of a terminal contact. (-1) defines a successful contact. (0) defines failed contact to the terminal.

**Terminal Phone.** The telephone number used to contact the terminal. Upon the initial creation of the terminal record, the database stores the telephone number.

**Call Interval Count.** The Interval Count chosen when scheduling this terminal for contact. The number of Intervals between calls, beginning at the start day and time specified.

**Call Interval.** The Interval chosen when scheduling this terminal for contact. Valid intervals: H=Hours, D=Days, W=Week, M=Month.

**Record Busy.** If changes to the terminal’s call status, occurs as the database accesses the Call List entry, a (-1) will appear in the field. If not, the value will be (0).

**Auto/Manual.** This entry shows whether the terminal’s Journal Clearing option is set for Automatic (-1), or Manual (0).

**CMD1 - CMD2.** The Command fields contain codes representing the commands in the terminal message. Each contact message contains up to eight commands.

The character that appears in each field represents a specific command to the terminal. (P = Get Parameters), (C = Change Parameters), (E = Get Error Status), (J = Get Journal Data), and (T = Synchronize Date and Time).
DELETE INDIVIDUAL CALL LIST ENTRIES

User deletes a call from the Call List by clearing it.
Follow these steps

1. Click the arrow symbol next to the Terminal ID field to highlight the entry for deletion.

<table>
<thead>
<tr>
<th>Call List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal ID</td>
</tr>
<tr>
<td>SAMPLE</td>
</tr>
</tbody>
</table>

2. Place the mouse cursor in the Terminal ID field and click once.

3. Press the DELETE key on the keyboard to remove the entry from the Call List.

CLEAR THE CALL LIST

If the user needs to remove all entries from the Call List, follow these steps.

1. Click the Clear button.

A confirmation message appears.

<table>
<thead>
<tr>
<th>Clear Call List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear entire Call List?</td>
</tr>
<tr>
<td>Yes</td>
</tr>
</tbody>
</table>

2. Click the Yes button to clear all items from the Call List.

VIEW THE CALL ERROR LIST

The Terminal Error List stores entries for failed terminal contacts, which falls into the following two categories.

- Five attempts were made to contact a terminal, but the terminal did not answer.
- A terminal called successfully, but did not return the call.

ACCESS THE CALL ERROR LIST FUNCTION

Navigate to the Terminal Manager > View Terminal Call Error List option. The Call Error List window appears.

VIEW CALL ERROR LIST INFORMATION

The Error List information displays in a table format. Each line entry represents a single terminal contact. The columns hold the various data fields that contain the data associated with that terminal contact attempt. To see all the column heading, scroll the display horizontally.

Terminal ID. The name Triton Connect uses to identify this terminal in the database.

Terminal ID
TECHWRITER
**Time to Call.** The time of the next scheduled call to this terminal.

**Attempt.** The number of attempts Triton Connect has made to contact this terminal. Triton Connect will make up to five attempts to reach the terminal before reporting a call error.

**Time Contacted.** The time of a terminal’s successful call.

**Called.** The flag indicates the result of a terminal contact. (-1) defines a successful contact. (0) defines failed contact to the terminal.

**Terminal Phone.** The telephone number used to contact the terminal. Upon the initial creation of the terminal record, the database stores the telephone number.

**Call Interval Count.** The Interval Count chosen when scheduling this terminal for contact. The number of Intervals between calls, beginning at the start day and time specified. Example below: make attempt to contact the terminal after every tenth count.

**Call Interval.** The Interval chosen when scheduling this terminal for contact. Valid intervals: H=Hours, D=Days, W=Week, M=Month. Example below, (10, d): make attempt to contact the terminal every tenth day.

**Auto/Manual.** This entry shows whether the terminal’s Journal Clearing option is set for Automatic (-1), or Manual (0).

**CMD1 - CMD2.** The Command fields contain codes representing the commands in the terminal message. Each contact message contains up to eight commands.

The character that appears in each field represents a specific command to the terminal. (P = Get Parameters), (C = Change Parameters), (E = Get Error Status), (J = Get Journal Data), and (T = Synchronize Date and Time).

### RESCHEDULING CALLS

If the user wishes to place a failed call back in the *Call List*, use the rescheduling function.

1. Click the **Reschedule** button.

The following confirmation message appears.

2. Click the **Yes** button. A call scheduling dialog box opens.
Schedule a time for the next attempt and click the OK button. The Terminal Manager removes the entry from the Call Error List and places it back in the Call List.

**CLEAR THE CALL ERROR LIST**

The Terminal Error List may contain only entries not in need of rescheduling, or serve no other useful purpose. Follow these steps to remove these entries from the list.

1. Click the Clear command button.

2. A series of confirmation messages will appear. Click the Yes button to these messages to clear ALL entries from the Terminal Error List.

**REFRESH THE ERROR LIST**

The Call Error List displays a “snap shot” of the terminal’s current contact errors. This picture of events may not reflect the most recent entries, especially if some time has passed with the list still open.

To refresh the display, click the Refresh button.

The display will update with the most current Error List status.

**USING THE CALL VIEWER**

Call Processors manages the details of placing calls to terminals and answering calls from terminals. They communicate directly with the communications hardware to process the transfer of data between the Triton Connect PC or network and one or more remote terminals.

Because the Call Processors will usually be running on the Modem Server PC in a network environment, other PCs on the network may not have convenient access to the Call Processors. Triton Connect provides a solution. The Call Viewer application allows any legally licensed PC on the network to remotely view the activity of each Call Processor.

In this section of the chapter, you’ll learn how to access and use the Call Viewer.

**ACCESS THE CALL VIEWER**

1. Navigate to the Terminal Manager > View menu.
2. Select the Call Processors option.

- OR -

3. Click the Windows Start/Programs menu.
4. Navigate to the Triton Connect applications group and select the Launch Call Viewer program.

The Call Viewer dialog box appears.
CONNECT TO THE CALL MONITOR

When the Call Viewer window opens, the utility will attempt to contact the Call Monitor, using a TCP/IP connection.

**Caution**

Call Viewer-to-Call Monitor communications requires the TCP/IP protocol installed on the computer. (See Chapter 2, Installation, for instructions on installing the TCP/IP protocol.)

The viewer lists Call Processors running.

If no Call Processors listed, check the following.

- Are any Call Processors running? Check the Call Monitor and start Call Processor(s), if necessary.
- Is the Call Viewer enabled at the Call Monitor? Make sure the Call Monitor’s Diagnostic menu has checked Enable Call Viewer option.
- Are the TCP/IP address and/or Port Number settings correct? Click the TCP/IP Settings option in the Call Monitor > Settings menu. This will open the TCP/IP Settings dialog. Make a note of the TCP/IP Address and TCP/IP Port number for the Call Monitor-Call Viewer entry.

Click the TCP/IP Settings option in the Call Viewer > Settings menu. This will open the Settings dialog. Check the IP Address and Call Monitor Port Number settings. The settings should match those noted for the Call Monitor. If necessary, change the values to match the Call Monitor settings.

MANAGE VIEWER WINDOWS

To see the activity of an individual Call Processor, select it in the list and click the Show button.

A viewer window will open and show the activity of that Call Processor, as in this example.

The Show button changes to a Hide button if the highlighted Call Processor appears in the viewer window.

Click the Hide button to make the currently selected viewer window invisible. The Hide button changes to a Show button.

To quickly display the viewer windows for ALL running Call Processors, click the Show All button.
Or use the **Hide All** button to temporarily make ALL displayed viewers invisible.

Use the **Make All Same Size** button to force all open viewer dialogs to match the size of the currently selected call viewer dialog.

Pause and resume the activity of all displayed viewer windows by clicking the **Screens Paused** option in the Settings menu.

A check mark indicates that all viewer windows are paused. Check the title bar of a viewer window to see if the status shows “Screen Paused”.

Also pause the activity of a selected viewer by clicking the **Pause** button on that viewer’s dialog.

---

**ALARM MONITOR**

The Alarm Monitor application provides a log of terminal error conditions. With the application running, it automatically receives error status as calls from the terminals. In this section, the user will learn how to access and view the status information provided by the Alarm Monitor.

**ACCESS THE ALARM MONITOR FUNCTION**

Start with Windows Start/Programs/Triton Connect menu. Select the Alarm Monitor application.

**VIEW ALARM MONITOR INFORMATION**

The Alarm Monitor status window provides information in a tabular format. A single-line entry for each terminal ID reports an error condition. On each line, column headings identify the types of information available in the entry. To see all the column headings, you will need to scroll the display horizontally.

Most of the information presented for each terminal ID arrives from the database, and provides additional identifying information, such as terminal address, and points of contact. The database receives this information with each new terminal added. See Chapter 4, Terminal Setup, for the procedure.

The Error Condition column provides the terminal’s most recent error indications. Look up the error code at www.tritonatm.com/service_and_support/error_code_lookup for a complete listing of the error descriptions and recommended user’s action. Refer to your ATM manual for further information on error codes.
“POP-UP” FEATURE

Normally, the *Alarm Monitor* will run in a minimized state in the Windows Task Bar. Every 30 seconds, the *Alarm Monitor* will check the terminal status table in the database for changes. When it detects a change, the *Alarm Monitor* will “pop” to the front of any application windows. The most recent error status will appear at the bottom of the Alarm Monitor status listing. To disable this feature, Click *Settings* and click the **Disable Pop-up** button.

![Image of Triton Connect Alarm Monitor]

VIEW THE STATUS MESSAGE LOG

The Status Message Log holds a record of the attempts by Triton Connect to report terminal status conditions to personnel using email message or pager calls.

![Image of Status Message Log]

ACCESS THE STATUS MESSAGE LOG

Navigate to the *Terminal Manager > View > Status Message Log* option.

The Status Message Log window replaces the Terminal Manager screen area, shown below.

![Image of Status Message Log window]

END OF STATUS MONITORING
CHAPTER 7 USING FILTERS

INTRODUCTION

The filters function permits the creation of special filtering statements that act as database filters, limiting the number of records visible at any one time to only those records which match a set of conditions the user specifies in the statement. The filters usefulness shows for operators in a network environment who work with many terminal records, but handle only small groups of the entire terminal database, or search for certain records of immediate interest.

For example, the function displays only those terminal records for a city, or only those terminals belonging to an organization. In general, activating a filter allows only those terminal records that match the filter criteria to show in the various terminal management functions. This includes all Terminal Data menu functions as well as the Delete and Modify Terminal, View and Set Terminal Parameters, View Terminal, Journal Data, Terminal Setup, and Report Manager functions. When working in the terminal management functions, a small icon sits in the lower right corner of the function window. This icon shows the status of the filter function.

For an active filter, the icon appears as shown.

Place the mouse cursor over the icon and a “help balloon” displays the name of the filter.

With no active filters, a cross overlays over the icon as shown here.

THE FILTERS MENU

Navigate to the Terminal Manager > Filters > Create/Edit/Delete option.

The Create/Edit/Delete function creates and manages filters. The Set Active Filter option, a cascading menu, lists the available filters by name, as shown in this example.

Click the filter’s name to enable a filter. The selected filter becomes the active filter and appears in a list at the bottom of the Filters drop-down menu box, as the Current Filter.
To turn off all filters, navigate to the Terminal Manager > Filters > Set Active Filters and click the No Filter option.

**FILTER CREATION AND MANAGEMENT**

As stated earlier, the Create/Edit/Delete Filters function creates and manages the filter statements. These statements act as database filters, making only those terminal data records that match a descriptive criterion available at any given time.

The user creates and manages these statements described under these headings.

- Creating A Filter
- Viewing A Filter
- Saving A Filter
- Editing A Filter
- Deleting A Filter

**CREATE A FILTER**

To create a filter, the filter statement joins a combination of drop-down list selections and user-defined entries.

**THE NEW COMMAND**

Click the **New** command button to clear the File Name: text entry box, which prepares the controls to accept the entries that will make up a new filter statement.

Enter a new filter name in the Filter Name text entry box.
BUILDING THE SQL FILTER STATEMENT

Three drop-down list and a text entry box provides the tools to build the filter statement.

1. Select the initial field of interest from the first drop down list. If necessary, a second row will permit the selection of an additional field from this list.

2. Choose a comparison parameter from the second list. These values will compare the field in the first box to the user-specific value selected in the third box.

3. Enter a value for comparison in the third box. The selected value should create a small number of records within the range of the selected field in the first block.

4. Finish the filter statement with the END command. If further refinement of the filter statement is necessary, use the And/Or commands. Selecting either And or Or, provides a second line with four fields. The fourth field only has the END command.

MORE EXAMPLES

The image displays an example of combined filter commands.

Combining the available filter criteria commands with words or phrases that describe specific terminals or groups of terminals in your database, creates filter statements to meet a wide range of needs.

VIEW A FILTER

The Generated SQL Statement window displays the actual commands joined together as the user builds the filter statement. The final statement appears below using the entries from the example image above.
SAVE A FILTER

Click the **Save** command button to save the filter statement with the name you specified earlier. All fields will clear and allow for the creation of another filter. The saved filter will appear in the drop-down portion of the box.

On a standalone (non-network) system, click on the filter entry in the *Set Active Filter* menu to activate it. A network environment requires some additional considerations.

To access filters created at other workstations on the network, update the Filters database by selecting any available filter, or by existing and re-entering the Terminal Manager application. This operation will update or refresh the list in the *Set Active Filters* menu, and display any additional entries for filters created by other operators.

DELETE A FILTER

When a filter is no longer needed, delete it by performing the following steps.

1. Select a Filter from the Filter Name list box.
2. Click the **Load** command button to load the filter statement.
3. Click the **Delete** command button and click the **Yes** button on the confirmation message to remove the filter.

FILTER BY PARAMETERS

To create a filter utilizing parameters, perform the following steps.

1. Navigate to the *Terminal Manager > Filters > Create/Edit/Delete Filter* option.

MODIFY A FILTER

The following steps summarize the procedure to modify an existing filter.

1. Select an Existing Filter.
2. Click the **Load** command button.
3. Change the Filter Name, if desired.
4. Change the filter statement components as necessary. If the statement has multiple lines, select and edit the additional lines as needed. If you wish to delete a line, select the **END** statement on the previous line.
2. Enter the name for the new filter in the *Filter Name:* field.

3. In the *Build Parameter Filter* area, select the parameter in the first field. Select *Matches* or *Is Not* in the second field.

4. Enter a Value in the third field.

5. In the last field, select either End, And, or Or.

6. For (And or Or), an additional parameter row appears to either Match or IsNot additional values.

7. Click the *Save* button, then click the *Yes* button.

**Note**

*Triton Connect 6.2 SP1:* With an active filter, the Terminal Manager’s Terminal Status, if enabled for the dashboard, will show only those ATMs matching the filter’s criteria.

**END OF USING FILTERS**
Chapter 8 - Terminal Parameters

Introduction

This chapter introduces the terminal parameters. These values affect the terminal operation or report the status of various terminal operations.

Many terminal parameters allow a user logged in with the Supervisor's password to alter the value or state of the applicable parameter, which changes the operation of a selected terminal. Other parameters do not allow the user to change the values, but allow them to view the read-only parameters.

Caution

Triton Connect provides a powerful feature to change the terminal's operations. Exercise caution when making any changes and only when the user understands the exact effect it will have on the terminal!

Access Terminal Parameters

Navigate to the Terminal Manager > Terminal Data > View Terminal Parameters option. By default, the Select Terminal section appears first in the Terminal Parameters screen.

Alternatively, click the Next and Previous buttons to move forward or backward through the list of available terminals.

When the user selects a terminal, a portion of the address data for that terminal fills in the fields at the left of the main window.

Select one or more terminals to view or configure.

Select A Terminal - General Procedure

1. Use the Select Terminal ID drop-down list and select a terminal’s ID.
2. Click the **View Parameters** button.

![View Parameters Button]

The Terminal Parameters screen changes to a tab format screen.

![Terminal Parameters Screen]

The screen provides a list terminal parameter categories:

- **Ad Graphics/File Manager**
- **Advanced Settings**
- **Amounts**
- **Cassette Stat**
- **Comm**
- **Control**
- **Format**
- **ISO No./Owner Info**
- **Triton Connect Settings**
- **Messages/Coupons**
- **Version Numbers**

3. Click a tab to view the parameter. The tab presents the state of the parameter as of the last time the terminal sent the parameters. See Chapter 5, Getting Terminal Data, for more information. The upper-right corner of the Terminal Parameters screen displays the last contact date and time for the selected terminal.

4. If the user wishes to select a different terminal, click the **Previous** or **Next** button at the top of the screen. The Select Terminal block replaces the tab screen. The user can continue to click the **Previous** or **Next** button, or select a terminal from the Select Terminal ID list box.

5. Click the **View Parameters** button.

**Note**

Triton Connect must contact the terminal prior to the terminal downloading its parameters for viewing. If the user selects a terminal for which no data has been previously downloaded, the Terminal Parameters screen will display a warning message with the **View Parameters** button grayed out.

![Warning Message]

**SELECT MULTIPLE TERMINALS FOR BROADCAST FEATURE**

**Note**

Selecting the **View Terminal Parameter** option grays out the **Broadcast** button. The user must select Terminal Manager > Terminal Data > Set Terminal Parameter option to enable the Broadcast button.

1. Click the **Broadcast** button.

![Broadcast Button]

The Build Broadcast List appears.

![Broadcast List]

2. Highlight the terminal(s) for selection in the Available list.

**SELECT MULTIPLE TERMINALS**

- To highlight a group of terminals, click once on the first terminal, then hold down the **SHIFT** key while clicking on the last terminal in the group. This will highlight the first terminal, the last terminal and any terminals in between.
To highlight multiple terminals that do not fall neatly into a group, hold down the CTRL key while clicking on any terminal anywhere in the list.

3. Click the <-Add button to add the highlighted terminal(s) to the Broadcast list.

4. Repeat the last two steps for any other terminal(s) desired in the Broadcast List.

5. The user may wish to broadcast to all terminals in the Available List, click the <-Select All button to highlight all the terminals and click the <-Add button to move them to the Broadcast list in a single step.

Caution

Moving multiple terminals from the Available List to the Broadcast List may trigger a Broadcast Warning message. Read and understand the warning message before selecting one of the three response buttons.

6. The User may remove one or more terminals from the Broadcast List. Use the procedures described in Step 2 to highlight the terminal(s) and then click the Remove -> button to return the terminal(s) to the Available List.

7. The user may move all the terminals in the Broadcast list back to the Available List, by clicking the Clear All -> button.

8. Select a terminal in the Broadcast List to activate the View Parameters button.

9. Click the View Parameters button to view the terminal parameter tabs.

10. The Broadcast List appears in the upper-left corner of the Terminal Parameters main dialog. Use the up and down arrows to scroll through the list.
Select the parameter tab and make the necessary parameter changes.

1. Changes to a parameter entry will appear **red** to indicate the value has been changed.

   - If a data entry field or control is not applicable to the currently selected terminal, the field or control will be grayed out or disabled.

   **Note**
   If all choices are grayed out, verify the user chose “Set” parameters rather than “View”.

2. If a single terminal is selected, each parameter change will apply to that terminal only.
3. If a broadcast list was used, each parameter change will be applied to all terminals in the list.

   **Note**
   When broadcasting parameters, all ATMs should be of similar type. For instance, graphics for a Model 97XX ATM cannot be sent to a Model RL5000 ATM unit.

After changing all parameter, click the **Send Parameters** button to schedule the terminal(s) for contact.

This will bring up a call scheduling window.

The scheduling window provides a means to choose a date, time, and contact interval when calling the terminal(s). Notice the scheduler appears with the current time, by default, as the contact time already loaded and ready to use. It provides a quick way to schedule an immediate, one-time only call to the selected terminal(s). If the user needs to schedule the call immediately, click the **OK** button.

If the default contact time is not acceptable, change the date, time, interval count and interval. The scheduler window offers all the information needed to create a customized contact time, including a breakdown of the scheduling format and an example entry.

The changes will be sent to the selected terminal (or multiple terminals, if the Broadcast feature was chosen) at the scheduled time.

Once a suitable contact time has been composed and entered in the scheduling window, click the **OK** button.
Messages use the terminal display screen to convey information to the customer. Messages greet the customer, makes promotional offers, and encourages repeat use.

**Note**

The Store and Marketing Messages also print on the customer’s receipt.

Promotional incentive, awarding a product, service, or discount as an incentive for making withdrawals from the terminal, typically use Coupons. Prizes refer to such awards or incentives.

Occurrence of either a withdrawal above a certain level, *Level Coupon*, or as a random percentage of all withdrawals, *Random Percentage*, triggers Coupons.

When triggered as either a level-based or random event, the terminal prints the coupon after the transaction.

A notification screen appears on the terminal display to inform the customer that a prize award coupon is printing.

This tab lets the user change the message text, configure coupon parameters, and select the language used by the terminal to present customer screens.

### CHANGE MESSAGES

Follow the steps below to change a message.

1. Click the option button for the message needing change, as in this example.

2. Edit the existing message or type a new message in the text window.

**Note**

For the Z180 ATMs, (9100/9600/9700) will have the Coupon configurations on this screen. Refer to Triton Connect Revision 6.0, chapter 8, page 8-7 for details.
**STATUS**

This tab provides a read-only display of the status of various aspects of the terminals’ operating configuration, such as the current operating mode, current terminal status, and security settings. It also allows the user to clear error conditions and reset the terminal.

**READ-ONLY VALUES**

- **Check Digits.** This screen shows the PIN Master, PIN Working, and MAC Master/Working (if used) check digits. After loading the Keys, the terminal generates the Check Digits, which must match a reference set of Check Digits. The terminal displays the Left/Right check digits information if the terminals software requires inputting the key information in that format.

  **Note**

  The parameters identified as ‘Master Key’ and ‘Comms Key’ refer to ‘PIN Master Key’ and ‘PIN Working Key’.

- **Sequence No.** This number increments each time the terminal performs a transaction. The Sequence Number prints on the customer’s transaction receipt and records in the terminal’s electronic journal entry for the transaction.
- **Last Authorization No.** The host processor generates the authorization number and authorizes the terminal to perform a transaction. The block reports the most recent authorization number.
- **DES Chip Loaded.** DES (Data Encryption Standard) encrypts the customer’s data. The word YES indicates the terminal has a DES system installed.
- **Security Module Present.** The Security Module protects communications between the terminal’s control electronics and the dispenser mechanism. The word YES indicates a Security Module installed in the terminal.
- **Demo Mode.** In Demonstration Mode the terminal will operate in a simulated customer transaction mode. The word NO indicates the terminal processes customer transactions normally.
- **Last Dispensed Status.** After each dispense operation, usually the result of a customer withdrawal transaction, the dispenser mechanism in the terminal reports its status. Use the status value to evaluate dispenser problems.
CLEAR ERRORS AND RESET THE ATM

The Error Code line displays the most recent terminal status condition.

| Error Code | 0 - No Errors |

If the Error Code block displays an error status, follow the steps below to clear the error status.

1. Click the **Clear Error and Reset ATM** button. The Error Code block displays the <Cleared> label marked in **RED**. The Red font indicates a changed parameter not sent to the terminal.
2. After making any other required parameter changes, click the **Send Parameters** button to schedule the terminal for contact.

**Note**

For error condition 924 - Counterfeit Note Detected, A message to verify if the user wants to continue when attempting to reset a counterfeit note detected error condition. This applies to ATMs with cash recycling dispensers only.

When parameters are sent to the terminal, the error status will reset. After correcting the condition the Error Code displays an updated status. If the same error appears, contact your service organization. If no errors exist, the Error Code displays a status of ‘0 - No Errors’.

TERMINAL SERVICE STATUS

This button shows the terminal service status that will take effect once the terminal receives the parameters. By default, the service status is set to **Terminal In Service**. Clicking the button changes the status to **Terminal Out of Service**.

**Note**

The ATM software determines whether the terminal supports the **Terminal In Service** or **Out of Service** function. Otherwise, selecting this function will have no effect on terminal operation.

VIEW VEND MATE STATUS

This function discontinued.

NMD STATUS

Click the **NMD Status** Button to view the NMD dispenser’s configuration. If the ATM does not use NMD Dispensers, the Tab does not display the button.
ISO NO./OWNER INFO

The ISO Number identifies an Independent Sales Organization (ISO) or other organization that provides ATM transaction processing services. The magnetic strip on a bank card stores the ISO Number. During a transaction, the ATM reads the ISO Number and determines which action to perform, such as blocking the surcharge.

<table>
<thead>
<tr>
<th>Messages/Coupons</th>
<th>Status</th>
<th>ISO No./Owner Info</th>
<th>Comm</th>
<th>Terminal Totals</th>
<th>Text Ad Screens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Owner</td>
<td></td>
<td>Tech Writer 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surcharge Owner</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

OWNER IDENTIFICATION

- **Terminal Owner.** This message will appear to the customer on the surcharge warning screen. It identifies the name of the terminal's owner.
- **Surcharge Owner.** This message will appear on the Configuration Summary Report in the X-Scale series ATMs or the Printer Test report on all other model terminals. It identifies the name of the individual or organization receiving the surcharge.

To change the Terminal or Surcharge Owner entries, click inside the Terminal Owner or Surcharge Owner entry and type the new message.

OVERRIDE ISO ACTION

Select the check boxes to affect the operations of the ISO numbers Action.
- Click the check box for the “Send ISO regardless of changes”. The terminal will request Triton Connect to send the ISO list if no other options change in the tab.
- Click the check box for the “Allow only ‘Accept’ ISO#”. The terminal will act on the ISO numbers with the ISO Action of ‘Accept’ and ignore all other ISO numbers are ignored.

VIEW / MODIFY ISO NUMBERS

Click the **View/Modify ISO Numbers** button to open the ISO Entry Form. Use this form to view and modify the terminals ISO-based behavior. Enter an ISO number and specify a specific ISO Action. If the terminal reads an ISO number on the customer’s card, an ISO action activates against the customer’s transaction. The terminal may have multiple ISO Numbers.
**Note**

The table below will assist the user to add data to the above ISO Entry Form. If the Host Processor requires the user to enter their data file to the text boxes, proceed to **Import ISO File** section.

<table>
<thead>
<tr>
<th>Control</th>
<th>Event</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spreadsheet / Flex Grid</td>
<td>Double Click ‘Left’ mouse button in a cell under the <em>ISO Number</em> Column</td>
<td>Cell opens to receive input data. Pressing the &lt;Enter&gt;, &lt;UP&gt;, or &lt;DOWN&gt; arrows saves the keyed information to the selected cell and adds a new row to the spreadsheet.</td>
</tr>
<tr>
<td></td>
<td>Single Click ‘Right’ mouse button in a cell under the <em>ISO Number</em> Column</td>
<td>Menu options appear: Copy, Paste, Delete data.</td>
</tr>
<tr>
<td></td>
<td>Single Click ‘Right’ mouse button in a cell under the <em>ISO Action</em> Column</td>
<td>Menu Options appear to change the value of the cell: Block Surcharge, Decline Card, Use Defined Surcharge, Accept, Award Coupon, MPTU Block, Block Transaction Type, Screen Action, or Use Defined Balance Surcharge. This function will change the values of several cells, when user selects multi-cells.</td>
</tr>
<tr>
<td></td>
<td>Single Click ‘Right’ mouse button in a cell under the <em>ISO Value</em> Column</td>
<td>Provides a text field to enter data. Not all ISO Action require a Value entry.</td>
</tr>
<tr>
<td>OK Button</td>
<td>Single Click ‘Left’ mouse button.</td>
<td>Checks for incomplete and inconsistent data fields. Saves changes made by user. Closes the ISO list, spreadsheet.</td>
</tr>
<tr>
<td>Cancel Button</td>
<td>Single Click ‘Left’ mouse button.</td>
<td>Closes the ISO Entry Form without saving changes.</td>
</tr>
<tr>
<td>Apply Button</td>
<td>Single Click ‘Left’ mouse button.</td>
<td>Checks for incomplete and inconsistent data fields. Saves changes made by user. Allows user to continue working.</td>
</tr>
</tbody>
</table>
ADD A NEW ISO ENTRY

Perform the following steps to add a new entry.
1. Double click (with the left mouse button) on an empty cell under the ISO Number column. A data entry box will appear.

<table>
<thead>
<tr>
<th>ISO Number</th>
<th>ISO Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 123456789</td>
<td>Use Defined Balance</td>
</tr>
<tr>
<td>2 11223344</td>
<td>Block Transaction</td>
</tr>
<tr>
<td>3 125478</td>
<td>Block Surcharge</td>
</tr>
</tbody>
</table>

2. Type in a new ISO number and press Enter. The adjoining cell, in the ISO Action column receives a default entry.

<table>
<thead>
<tr>
<th>ISO Number</th>
<th>ISO Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 123456789</td>
<td>Use Defined Balance</td>
</tr>
<tr>
<td>2 11223344</td>
<td>Block Transaction</td>
</tr>
<tr>
<td>3 125478</td>
<td>Block Surcharge</td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

3. In the new entry under the ISO Action column, right-click the cell and select an available Action from the pop-up menu.

Block Surcharge
Decline Card
Use Defined Surcharge
Accept
Award Coupon
MPTJ Block
Block Transaction Type
Screen Action
Use Defined Balance Surcharge
Maximum Withdrawal Amount

4. Right click in the Value column and select an available Value from the pop-up menu, type a monetary value, or the block will stay grayed out.

Allow Mini Statement
Block Mini Statement
Allow PIN Change
Block PIN Change
Bansi Customer BIN

**Note**
If the user selects the Use Defined Surcharge, User Defined Balance Surcharge, or Maximum Withdrawal Amount, ISO action in Step 3, a text box will appear. Select Screen Action and a pop-up menu appears. All other ISO Actions do not have a Value.

IMPORT ISO FILE

A few host processors require the user to import their ISO numbers via a data file. This section describes the import procedure and selectable options.

Click the Import File button on the ISO Entry Form to access the text file in the ISO Folder.

1. Click the Select File button.
2. Locate the text file with the ISO bins and click the Open button.
3. Verify that the setting for Overwriting Existing Entries, the Action, and the Value are set correctly.
4. Click the OK button. Depending on the number of entries, there may be a delay before the ISO entry form fills.
5. Click the Apply button, then click the OK button.
6. Click the Send Parameters button.
**Note**
A check in the Overwrite Existing Entries box will cause the imported file to overwrite all entries on the ISO Entry form. No check in the box will append the imported text file after the last ISO number row.

A description of each Action option provided below.

- **Block Surcharge.** Selecting this action will cause the terminal to allow surcharge-free transactions when a customer uses a card with the currently displayed ISO number.

- **Decline Card.** Selecting this action will cause the terminal to refuse to process transactions when a customer uses a card with the currently displayed ISO number.

- **User Defined Surcharge Amount.** Selecting this option will cause the terminal to apply the applicable surcharge to transactions performed with a card that uses the currently displayed ISO number. The user enters the surcharge amount into the “ISO Action Parameter” box.

- **Accept.** This action supports the ‘Bingo’ feature applicable to UK versions of ATM software. The action applies to transactions performed with cards that use the displayed ISO number.

- **Award Coupon.** This function awards a configured customer coupon to customer cards with the displayed ISO numbers.

- **MPTU Block.** (Mobile Phone Top Up-UK only) This function disallows paying a wireless phone bill for customer cards with the displayed ISO numbers.

- **Block Transaction Type.** This function disallows PIN Services for cards with the displayed ISO numbers.

- **Screen Action.** This function allows user to alter the options on the customer transaction screen to include or block certain transaction options for cards with the displayed ISO numbers.

- **Use Defined Balance Surcharge.** (Australia only) This function works in conjunction with Balance Inquiry Surcharge enabled at the ATM and allows user to enable a surcharge for balance inquiries on cards with the displayed ISO numbers.

The Value list displays values for specific Action items. Not all items will have a value, but present a text box to enter a monetary value.

With the Screen Action selected in the Action block, the Value block will show a list of value options.

- Allow Mini Statement
- Block Mini Statement
- Allow PIN Change
- Block PIN Change
- Banski Customer BIN
Use this screen to setup or change the EMV parameters and applications applied to the bankcards. Click the EMV Settings button.

Click the check boxes on the EMV specific parameters and applications to enable/disable the functions. Click the OK button to save the selected option. Click the Reset button to default the selections. The host processor will determine appropriate parameters and applications for the terminal’s site.

- Enable EMV.
- Allow terminal to process magnetic stripe based transactions.
- Allow terminal to process magnetic stripe data as a fallback.
- ICC will latch and remain latched until user receives a prompted to remove card.
- Terminal will add the tag data stored on the terminal to journal entries.
**COMM**

<table>
<thead>
<tr>
<th>Messages/Coupons</th>
<th>Status</th>
<th>ISO No./Owner Info.</th>
<th>Comm</th>
<th>Terminal Totals</th>
<th>Test Ad Screens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predial</td>
<td>Modem Init. String</td>
<td>Host Phone No.</td>
<td>898-076-3452</td>
<td>Alt. Host Phone No.</td>
<td>109-567-8743</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use this screen to change the communications configuration of the selected terminal. The settings shown apply to communications with the Host Processor servicing the selected terminal.

**Predial**

The Predial function enables the terminal to dial out to the processor as soon as the customer's ATM or credit card has been scanned, thus reducing the overall transaction processing time. With the Predial disabled, the terminal waits until the customer confirms a specific transaction before dialing out.

**Note**

The host processor must support the Predial feature.

Follow the steps below to configure the Predial setting.

1. Click the down arrow in the **Predial** list box to view the options: **Yes** and **No**.

2. Select **Yes** to enable the Predial, or **No** to disable the Predial.

**Modem Init. String**

If the terminal's modem requires a non-standard configuration, type a Hayes-compatible setup string in the text box. The string is sent to the modem when it initializes.

Follow the steps below to enter a Modem Init. String.

1. Click inside the **Modem Init. String**.

2. Type the Modem Init. String.
**PHONE NUMBERS**

If the terminal communicates with the host processor over a dial-up phone line, enter the Host Phone No. and the Alt. Host Phone No. at the terminal during the initial setup.

The Comm tab displays the Host and Alt. Host Phone Numbers in read-only mode.

<table>
<thead>
<tr>
<th>Host Phone No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>898-076-3452</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Alt. Host Phone No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>109-567-8743</td>
</tr>
</tbody>
</table>

**PARITY SELECTION**

In some cases, the host processor may require communications using 8-bits per character and no parity, instead of the more commonly used configuration of 7-bits per character and even parity. The Parity Selection function allows the user to switch between the two types of data-bites and parity.

Follow the steps below to change the parity type.

1. Click the box or the sentence to place a check mark in the check box and use 8-bits with no parity.

   - Use 8 data bits, no parity in place of 7 data bits, even parity for host communications.

2. Remove the check mark to use the 7-bits with even parity.

   - Use 8 data bits, no parity in place of 7 data bits, even parity for host communications.
REMOTE KEY TRANSFER (RKT) SUPPORT

Triton Connect views the state of Remote Key Transfer (RKT) as enabled or disabled. With RKT enabled, Triton Connect can disable this feature. However, once RKT switches to disabled, a technician must visit the ATM to enable the feature.

VIEW RKT STATUS

Click the Remote Key Transfer button.

The Remote Key Transfer screen opens. This window shows the RKT status as enabled

**Note**

If the button does not appear, either the terminal does not support RKT or a user disabled the feature.

CHANGE REMOTE KEY TRANSFER STATUS

Triton Connect uses a two-step sequence to disable the Remote Key Transfer (RKT).

1. Click the Disable RKT button.

A warning message appears. Read and understand the message. Once the RKT is disabled, a technician can only enable the feature at the terminal.

2. If the user does not wish to disable the RKT feature, click the Do Not Disable RKT button and the screen displays the “RKT is Enabled” message.

3. If the user wishes to disable the RKT feature, Click the Apply button and click the OK button. A RED band will surround the Remote Key Transfer button until the user clicks the Send Parameter button.

4. Click the Cancel button on either screen will return to the Comm tab screen.
ABOUT TERMINAL TOTALS
This tab lists significant terminal transaction totals. The values shown are read-only.

TOTAL DEBIT TRANSACTIONS
The total number of checking and savings account withdrawal transactions applied since the last Day Close.

TOTAL CREDIT TRANSACTIONS
The total number of credit card withdrawal transactions applied since the last Day Close.

TOTAL BALANCE INQUIRIES
The total number of balance inquiry transactions requested since the last Day Close.

TOTAL TRANSFERS DONE
The total number of account transfer transactions performed since the last Day Close.

TOTAL DEBIT AMOUNT
The cash number represents the total monetary value of all Debit transactions since the last Day Close.

TOTAL CREDIT AMOUNT
The cash number represents the total monetary value of all Credit transactions since the last Day Close.

**Note**
The value differences from Day Close to Day Close calculates the Terminal Totals. If Day Close function not performed daily, the totals cumulate.
**TEXT AD SCREENS**
This tab applies only to Z180 (9100, 9600, 9700) ATMs.

---

### ABOUT TEXT AD SCREENS

This tab sets up the terminal to download text-based Ad Screens. The Ad screens will appear with the “Transaction Processing Please Wait” message, while the customer waits for the completion of the transaction.

The user can create up to four Ad Screens. Each screen consists up to eight lines of text. The Display Duration (in seconds) sets the number of seconds the ATM displays the Ad Screen.

### DISPLAY OF TEXT AD SCREENS

Graphics Ad Screens take priority over text-based screens. Terminals running Graphics Ad Screens, will not display Text Ad Screens.

Terminals will display Text Ad Screens, if no loaded Graphics Ad Screens available and the Triton Connect or by the local terminal control enabled the Text Ad Screen function.

Follow the steps below to create a text-based Ad Screen.

1. Select the Ad Screen (1, 2, 3 or 4).
2. Move the mouse cursor into the message window area and click the left mouse button to establish the starting point of the message.
3. Type the text as it will appear on the display. Use the Alt-key sequences to help format the text.
4. Assign a duration for the Ad (typically 5 to 10 seconds).

Disable a specific Text Ad Screen by changing the Display Duration to zero (0).
AMOUNTS

Due to the increased amount of information to cover all dispensers, click the Currency Information button to access the Fast Cash amounts assigned to each dispenser. Each column displays the cash amounts for a specific dispenser.

Use this screen to change the cash amounts applicable to the listed parameters, by typing the values directly into the related text boxes.
This sets the maximum amount allowed per customer withdrawal transaction. The amount ranges from 1 to 999999 in increments of 1, but must be an even multiple of the denomination in the cassette. The value uses whole amounts only. No fractions of a whole note allowed. Example: $30.00 is Okay, but $30.55 not allowed.

The ATM compares the withdrawal amount entered, either through a Fast Cash selection or by user-defined entry, to the maximum withdrawal limit. If the amount is larger than the limit, an error message warns the user and displays the maximum allowable amount.

**Note**
The maximum withdrawal amount cannot exceed the lesser of the terminal’s max amount or the maximum set by the ATM’s host processor, since the processor must approve any selected amount.

Example: The terminal’s max amount equals to $450.00, but the processor has set the max to $400.00. The customer’s max withdrawal limit equals to $400.00. If the terminal’s max equals to $350.00 and the processor max equals to $400.00, the customer’s max withdrawal amount equals to $350.00.

Follow the steps below to change the maximum amount.

1. Click inside the Max Withdrawal Amount text box.
2. Enter the maximum withdrawal amount.

Up to seven fast cash amounts offer the customers a quick-cash withdrawal.

Follow the steps below to change the Fast Cash amounts.

1. Click inside a Fast cash text box.
2. Type the fast cash amount.

**Note**
Fast cash amounts are multiples of the denomination. Other amounts will cause an error condition at the terminal.

This sets the maximum non-cash purchase limit. The amount entered must equal an even multiple of the value of a single unit of non-cash purchases in the cassette. The value is in dollar amounts only. No cents allowed.

Follow the steps below to change the maximum amount.

1. Click inside the Max Non Cash Withdrawal Amount text box.
2. Enter the maximum withdrawal amount.

This read-only field indicates the denomination of the currency in the cassette(s).
CASSETTE STAT

<table>
<thead>
<tr>
<th>Amounts</th>
<th>Cassette Stat</th>
<th>Version Numbers</th>
<th>Ad Graphics / File Manager</th>
<th>Receipt Graphics</th>
<th>LED Sign Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cassette A Data</strong></td>
<td><strong>Cassette B Data</strong></td>
<td><strong>Cassette C Data</strong></td>
<td><strong>Cassette D Data</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document Value</td>
<td>$20.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>Cash Loaded</td>
<td>$20,000.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>Reject Events</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Dispensed Amount</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>Cash Remaining</td>
<td>$20,000.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td></td>
</tr>
</tbody>
</table>

ABOUT CASSETTE STAT

This tab provides read-only status information for each cassette in the terminal. Each cassette has its own Cassette Data fields.

DOCUMENT VALUE

Indicates the denomination of notes for multi-cassette terminals. A single cassette unit uses the Cassette A Data fields. Cassette B, C, D Data default to Zero (0) values.

TOTAL TRANSACTIONS

Displayed for single-cassette terminals only. Total number of cash withdrawal transactions involving this cassette.

CASH LOADED

Amount of cash initially loaded into this cassette. Personnel responsible for loading the cassette with cash enters the value at the terminal.

** Note**

A correct Cash Loaded amount entered at the terminal prevents an ATM error with the actual amount of cash in the cassette.

REJECT EVENTS

The number represents the total number of rejects during the dispensing of cash from this cassette.

DISPENSED AMOUNT

Amount of cash dispensed from this cassette since the last cassette load.

CASH REMAINING

Cash remaining in the cassette. Equals Cash Loaded minus Dispensed Amount.
### VERSION NUMBERS

<table>
<thead>
<tr>
<th>Amounts</th>
<th>Cassette Status</th>
<th>Version Numbers</th>
<th>Ad Graphics / File Manager</th>
<th>Receipt Graphics</th>
<th>LED Sign Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model No.</td>
<td>Argos 15 - Handle H1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program Version No.</td>
<td>8.1.0.52 07/26/19</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen Version</td>
<td>BCSF001E 08/15/18</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Triton Controller Version</td>
<td>KX-5B.01</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### ABOUT VERSION NUMBERS

This tab allows the user to view the read-only version numbers for key components of the operating software loaded on the terminal.

#### MODEL #

The **Model #** identifies the terminal.

#### TRITON CONTROLLER VERSION #

The EPROM holds software downloading, initialization, testing, and low-level interface routines. The **Triton Controller Version #** identifies the software loaded on the EPROM chip installed in the terminal.

#### PROGRAM VERSION #

The **Program Version #** identifies the terminal's operating software. Triton Connect or a user at the local ATM will download the software into the terminal.

#### SCREEN VERSION #

The **Screen Version #** identifies the table components loaded in the terminal's operating software. The table components refer to the part of the software that provides the ATM user interface and associated terminal control functionality.

### ADDITIONAL DATA INFO.

Triton Connect supports retrieving and displaying an increased amount of information about the ATM, devices, and general configuration.

**Note**

If the user clicks on the **Version Number** tab and this feature is not available, contact Triton Technical Support to determine if your ATM has a software upgrade with this feature.
Click the **View Config. Overview** button. The screen displays the ATM’s configuration. When Technical Support asks for the configuration and the user is not at the ATM, the following screen displays the hardware and software and parameter setup. The screen has a **Copy Text** button to copy the information into an email or text file.
AD GRAPHICS/FILE MANAGER
Refer to Triton Connect Manual Version 6.0 for this screen. Otherwise, click the Extended Parameters button under the Control Tab.

RECEIPT GRAPHICS
Refer to Triton Connect Manual Version 6.0 for this screen. Otherwise, click the Extended Parameters button under the Control Tab.

LED SIGN MESSAGES
The feature requires custom software for a specific customer. This feature is not available to other customers.
ADVANCED SETTINGS

Depends on your ATM as to which options are available.

ABOUT ADVANCED SETTINGS

This screen provides access to additional terminal parameters. Unless the user understands the effect of the parameters on the terminal’s operation or instructed to enable a feature by the host processor or by Technical Support personnel, do not alter these extremely sensitive functions.

**Note**

A check in the check box makes the parameter active or enabled.

INCLUDE COMMS HEADER IN PROCESSOR REQUEST MESSAGE

Checking this option enables the terminal to include the Communication Header in all request messages to the host processor. The user adds the header to the terminal during the setup and configuration procedures.

INCLUDE ATM STATUS MONITORING

Check this option to provide the status monitoring information to the host processor. Monitoring this status provides important information about the terminal’s operational readiness.

Triton Connect 6.2 SP1: Adds an Advance Status Monitoring option for card reader and EPP information.

RETURN TERMINAL TOTAL TO PROCESSOR

Check this option to enable the terminal to send the terminal totals to the host processor during a close operation.

PROTOCOL REVERSALS ENABLED

Check this option to enable the terminal to send a
reversal to the host in the event the original request failed for a communication problem during sending/receiving the transaction message.

**ALLOW ANY BILL DENOMINATIONS**

Check the check box for international currency value support. It enables the terminal to accept non-U.S. standard note denomination values.

**BILL MIX METHOD:**

This option allows the user to select the pick method for dispensers that employ multiple cassettes with the same denomination.

- The Minimize method minimizes the number of bills dispensed, and depletes an entire cassette before using another when both cassettes have the same denomination. For example, a three-cassette dispenser with $10 bills in cassette A and $20 bills in cassettes B and C will fill a $150 transaction request with 1 bill from cassette A and 7 bills from cassette B. Cassette C will not dispense notes until cassette B is empty.

- The Minimize EW method means the terminal rotates cassettes filled with the same denomination after every customer transaction. For example, if cassettes A and B have the same denomination, the first transaction after a terminal restart will use cassette A. The next transaction will use cassette B. Each subsequent transaction will rotate between the cassettes.

**Note**

To use this functionality, the ATM software must support this functionality. RL2000/FT5000/RT2000/RL5000 ATM software version 2.4 introduces support for this functionality. If uncertain, please check with Triton Technical Support to verify if your ATM software version supports this functionality.

**VIEW OR CHANGE BILL MIX METHOD**

Follow the steps below to use this functionality. View or change the Bill Mix Method by clicking the drop down box and viewing the available options.

**DISPENSE OPPOSITE CASSETTE SIDE**

The READ-ONLY check box displays the current value set in the terminal’s Management Functions program. Check the box only if the terminal uses a rear dispensing model.

**SIZE (DIGITS) FOR TRANSACTION AMOUNTS.**

(NORMAL=8, EXTENDED=12, FULL EXTENDED=15)

The READ-ONLY text box displays the current value set in the terminal’s Management Functions program.

**CASSETTE (A-D) IS IN-SERVICE**

Use the check boxes in this section to control the service status of each note cassette installed in the terminal. Four check boxes support the maximum number of dispenser cassettes a terminal will use. Some dispensers have few than four cassettes. A check in the corresponding check box will place the cassette to an In Service status. Verify the check boxes before initiating the “Send Parameters” command.

**Note**

To use this functionality, the ATM software must support this functionality. RL2000/FT5000/RT2000/RL5000 ATM software version 2.4 introduces support for this functionality. If uncertain, please check with Triton Technical Support to verify if your ATM software version supports this functionality.

**Note**

To enable a cassette for In Service status, follow the proper loading procedure at the terminal.
If the terminal has fewer than four cassettes installed, the remaining options will have no effect on its operation; however, the state of these unused options change to match that of the active options. For example, uncheck both Cassette A and Cassette B on a two-cassette terminal will automatically uncheck the Cassette C and Cassette D options.

**Note**
The Advanced Setting tab will display the Cassette Service check boxes when the selected terminal has a multi-cassette dispenser.

E-Flags are Advanced features for future use. **DO NOT** make any adjustments to these settings!
The user can remotely change the terminal Master and Administrative passwords from this screen.

**CHANGING PASSWORDS**

**Note**

This function applies to Z-180 processor units (Models 8100/9100/9600/9700 etc.). To change passwords for X-Scale units (Models RL/FT/RT), use the “CONTROL” function, **Extended Parameters > Misc** option.

Clicking the Change Terminal Master Password button brings up the following.

Enter the current password in either case. If the program accepts the current password, it will allow the entry of a new password, which will take effect after the next scheduled parameter download to the terminal.
**SURCHARGE**

This screen is read only.

Perform the steps to configure the surcharge settings.

1. Click the down arrow in the Transaction Type list box and select a transaction. The Surcharge Settings will apply to transaction type: **Withdrawal**. See Step-10 for **Tiered**.
2. **Enable Surcharge**: Click the Enable Surcharge list box. A check in the box enables the surcharge function. Uncheck the box to disable the function.

3. **Amount**: If the transactions require a fixed surcharge amount, click inside the **Amount** textbox and enter the amount. The value may be from $0.00 to $999,999.99 inclusive.

4. **Credit Fee**: The Host will determine if this feature 

---

**ABOUT SURCHARGE CONFIGURATION**

Use the controls on this tab to enable or disable surcharging, enter a surcharge amount or percentage, and determine where to display the surcharge message during the transaction, either beginning or end of transaction.

The ATM’s processor or other appropriate regulatory agency will determine the specific surcharge requirements.

**SURCHARGE CONFIGURATION**

Click the **Modify Settings** button. This screen summarizes the surcharge settings and screen selected.
is required. If yes, the Host will determine the additional fee added to the Surcharge. If no, leave this value at $0.00 to disable the feature. No additional fee added to the surcharge if the surcharge amount equals zero.

**Note**
If the transactions require a fixed surcharge amount, and not use the surcharge percent, ensure the surcharge comparison option is set to GREATER and the surcharge percent is set to zero (0). This will ensure the customer will see only the fixed surcharge amount. Failure to do so can cause the terminal to report an incorrect surcharge value.

5. Set Will/May. This lets the customer know if a fee for processing a transaction “may” or “will” occur.
6. Set Percentage. If the transaction amount requires calculated percentage surcharge, click the Surcharge Percent list and select the required percentage (0 to 99 percent)

7. Set Display Surcharge Screen location. This option determines when the customer will see the surcharge message.
8. A check in the check box displays the surcharge message AFTER the customer has entered a custom withdrawal amount or a balance request. Remove the check to display the surcharge message BEFORE the customer enters a withdrawal amount (the message will appear as soon as the customer removes their card from the card reader).
9. Set the Lesser/Greater option. The surcharging systems calculates a surcharge based on a comparison between a fixed surcharge and a percentage-based surcharge.

**Note**
If the processor or other authority requires that the surcharge be the lesser of either the surcharge amount or surcharge percentage, select the GREATER option.

10. Select the surcharge Screen number the terminal will display. Click the Screen list box and select a screen. The message text for this screen will appear in the preview window.

**Note**
The Screen displays read-only text.

If the user right-clicks in the text box, a second screen pops up. This screen applies to the Z180 ATMs only.
11. Right-clicking in the grid area will present the choice to add a new entry or delete a current entry.
12. Use the backspace, numeric, and decimal buttons on the keyboard to modify a current entry.
13. Click the **OK** button once the desired changes have been made.

14. Click **Send Parameters** button to schedule the terminals call to update the values.
Use this screen to enable or disable Call Back and configure the parameters the terminal will use when placing calls to the Triton Connect host PC.

**Note**

With the Call Back disabled, the user must enter the EPROM access code in the terminal setup.

**TRITON CONNECT CALL BACK**

This function determines whether not the terminal will return a call after first receiving an initiating call from a Triton Connect host computer.

**TC MAX RETRIES**

The terminal creates call blocks to contact the Triton Connect host computer. Each block consists of multiple attempts to reach the host computer, using the Triton Connect primary and backup phone numbers.

During each block, the terminal will place a call to the primary number. If there is no answer in 60 seconds, the call will use the backup number, if one is available.

If there is no answer using the backup number within 60 seconds, or there is no backup number available, the terminal will repeat the cycle by returning to the primary number, then the backup.

If there is still no answer after two calls to the primary number and two calls to the backup number, the terminal will pause for the time established by the Triton Connect Redial Delay parameter, then will begin the communications attempt again with the next call block.

The cycle of call blocks repeats for the number of times established in the Triton Connect Max Retries setting before abandoning the attempt to reach the host computer.
**TC REDIAL DELAY**

Use this function to determine the waiting period, in seconds, he terminal will observe between attempts to call back to the Triton Connect host computer.

**TRITON CONNECT PHONE NUMBERS**

Enter the numbers the terminal will use when calling back the Triton Connect host computer. Enter a primary number, and if a secondary number is available, enter it in the Backup Phone Number entry box.

**ALARM MONITOR PHONE NUMBERS**

In some applications the terminal monitors for alarm conditions. In these cases, the user provides a separate set of primary and backup phone numbers, which the terminal will use when attempting to report errors or other alarm conditions to a Triton Connect host computer.

<table>
<thead>
<tr>
<th>Alarm Monitor Primary Phone Number</th>
<th>1-123-456-7890</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Monitor Backup Phone Number</td>
<td>1-123-456-7891</td>
</tr>
</tbody>
</table>

**Note**

When the user enables Triton Connect, enter a Primary number. The other phone numbers are optional.
CONTROL

This screen controls various parameters associated with close scheduling, alarm threshold conditions, journaling, terminal monitoring and status reporting.

The following sections provide descriptions of the various parameters.

EXTENDED PARAMETERS

This option appears for 32-bit terminals (RL/FT5000, RT2000, 98XX, ARGO and AGRO-FT) to configure specific parameters.

Click the Extended Parameters button to access a sub-system of dialogs to configure specific parameters.

- Service Provider (requires custom software)
- Gift Cards (requires custom software)
- Propane (requires custom software)
- Anti-Skim

**Note**

After completing the required parameter changes, click the Save Changes button to save the current settings and return to the Terminal Parameters main dialog.

Click the Send Parameters button and the terminal(s) will receive the new settings.
**ENABLE SCHEDULED CLOSE**

Click the *Enable scheduled close* check box and the terminal(s) will perform the *Day Close* function.

**CLOSE REPORT TIME**

After enabling the schedule close, the terminal will automatically generate a Day Close. Specify the time of day when the close will take place. Use the arrow controls to select an hour, minute and AM or PM value.

**DAY CLOSE REPORT**

The Day Close report shows the cumulative value of all transactions (withdrawals, transfers, balance inquiries) performed by the ATM since the previous Day Close. The report also shows the corresponding Host totals, to compare the ATM totals against the Host processor records.

Perform a Day Close once each business day. Because the Host Processor also performs a business Day Close for the ATM, perform the close at the same time each day at the time specified by your Host Processor. This will help ensure the Day Close reports reflects the Host’s current business day totals for your ATM.

**ENABLE SCHEDULED JOURNAL CALLS**

Check this option to direct the terminal to automatically send the unaudited electronic journal records to the Triton Connect host computer at a specified time.

**SET JOURNAL CALL TIME**

Enter the time hours in 24-hour format at which the terminal will automatically send the contents of its electronic journal to the Triton Connect host computer.

**RANDOM CALLING WINDOW**

The terminal will initiate the call at some random time that is within one hour of the specified time. The purpose of this behavior is to avoid a situation in which multiple terminals attempt to call the Triton Connect Host Computer at the same time.
ENABLE CALL AT NUMBER OF JOURNAL RECORDS THRESHOLD

Check this option to direct the terminal to place a call to the Triton Connect host computer whenever the number of records in the terminal's electronic journal reaches a specified value.

SET # RECORDS THRESHOLD

Enter the number of journal records that will establish an activating threshold for the Journal Records function. If this function has been enabled (see previous paragraph), when the number of journal records equals the value entered here, the terminal will automatically call and transfer the journal to the Triton Connect host computer.

ENABLE CALL AT LOW CASH THRESHOLD

Check this option to direct the terminal to place a call to the Triton Connect host computer whenever the level of cash in the terminal’s cash cassette reaches a specified value.

SET LOW CASH THRESHOLD

Enter a quantity of cash in the cassette to establish a threshold for the Cash Threshold function. With this function enabled (see previous paragraph), when the number of notes in the cassette drops to the value entered, the terminal will automatically send an alarm notification call to the Triton Connect host computer.

OUT OF SERVICE SETTINGS

Clicking this button provides access to enable the terminal to go “Out of Service” for a Printer error.

STAY IN SERVICE WHEN RECEIPT PAPER IS LOW

Check this option to force the terminal to remain in operation despite a low receipt paper condition.
**ALLOW HEARTBEAT TO BE ENABLED**

Click the *Allow Heartbeat to be enabled* check box which allows the terminal to display the Heartbeat option the operator.

The Heartbeat option will appear in the applicable Management Functions menu area of the terminal.

**ENABLE HEARTBEAT/DELAY PERIOD**

Click the *Enable Heartbeat by delay period* check box and enter a value in the *Delay Period* text box to set the number of minutes the terminal will wait before sending the Heartbeat message to the host processor.

**ENABLE HEARTBEAT AT SPECIFIC TIME**

Click the *Enable Heartbeat at Specific Time* check box and enter a specific time when a heartbeat message will be sent to the host processor.

**HEARTBEAT MESSAGE**

The single most important feature of an ATM is the communications between itself and the host processor. When communications break down neither the host processor or the ATM will know of the failure.

In real-time, the host has no way of determining if communications failure has occurred as a result of equipment failure or the absent of transactions due to a slow period. The ATM’s *Heartbeat* feature provides a means of reporting communication’s system status to the host processor via dial-up or TCP/IP.

With the Heartbeat feature enabled, the terminal will call the host after a period of inactivity. During this call, the terminal will request a COMMS KEY DOWNLOAD, the normal configuration download request, and will report the status to the STATUS MONITORING function. The host determines the terminal’s communication status without the terminal performing any transactions at the time.

An internal timer will initialize to the number of minutes set in the DELAY PERIOD parameter at system power-up and after a reset. This timer restarts each time the terminal makes a call to the host. A call includes any transaction, financial balancing, or configuration that communicates with the host. This includes up to the point that the host recognizes the Terminal ID.

A customer declined transaction will reset the timer, while a failed call because of a busy host phone number will not.
The **Extended Parameters - Misc** tab allows the user to perform the following configuration actions.

1. Change Default Language.
2. Change Default Transaction.
5. Change Message Type.
7. Schedule Reboot.
8. Delete users and/or modify user name (32-bit terminals only)

## Change Default Language

Use the **Default Language** to display and print customer and management reports, and receipts.

The default language sets the language initially displayed on customer transaction screens. In most cases, the terminal’s location and customer language considerations will determine the default language. Usually, the default language will suffice for most of the intended customers.

In other cases, give customers the option of selecting a different language via the language selection screen. The ATM will use this language in all transaction screens for the current session only, afterwards the ATM will return the language to the default language.

Follow the steps below to change the **Default Language**.

1. Click the down arrow in the **Default Language** list box to view the available languages.
2. **Available languages include:** English, Spanish, French, and German. The terminal’s software determines the availability of other languages.
3. Click a language for default.

## Change Default Transaction

The **Default Transaction** enables the ATM to present a default transaction to the customer: Withdrawal, Transfer, or Balance. In most cases, the ATM presents some or all three of these options to the customer. In some instances, the ATM has additional transaction options disabled and not displayed to the customer.

If no other transaction options are available or enabled, the ATM displays the default transaction type (such as withdrawals) to the customer.

Follow the steps below to change the **Default Transaction**.

1. Click the down arrow in the **Default Transaction** list box to view the available transactions.
2. Available transactions include: Withdrawal, Balance, Transfer, Purchase, and Other depending upon the terminal's software version.
3. Click the transaction type for default.

**CHANGE DEFAULT ACCOUNT**

The Default Account enables the ATM to present a default account for customer transactions: CHECKING, SAVINGS, CREDIT CARD, or OTHER. In most cases, the ATM presents some or all account options to the customer. In some instances, the ATM has additional account options disabled and not displayed to the customer.

If no other account options are available or enabled, the ATM displays the default account type (such as checking) to the customer.

Follow the steps below to change the Default Account.

1. Click the down arrow in the Default Account list box to view the available account types.
2. Typical account types include: Checking, Savings and Credit.
3. Click the account type for default.

**CHANGE PROTOCOL TYPE**

The communications protocol setting depends on the type of communications environment the terminal operates and the host processor's requirements. The Triton Standard communications protocol, for example, suffices for many locations in the continental United States. International markets may require different protocol, such as Datapak, Radiopad, or other specialized protocols.

Follow the steps below to change the Protocol Type.

1. Click the down arrow in the Protocol Type list box to view the available protocols.

**CHANGE MESSAGE TYPE**

The communications message setting specifies the content and structure of messages pass between the terminal and the processor during transactions and status updates. The Triton Standard communications message specification suffices for many locations in the continental United States. International markets may require a different message specification.

The communications message setting will depend on the processor's communications requirements.

Follow the steps below to change the Message Type.

1. Click the down arrow in the Message Type list box to view the available message formats.

2. Click the protocol type desired.

2. Click the message type desired.
Triton recommends a periodic scheduled reboot of
PC-based units at least once a week. Use these fields to
Enable the Scheduled reboot and set the time for the
reboot of the terminal.

**VIEW USER LIST**

Passwords restrict management functions access to
designated personnel. Each authorized user has an
assigned password, 2-digit ID code, and a username.
Enter the ID code and password to access the terminal
management functions. The username can consist up
to 40-characters and refers to the currently logged user.

The User List shows the ID code and corresponding
username for each user on the terminal.

**DELETE / MODIFY USER (NEW)**

This option available with the X3/32-bit terminals only.

To Delete a User, not the Master, highlight a User, then
click on the **Delete User** button. The ATM deletes the
user’s name.

To Modify a User’s name or change a User’s password
highlight a User and click the **Modify User** button. The
following screen will appear.

Change the User’s name and/or password and click the
**Apply** button. The ATM updates the user’s name and/
or password.

**Note**

The terminal must run software version 1.8.2 or newer
to modify the Master and User passwords.

**Import ATM Passwords from File**

Triton Connect adds the ability to import user pass-
words to the ATM. The file reduces typographical
errors or re-typing the passwords if they will be sent
to several ATMs or groups of ATMs at different times.
The format of the file is one user’s data per line con-
taining the User ID, Username, and the password, each
separated by a comma. NotePad or a any standard text
editor can create the file.

To use this feature, perform the following steps.

1. Open the Triton Connect Terminal Manager
2. Click the Terminal Data menu and select Set Ter-
   riminal parameters.
3. Select the desired ATM and click View Parameters.
4. Navigate to the Control tab.
5. Click the **Extended Parameters** button.
6. Navigate to the Misc tab.
7. Click Import From File in the User List area.
8. Browse for the file, select it, and click Open.
9. Click Save Changes.
10. Click Send Parameters to schedule the call to the
    ATM.
ABOUT AD DATA

This tab enables the user to perform the following ad configuration actions.

1. Add and Remove Ads.
2. Configure Ad Display Times, Duration and Location.
3. Configure Ad Sequence.
4. Select a Screen File.

ADD AND REMOVE ADS

Follow the steps below to add an Ad file to the Active Ads list.

**Note**

Triton Connect 6.2 SP1: Adds PNG to the graphics limited to (BMP, Gif, JPEG, PNG) files.

1. Check the Terminal Data Directory list. Locate and highlight an Ad file in the list. Click the Activate Ad button to transfer the file to the Active Ads list.

2. To highlight a group of ads, click once on the first ad, then hold down the SHIFT key while clicking on the last ad in the group. This will highlight the first ad, the last ad and any ads in between.

3. To highlight multiple ads that do not fall neatly into a group, hold down the CTRL key while clicking on any ad anywhere in the list.

4. If the list does not contain the desired Ad file, click the Add Ad button to bring up a browse dialog.

5. Browse to the Ad file's location and click the filename. Click the Open button and return to the Ad Data window. The Terminal Data Directory and the Active Ads list will display the new Ad file.
6. When the Active Ads list receives a new Ad file, the scheduling, duration, and ad location controls opens. Configure the ad display times, duration and location. See the next section Configure Ad Display Times, Duration and Location for instructions.

<table>
<thead>
<tr>
<th>Active Ads</th>
<th>38105340: autumn-pics</th>
<th>38185437: beautiful-sce</th>
<th>358687514: america-imag</th>
</tr>
</thead>
<tbody>
<tr>
<td>11:00am</td>
<td>6:00am</td>
<td>12:00pm</td>
<td>6:00am</td>
</tr>
<tr>
<td>1:00am</td>
<td>7:00am</td>
<td>1:00pm</td>
<td>7:00pm</td>
</tr>
<tr>
<td>2:00am</td>
<td>8:00am</td>
<td>2:00pm</td>
<td>8:00pm</td>
</tr>
<tr>
<td>3:00am</td>
<td>9:00am</td>
<td>3:00pm</td>
<td>9:00pm</td>
</tr>
<tr>
<td>4:00am</td>
<td>10:00am</td>
<td>4:00pm</td>
<td>10:00pm</td>
</tr>
<tr>
<td>5:00am</td>
<td>11:00am</td>
<td>5:00pm</td>
<td>11:00pm</td>
</tr>
</tbody>
</table>

Follow the steps below to remove an Ad file from the Active Ads list.

1. Locate the Ad file for removal from the Active Ads list and click on the entry to highlight it.
2. Click the Remove Ad button to remove the ad file.

**CONFIGURE AD SEQUENCE**

The arrangement of the Ad files in the Active Ads list determines the order in which the terminal’s display presents the multiple ads to the customer. The user controls this order by moving ads up and down in the list.

Click on the Ad file in the Active Ads list to highlight it. Click the Move Up button to move the Ad file up or click the Move Down button to move the Ad file down. Each click of the button moves the file one position up or down.

**CONFIGURE AD DISPLAY TIMES, DURATION, AND LOCATION**

Performing either of the following actions will show the ad display times, duration and location controls.

- Add an Ad file to the Active Ads list.
- Highlight an entry in the Active Ads list and click the View Schedule/Field button.

Follow the steps below to configure ad display times, duration, and location for the selected Ad file in the Active Ads list.

1. The Active Hours schedule shows a check box for each hour of the day. New ads receive the default setup with all boxes checked for a 24-hour display.

Remove the check marks for those hours, in which, the terminal will not display the ad. Click the Apply button to accept the changes.

2. The Duration sets the length of time (in seconds) the terminal displays the ad. By default, the text box contains a value of zero (0) and the terminal will not display the ad.

To set the time, click inside the Duration text box and enter a duration in seconds, between 0 and
120. If the ad is a video with a zero (0) Duration, the terminal will display the ad for the entire playing time of the video. Click the Apply button to accept the changes.

3. The Active Field specifies where the terminal displays and/or prints the ad graphics. To configure the location for the current ad, click inside the Active Field to view the location options.

![Active Field Image]

Click the required option, then click the Apply button to accept the choice.

4. When clicked, the Apply button becomes the Done button. Click the Done button to return to the main Ad Data window.

**SELECT A SCREEN FILE**

The Screen File specifies the appearance and functionality of the screens the terminal displays to the customer.

**Note**
Screen files must be in the *.tsm file format.

Follow the steps below to select a Screen File.

1. Locate and click the screen file in the Terminal Data Directory list to highlight it. Click the Activate Screen File button. The selected Screen File name is shown next to the button.

![Terminal Data Directory Image]

2. If the list does not show the desired Screen File, the user must add the Screen File via a software update procedure.

**RAM MEMORY-DISK/FLASH SPACE**

Disk/Flash memory stores the Graphic files. RAM memory temporarily holds the files while in use by the terminal's display.

**GRAPHIC SIZES**

The terminal reveals graphics in designated fields on the display. Optimize graphics by creating them in sizes that fit their intended use. Graphic dimensions are in pixels.

**GRAPHIC EXAMPLES**

![Graphic Examples Image]
<table>
<thead>
<tr>
<th>MODEL SIZE</th>
<th>DISPLAY SIZE</th>
<th>SCREENS</th>
<th>PIXEL SIZE</th>
<th>FORMAT COLOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARGO 15 &amp; FT</td>
<td>15”</td>
<td>Full Screen</td>
<td>1020 x 764</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Welcome Ad</td>
<td>500 x 500</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Header</td>
<td>1020 x 120</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transaction Ad</td>
<td>1020 x 485</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receipt Graphic</td>
<td>480 x 120</td>
<td>bmp / Black Only</td>
</tr>
<tr>
<td>ARGO 12.0</td>
<td>12.0”</td>
<td>Full Screen</td>
<td>796 x 596</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Welcome Ad</td>
<td>408 x 329</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Header</td>
<td>796 x 90</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transaction Ad</td>
<td>796 x 341</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receipt Graphic</td>
<td>480 x 120</td>
<td>bmp / Black Only</td>
</tr>
<tr>
<td>ARGO 7.0</td>
<td>7”</td>
<td>Full Screen</td>
<td>796 x 476</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Welcome Ad</td>
<td>446 x 294</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transaction Ad</td>
<td>796 x 300</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receipt Graphic</td>
<td>480 x 120</td>
<td>bmp / Black Only</td>
</tr>
<tr>
<td><strong>X2-MIGRATED</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RL/FT5000/RT2000</td>
<td>10.4”</td>
<td>Header</td>
<td>636 x 90</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Welcome Ad</td>
<td>310 x 385</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Full Screen</td>
<td>636 x 476</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transaction Ad</td>
<td>636 x 260</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receipt Graphic</td>
<td>480 x 120</td>
<td>bmp / Black Only</td>
</tr>
<tr>
<td>RL2000</td>
<td>8.0”</td>
<td>Header</td>
<td>636 x 90</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Welcome Ad</td>
<td>310 x 385</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Full Screen</td>
<td>636 x 476</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transaction Ad</td>
<td>636 x 260</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receipt Graphic</td>
<td>480 x 120</td>
<td>bmp / Black Only</td>
</tr>
<tr>
<td><strong>X2 UNITS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RL2000</td>
<td>5.7”</td>
<td>Full Screen</td>
<td>636 x 476</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transaction Ad</td>
<td>636 x 260</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transaction Ad</td>
<td>636 x 475</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receipt Graphic</td>
<td>480 x 120</td>
<td>bmp / Black Only</td>
</tr>
<tr>
<td><strong>X-SCALE UNITS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RL/FT5000/RT2000</td>
<td></td>
<td>Full Screen</td>
<td>636 x 476</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LOGO</td>
<td>310 x 85</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transactions Ad</td>
<td>636 x 260</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Banner</td>
<td>205 x 56</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Header</td>
<td>636 x 90</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Welcome Ad</td>
<td>310 x 385</td>
<td>jpg, gif, bmp, png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receipt Graphic</td>
<td>480 x 120</td>
<td>bmp / Black Only</td>
</tr>
<tr>
<td>Coupon Graphic (Top or Bottom - Only)</td>
<td></td>
<td></td>
<td>450 x 225</td>
<td>bmp only</td>
</tr>
<tr>
<td>Coupon Graphic (Top and Bottom - Only) Applies any X2 Display</td>
<td></td>
<td></td>
<td>320 x 160</td>
<td>bmp only</td>
</tr>
</tbody>
</table>
**Note**

This feature is part of a custom software. Contact the ATMs host processor to determine if the custom software is required for this ATM.

---

### EXTENDED PARAMETERS - OPTIONAL SCREENS

<table>
<thead>
<tr>
<th>Misc</th>
<th>Ad Data</th>
<th>News Ticker</th>
<th>Optional Screens</th>
<th>Couponing</th>
<th>Service Providers</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Optional Screens</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Screen Enabled**
- **Select ATM Transaction Type:**
  - PIN Change
  - Mini Statement
  - Purchase
  - Withdrawal
  - Transfer of Funds

---

### ABOUT OPTIONAL SCREENS

Use this function to enable/disable optional screens and screen buttons at the terminal.

Follow the steps below to configure Optional Screens and Screen Buttons.
1. Click the down arrow in the screens list box. Select a screen type.
2. Click the Screen Enabled check box to enable (check) or disable (uncheck) the currently selected screen.

3. The Optional Buttons choice applicable to the selected screen will appear. Click the check boxes to enable (check) or disable (uncheck) the buttons, as applicable.

4. After completing any required parameter changes, click the Save Changes button at the top of the screen to return to the Terminal Parameters main dialog.

The types of screens and screen button choices can vary depending upon the Screen File that is currently in use. The available screen options will generally fall into the following categories.

**ACCOUNT/TRANSACTION**

These screens offer additional keypad-based and audio-transaction based account and transaction-type selections to the customer, such as for balance inquiries, transfers and cash withdrawals.

**LANGUAGE SELECTION**

This screen offers the customer the opportunity to select a favored language in which to perform the transaction, such as Spanish or French. The terminal supports both displayed and audio-based language selections. After the completion of the transaction, the ATM returns the screens to the default language.

**SURCHARGE MESSAGE**

The host processor may require specific wording in the surcharge notification message presented to customers. These screens offer a choice of surcharge message types. The location of the surcharge message in the transaction flow (Beginning or Ending) is also selectable.

**FAST CASH AMOUNTS**

These screen buttons offer the customer the convenience of choosing from several predefined withdrawal amounts, rather than having to enter a value.

**CHARITY SELECTIONS**

This selection of buttons is currently not available.

**Note**

Main transaction/account selections may necessitate the configuration of other options. See the terminals Operation/Configuration manual for more details.
EXTENDED PARAMETERS - COUPONING

Coupons notify customers of awards, prizes, sales, or other promotional opportunities. From the Extended Parameters - Coupon tab the user performs the following coupon configuration actions.

1. Select Coupon Type.
2. Set Minimum and Maximum Levels.
3. Enter a Random Percentage.
4. Enter a Coupon Prompt.
5. Enable Award Based on ISO Properties.
7. Configure Dispensed Coupon Cassette and Number of Dispenses.

ABOUT COUPONING

Customers may receive one of two types of coupons: Printed or Dispensed. The user must select the coupon type, before configuring the coupon's settings. The user may set up as many as four Printed and two Dispensed coupons.

SELECT COUPON TYPE

Customers may receive one of two types of coupons: Printed or Dispensed. The user must select the coupon type, before configuring the coupon's settings. The user may set up as many as four Printed and two Dispensed coupons.

1. Click the coupon types drop-down list.

   - **Printed0.** This is the first of four available printed coupon types. The receipt printer prints coupons to the customer.
   - **Printed(1-3).** Additional printed coupon selections.
   - **Dispensed0.** This is the first of two available dispensed coupon types. A designate dispenser cassette(s) dispenses coupons to the customer.
   - **Dispensed1.** Additional dispensed coupon.

2. Select a coupon type. Set the coupon parameters as required.

SET MINIMUM AND MAXIMUM LEVELS

The Minimum Level parameter represents the minimum withdrawal amount that will trigger the printing or dispensing of a coupon. The Maximum Level parameter represents the maximum amount that will trigger the printing or dispensing of a coupon.

Follow the steps below to set the minimum withdrawal amount for the currently selected coupon type.
1. Click inside the Minimum Level text box.
2. Enter a value. The value must be at least as large as the Multiple Amount parameter, and no greater than the Maximum Cash parameter.

![Minimum Level and Maximum Level](image)

3. Click inside the Maximum Level text box.
4. Enter a value. The value must be at least as large as the Multiple Amount parameter, and no greater than the Maximum Cash parameter.

If the customer performs a successful withdrawal transaction for an amount equal to or greater than the Minimum Amount parameter and less than or equal to the Maximum Withdrawal Amount parameter, the Coupon Type selected will determine whether to print or dispense a coupon.

**ENTER A RANDOM PERCENTAGE**

This function sets the frequency when to print or dispense awards coupon. The random percentage can be set from 0 to 100%. For example, a random percentage of 10% will print or dispense one prize coupon out of every ten successful transactions.

Follow the steps below to enter a random percentage value.

1. Click inside the Random Percentage textbox.
2. Enter the random percentage, from 0 to 100.

![Random Percentage](image)

**ENABLE AWARD BASED ON ISO PROPERTIES**

This function allows customers to receive coupons based on the detection of a ISO Number, when the terminal scans the customer’s ATM card.

**Note**

The ISO Number must have the Award Coupon action selected.

Click the Award Based on ISO Properties check box. A check mark in the box enables the function.

1. Click inside the Prompt text box.
2. Enter a brief message to prompt the customer to retrieve the coupon.

![Prompt](image)

**CONFIGURE PRINTED COUPON MESSAGE, GRAPHIC AND LAYOUT**

The settings in the Printed Coupon area applies to printed coupons only. The Printed Message text box allows the user to type a descriptive statement that will appear on printed coupons. The message should describe the purpose of the coupon, such as a discount coupon, prize claim slip, or other statement. The Graphic File Name adds an image to the printed coupons. The Layout parameter establishes the orientation of text and graphics on printed coupons.

Follow the steps below to configure the coupon message, graphic, and layout for printed coupons.

1. Click inside the Printed Message text box. Enter a brief coupon message.

![Printed Message](image)
2. Click the down arrow in the Graphic FileName list box to view the available graphics and select the desired graphic.

3. If the list does not contain the desired graphic file, click the Send Coupon button to bring up a browse dialog.

4. Browse to the location of the graphic files and click to highlight the filename. Click the Open button to accept the selection and return to the Coupon window.

5. Click the Layout list box to view the available alignment types.

The alignment can be set to one of three types.

- Top & Bottom Graphics orientate along the top and bottom of the receipt paper.
- Top Graphic orientates along the top of the receipt paper.
- Bottom Graphic orientates along the bottom of the receipt paper.

6. Click the layout type needed.

**Configure Dispensed Coupon Cassette and Number of Dispenses**

*Note*
This feature is available only for NMD dispensers that have two or more cassettes.

The settings in the Dispense Coupons area apply to dispensed coupons only. The Cassette selection determines the cassette that will dispense the coupons. The Count parameter determines the number of coupons dispensed for each qualifying transaction.

Follow the steps below to configure the coupon cassette selection and number of dispenses.

1. Click the Cassette list box to view the available cassettes. Select the cassette that will dispense coupons.
2. Click inside the Number to dispense text box. Enter the number of coupons to dispense for the selected cassette.
**Note**

This feature is part of a custom software. Contact the ATMs host processor to determine if the custom software is required for this ATM.

**EXTENDED PARAMETERS - SERVICE PROVIDERS**

Select Provider: 

Provider Name: 

ID: 

Surcharge: 

Fast Cash Amounts:

**EXTENDED PARAMETERS - GIFT CARDS**

Discount: 

Minimum Value Per Card: 

Maximum Value Per Card: 

Card amount less than or equal to: 

Surcharge Amount: 

Maximum Amount: 

**Note**

This feature is part of a custom software. Contact the ATMs host processor to determine if the custom software is required for this ATM.
**Note**
Consult the Propane Pump Payment Module (PPPM) Users Manual for information on these settings.
**EXTENDED PARAMETERS - ANTI-SKIM**

This feature adds the ability to view and change values specific to the anti-skim card reader. This feature only applies to ATMs with an anti-skim card reader. Those readers with an internal anti-skim sensor board will display the Internal Sensor block.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Temperature Corrected</th>
<th>Differential Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metal Preset Time (sec)</td>
<td>[180]</td>
<td>[180]</td>
</tr>
<tr>
<td>Metal Absent Time (sec)</td>
<td>[10]</td>
<td>[10]</td>
</tr>
<tr>
<td>Detection Voltage (mV)</td>
<td>[150]</td>
<td>[50]</td>
</tr>
<tr>
<td>Warning Voltage (mV)</td>
<td>[110]</td>
<td>[20]</td>
</tr>
<tr>
<td>Internal Sensor</td>
<td>[Enabled]</td>
<td></td>
</tr>
<tr>
<td>Delta Card Insertion</td>
<td>[17]</td>
<td></td>
</tr>
<tr>
<td>Delta Periodic Polls</td>
<td>[17]</td>
<td></td>
</tr>
<tr>
<td>Delta Power Cycle, Low Temp</td>
<td>[17]</td>
<td></td>
</tr>
</tbody>
</table>

**TEMPERATURE CORRECTED**
- Metal Present Time (sec) for temperature corrected is the time for which metal must be continuously detected to be considered a skimmer. Set to 0 seconds to disable.
- Metal Absent Time (sec) for temperature corrected is the time for which metal must be continuously removed before terminal recognizes skimmer removed.
- Detection Voltage (mV) for temperature corrected is the voltage sensed by the metal detector by which any higher voltage is considered a skimmer.
- Warning Voltage (mV) for temperature corrected option currently unavailable.

**DIFFERENTIAL VOLTAGE**
- Metal Present Time (sec) for differential voltage is the time for which metal must be continuously detected to be considered a skimmer. Set to 0 seconds to disable.
- Metal Absent Time (sec) for differential voltage is the time for which metal must be continuously removed before terminal recognizes skimmer removed.
- Detection Voltage (mV) for differential voltage is the voltage sensed by the metal detector by which any higher voltage is considered a skimmer.
- Warning Voltage (mV) for differential voltage option currently unavailable.

**INTERNAL SENSOR**
*Triton Connect 6.2 SP1,* Click the check box to enable the Internal Sensor. Default values shown.
EXTENDED PARAMETERS - CONTACTLESS

Triton Connect 6.2 SP1: This feature adds support for a contactless reader. Check the boxes that apply to your ATM.
**FORMAT**

This screen enables the user to configure miscellaneous formatting options if software supports these features permits.

<table>
<thead>
<tr>
<th>Advanced Settings</th>
<th>Passwords</th>
<th>Surcharge</th>
<th>Triton Connect Settings</th>
<th>Control</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Currency Symbol**
  - This function enables the user to select the symbol that is appropriate for the currency type being used in the terminal.

- **Transaction Receipt Format**
  - Check this option will alter the format of the customer transaction receipt to fit the requirements of the Latin American marketplace.

- **Date Format**
  - Use this option to select the date format that is most appropriate for the terminals’ location.

- **End of Terminal Parameters**

**“Chequing” vs. “Checking”**

Terminals installed in certain international locales may require the variant of the word “checking.”
CHAPTER 9 JOURNAL DATA

INTRODUCTION

In Chapter 5, Getting Terminal Parameters, the user learned how to retrieve terminal data, consisting primarily of terminal parameter data and journal data. Once Triton Connect receives and stores the data in the database, the user can access and view the data. In this chapter the user will learn how to view the stored journal data, how to extract, and to archive selected journal information from the journal database.

ACCESS THE JOURNAL DATA FUNCTION

Follow these steps to access the View Journal Data function.

1. Navigate to the Terminal Manager > Terminal Data > View Journal Data option.
2. The View Journal Data screen opens.
3. By default, the screen displays the first journal data record. Click the Next button to see the next journal entry.

VIEW JOURNAL DATA

Follow these steps to view journal data for the selected terminal.

1. Select a terminal ID using the Terminal ID dropdown list.
2. Click the View button. The Journal Data screen opens, as shown here.
3. Triton Connect 6.2 SP1: Adds the ability to skip to a particular journal record when viewing journals for a terminal. Click in the Record ID text box and enter the desired value.
5. **Triton Connect 6.2 SP1**: Adds the EMV details with values for EMV reader, EMV chip, and EMV fallback.

**Navigate through the journal data for the selected terminal by using the navigation buttons.**

![Navigate through the journal data](image)

**Note**

Use ALT (key) combinations to quickly scroll through the journal entries. To do so, hold down the ALT key on the keyboard then press one of the following keys:

- **F** - Moves to the First record.
- **P** - Moves to the Previous record.
- **N** - Moves to the Next record.
- **L** - Moves to the Last record.

**First**: Click the **First** command button to move to the first journal data record in the database for the selected terminal and displays the data.

**Previous**: Click the **Previous** command button to move to the previous journal data record in the database for the selected terminal and displays the data.

**Next**: Click the **Next** command button to move to the next journal data record in the database for the selected terminal and displays the data.

**Last**: Click the **Last** command button to move to the last journal data record in the database for the selected terminal and displays the data.

**SEARCH JOURNAL DATA**

Search the journal record using defined criteria with the help of the search definition function. To activate it, click the **Search** button.

![Search journal data](image)

The search definition window opens.

Choose the criteria from the drop-down list to define a search.

![Search criteria](image)

Scroll through the list for more options. For each option the search window will automatically provide additional controls to help refine the criteria selected.

With the search criteria selected, click the **Apply** button to conduct the search. A separate window displays the first record that matches the search criteria.

**PRINT JOURNAL DATA**

Click the **Print** button to print the entire journal, or selected portions of the journal.
The Print window opens.

Use the **Entry Range** options to choose the number of journal entries you want to print.

The **Current Journal Entry** option will print the information for the entry currently displayed in the View Journal main window.

The **All Journal Entries** option will print the information for ALL database journal entries. The option label lists the number of entries stored in the database, (8 entries in this example), so exercise caution when choosing this option.

**ENTRY RANGE**

Use the **Entry Range** options to choose the number of journal entries you want to print.

**ABOUT THE PRINT RANGE**

The print function default has a check mark in the **Print All Entries** option box. This feature selects all journal entries in the specified range for printing, including previously printed entries.

If the user wishes to print only those entries in the print range excluding the previously printed entries, uncheck the **Print All Entries** check box.

**REPORT FORMAT**

Use the options in the **Report Format** area to control the format of the journal printout.

The **Expanded** option will print all information associated with each journal in an extended format that is more “user friendly” than the abbreviated Comma Delimited and Journal Tape options.

Select the **Print to File** option to activate the Comma Delimited report format. The print function will send the report output to a specified file instead of to the printer.

**COMMA DELIMITED REPORTS**

Triton recommends using the Comma Delimited option with compatible external applications such as a spreadsheet and database programs.

Quotes and commas, enclose data associated with each entry shown in this example.
This type of output allows spreadsheet, database, or word processor programs to easily store journal data in a structured way for retrieval and formatting.

The Journal Tape option produces a report formatted in an appearance like the terminal’s receipt paper output, as in this example.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Description</th>
<th>Amount</th>
<th>Code</th>
<th>D</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/14/58</td>
<td>10:21</td>
<td>OK 6</td>
<td>$40.00</td>
<td></td>
<td>4</td>
<td>0</td>
</tr>
</tbody>
</table>

**OTHER PRINT OPTIONS**

- Print to File, Not Printer
- Print Transactions Only
- Mark Entries as Printed
- Print All Entries (Including those Previously Printed)

Select the Print to File option to print Expanded, Comma Delimited and Journal Tape reports to a file instead of to the printer.

Select the Print Transactions Only option to exclude non-transaction specific entries from a report. This option becomes active with both the Print to File and Comma Delimited options checked.

With a check in the Mark Entries as Printed box, the database will mark any journal entries printed as “Previously Printed”.

Select the Print All Entries option to include all entries in the specified range in the printout. To exclude entries marked as “Previously Printed,” do not select this option.

Triton Connect 6.2 SP1: adds an optional Header when printing journal records to file. To use the header, click the Include Header check box. Check or verify the check-status of header components: Location, Address, Notes. The Modify Terminal screen provides the source for the Header values. The checked values will display on the top of the file.

**Note**

ATM software version 4.2.2 and later requires, SP1 to reflect correct values in a cassette close journal record.

After choosing the print options, click the OK button to print the selected journal data to your default printer or file.

**TRANSACTION RESPONSE CODES**

The transaction-processing organization passes these codes to the terminal and stores them in the journal records. Triton Connect downloads these codes upon command. The Journal Text Entry field shows the codes in the View Journal window, as shown in this example.

The example shows the host processor declined the transaction because of an INVALID PIN (Response Code 0050).

**Note**

Response Code Table on next page.
Follow these steps to access the View Archived Journal Data option.

1. Navigate to Terminal Manager > Terminal Data > View Archived Journal Data option.

2. A file search dialog box opens. Use the dialog box to locate and select the archive file with the .ach (archive) extension.

3. Click the Open button to open the archive file. The View Archived Journal Data screen opens. Because this screen has the identical form layout as the View Journal Data screen, refer to the beginning of this chapter for additional information on selecting, viewing and printing the archived journal entries.

4. Select the ID of the terminal using the Terminal ID drop-down list.

5. Click the View button. The journal data window opens.

6. By default, the screen displays the first journal data record. To see the next journal entry, click the Next button.

The View Archived Journal Data screen controls are identical to those in the View Journal Data window. Refer to the coverage of that function earlier in this chapter for details on navigating the associated screens and viewing the journal data.
This application only used for older TC Databases that might gave unmasked data in an Access Database.
This utility will mask Personal Account Numbers (PAN) data in journal records for Triton Connect databases and journal archived files. These records show the first six (6) digits and the last four (4) digits of the account numbers. The equal (=) sign representing the masking character replaces the middle digits. An example of PAN data: 123456======7890.

Follow these steps to access the Mask Journal Data (PAN data) function.
Navigate to the Terminal Manager > File > Mask Journal Data option. The following screen opens.
USE JOURNAL ARCHIVE FILE FOR JOURNAL DATA REPORT

Triton Connect allows a Journal Archive file (.ach) as the data source to generate a Journal Data Report. Follow these steps.

1. Navigate to the Terminal Manager > Utilities > Reports Manager option.
2. Select Journal Data in Available Reports scroll box.
3. Click the check box to enable Select Archive File. A Browse button appears.

Click the Select All button to select all entries or click the Start Date or End Date calendar to set the date range.

4. Click the Browse button. A dialog screen will open.

5. Click the Open button on the browse dialog to load the file and return to the main dialog window. An entry for the selected journal file will appear in the main window.

6. Select the Disable Error Messages to suppress any unexpected or corrupted data messages. Normally not selected.
7. Configure the dialog controls as needed and click the View button to generate the report.

DATA MANAGER WILL RESPECT DATABASE SIZE LIMIT

The Triton Connect databases use the Microsoft Access database management system and thus have a 1 gigabyte limit. The Data Manager in the Triton Connect 4.4 and above will not add any more data if the database is close to the 1 gigabyte limit.

END OF JOURNAL DATA
CHAPTER 10

**Note**
This feature requires custom software for a specific customer. If you believe you are that specific customer, contact the ATM’s Host Processor to verify this ATM needs the custom software.

Refer to Triton Connect Revision 6.0 for detailed information about the LED Sign Messages feature.

END OF CHAPTER
CHAPTER 11 - REPORT MANAGER

INTRODUCTION

Triton Connect enables the user to produce detailed reports based on the parameter, journal, and close data obtained from your terminals. In this chapter, we’ll show how to access and view reports.

ACCESSING THE REPORTS MANAGER

Navigate to the Terminal Manager > Utilities > Reports Manager option and the following screen opens.

VIEWING REPORTS

The Available Reports offers a list of report types. Follow these steps to view a report.

1. Select the type of report from the Available Reports list provided below.

<table>
<thead>
<tr>
<th>Call Failures</th>
<th>Journals Downloaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call List Report</td>
<td>Journals Not Downloaded</td>
</tr>
<tr>
<td>Cassette Close</td>
<td>Most Common Status Messages</td>
</tr>
<tr>
<td>Cassette Status</td>
<td>Scheduled Close Status</td>
</tr>
<tr>
<td>Check Digits</td>
<td>Terminal Configuration</td>
</tr>
<tr>
<td>Check Digits 3Des</td>
<td>Terminal Down Time</td>
</tr>
<tr>
<td>Coupon Report</td>
<td>Terminal Files</td>
</tr>
<tr>
<td>Day Close</td>
<td>Terminal Status</td>
</tr>
<tr>
<td>Denied Transactions</td>
<td>Terminal Status Messages</td>
</tr>
<tr>
<td>Down Time Per Error</td>
<td>Terminal text Messages</td>
</tr>
<tr>
<td>EMV Data</td>
<td>Terminal Totals</td>
</tr>
<tr>
<td>ISO Numbers</td>
<td>Triton Connect Numbers</td>
</tr>
<tr>
<td>Journal Data</td>
<td>Version Numbers</td>
</tr>
</tbody>
</table>

2. Additional controls will appear in the Reports Manager for some reports. Use these controls to refine the report criteria. The Changing Report Criteria section describes the control functions.

3. Make any needed control selections to further define the output of the selected report type. Click the View button to generate the report.

DISABLING ERROR MESSAGES

If errors exist in the data used to generate the report, such as incorrect or corrupted terminal data in the database, a series of error messages will appear. The user must dismiss each error message to view the report.

If the report criteria include many terminals, the Report Manager may show an excessive number of error messages. In such cases place a check mark in the Disable Error Messages check-box before clicking the View button. This will temporarily disable the display of error messages for ALL reports.

To view error messages, remove the check mark before viewing the next report.

CHANGING REPORT CRITERIA

The Reports Manager offers additional controls for some report types. These controls allow you to select criteria to further refine the output of the report.

CLOSE-TYPE REPORTS

Cassette Close and Day Close reports require additional controls to select the type of close data for viewing. Select either, (Trial Close or Close), and either (Most Recent Record or All Records).
The Reports Manager main window shown below.

Click Close to generate a report based on final close data.

Click Trial Close to generate a report based on trial close data.

Click Most Recent Record to generate a report based on the most recent close data for each terminal.

Click All Records to generate a report based on all available close data for each terminal.

**USING FILTERS WITH REPORTS**

By default, the Reports Manager generates reports from the data stored in the terminal database. This data accumulates from contacting all terminals. Available controls for each report type allows for report customization. Most of these controls do not allow the user to produce reports for specific terminals.

To generate reports for specific terminals, establish a filter using the Filters function of the Terminal Manager. Enable the filter before choosing and viewing a report. The Reports Manager will display the selected report using only the data from the terminals that fit the filter criteria.

**CALENDAR-STYLE DATE RANGE SELECTION**

The Journal Data, Journals Downloaded, Journals Not Downloaded, Most Common Status Messages, Terminal Down Time, and Terminal Status Messages reports provide a calendar-based date-range selector, as shown below.

The Start Date and End Date list boxes become active when the user selects the Journal Data report.

**Note**

Not all selected reports will active the Start Date and End Date list boxes.

By default, the starting and ending dates for the report are automatically set to the current day, which selects for the most recent one-day range of journal activity.

Specify a start date by selecting a month and year using the Start Date drop-down lists. Click the day of the month and the day becomes highlighted. This selects the day/month/year as the new starting date.

Specify an end date by select a month and year using the End Date drop-down lists. Click the day of the month and the day becomes highlighted. This selects the day/month/year as the new end date.

Click the Select All command button to view all journal data in the database.
The Terminal Status report requires additional controls to further refine the data returned by the Reports Manager.

Select the Terminal Status report and the window provides additional Report Details controls as shown.

Click All Terminals to generate a Terminal Status report using all terminals in the database.

Click Any Terminal Error to generate a Terminal Status report using only those terminals currently experiencing some sort of error condition.

Click Terminals Reporting Low Cash to generate a Terminal Status report using only those terminals reporting a low cash condition.

Click Specific Terminal Error # to generate a status report for terminals that are experiencing a specific type of error, select this option and enter the error number.
The Report Viewer screen displays the generated report.

**Printer Button**

The Printer button prints the report to the default printer used by the PC.

**Envelope Button**

The Envelope button exports the on-screen report into another format or application.

**Lightning Button**

The Lightning Bolt button refreshes the data on screen with the latest information from the databases.

**Tree Button**

The Tree button toggles from Preview to Report Only and back again. The Preview displays every report requiring more than one line of entry for any terminal. Selecting the Terminal ID from the Preview section jumps to the data in the report regarding that terminal.

**Percentage of View**

The Percentage of View drop-down changes the size of the page viewed in the report window.

**Navigation Control**

The Navigation Control allows the user to move from one page to the next, forward and backward. Type a page number in the text box to jump directly to the page.

**Search Button**

Type the text or values in the search box, and click the Find Next button to Search or click the Cancel button to exit the Search mode.
The *Call Failures Report* provides a listing of all terminals that Triton Connect failed to reach after five attempts from the scheduled Call List.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Time to Call** - The last scheduled call date and time that Triton Connect failed to contact the terminal.

**Interval** - The interval represents the amount of time between the last failed attempt and the next attempt to contact the terminal. Interval equals Hours, Days, Week, or Months.

**Count** - The number of Intervals needed to pass before Triton Connect attempts to contact the terminal.

**Tries** - The number of attempts to contact the indicated terminal. Triton Connect will make five attempts to reach a terminal before reporting a call failure.

**Called** - Identifies if Triton Connect successfully contacted the terminal.

**Total Failed Calls** - The total number of failed call entries in the report.

---

The *Call List Report* provides information on the currently scheduled and persistently scheduled calls in the active Call List. The report also provides a list of commands the call will perform, the next scheduled time to call, and whether or not that attempt has been made.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Phone Number** - The phone number or TCP/IP address Triton Connect will use to contact the terminal.

**Commands** - Triton Connect will request specific parameters from the terminal. The table below displays the command list.

### COMMANDS

<table>
<thead>
<tr>
<th>Call Summary (Case Sensitive)</th>
<th>J</th>
<th>Journal Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>All Journal Data</td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>X-entries Journal Data</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>Parameters</td>
<td></td>
</tr>
<tr>
<td>p</td>
<td>Selected Parameters</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>Synchronize Date/Time</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Error Status</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>Coupon Data</td>
<td></td>
</tr>
</tbody>
</table>

**Time Contacted** - The actual date and time Triton Connect successfully contacted the terminal.

**Int** - The Interval between attempted calls; h=hours, d=days, m=months, or y=years.

**Amt** - The number of Intervals (Int) Triton Connect waits before attempting to call the terminal, again.

**Time To Call** - The scheduled date and time Triton Connect will attempt to contact the terminal.

**Called** - States whether Triton Connect completed the call successfully, Yes or No.
The Cassette Close Report provides information summarizing the most current financial transactions, involving an indicated cassette, performed by the indicated terminal. Typically, this summary covers the period of time since the last Cassette Close operation performed on the terminal.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Date** - The date represents the last time the terminal performed the Cassette Close operation.

**Contact Time** - This time represents the last time the terminal uploads the close information.

**Cassette ID** - Identification for the cassette(s) installed in the ATM. For single-cassette ATMs, the ID is simply ‘Single’. An alpha code designation in the series ‘A’, ‘B’, ‘C’, or ‘D’, represents the cassette ID of a multi-cassette ATM, depending upon how many cassettes installed in the unit.

**Bill Size** - The denomination of the currency loaded in the designated cassette.

**Transactions** - This represents the total number of withdrawal transactions involving the designated cassette since the last Cassette Close operation.

**Reject Events** - The number of times currency routed to the reject cassette or vault in the terminal instead of dispensing to the customer. Rejects occur for a several reasons, such as poor note quality, currency not loaded correctly in the cassette, or machine error.

**Quantity** - Number of bills in the cassette applicable to the Start, Dispensed, and Remaining headings.

**Amount** - Total value of the currency in the cassette applicable to the Start, Dispensed, and Remaining headings.

**Start** - The Quantity heading displays the number of bills in the cassette after the completion of the last Cassette Close operation. The Amount heading displays the total value of the currency in the cassette after the completion of the last Cassette Close operation. The Quantity and Amount numbers will change to include the restocking of cash into the cassettes.

**Dispensed** - Under the Quantity heading, the number of notes dispensed including rejected notes since the last Cassette Close. The Amount heading displays the total cash value dispensed including rejects since the last Cassette Close.

**Remaining** - The Quantity heading displays the number of notes remaining in the cassette when the close operation take place. The Amount heading displays the total cash value remaining in the cassette when the close operation takes place.

**Note**
Due to changes in ATM software version 4.2.2 and later, use Triton Connect version 6.2 to correctly reflect the Day Close settlement amount and Cassette Close multiple amounts properly in the journal. Earlier versions will show N/A for these fields.

**Triton Connect 6.2 SP1** - Needed to correctly reflect the correct values in a cassette close journal record.
The Cassette Status Report provides information on the cassette as of last contact with the terminal.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Terminal Location** - The terminal location description initially entered into the database. This is usually the name of the store or other location where the terminal is installed.

**Date/Time** - The field indicates when the ATM last communicated with Triton Connect.

**Cassette ID** - Identification for the cassette(s) installed in the ATM.

**Bill Size** - The denomination of the currency loaded in the designated cassette.

**Reject Events** - The number of times currency authorized for dispense to the customer, but re-routes to the reject cassette or vault in the terminal.

**Cash Loaded** - Amount of cash loaded in the cassette during restock.

**Cash Dispensed** - Amount of cash dispensed since the last cassette close.

**Cash Remaining** - Cash remaining in the cassette.

**Totals** - This displays the cumulative totals for all cassettes in the indicated terminals.

### FOR MORE DETAIL

The Cassette Status parameters summarizes the descriptions providing additional details in the previous section, which covered the Cassette Close Report. See that section for more information on the following parameters.

- Terminal ID
- Cassette ID
- Reject Events
- Cash Loaded (See description of the Start parameter)
- Cash Dispensed (See description of the Dispensed parameter)
- Cash Remaining (see description of the Remaining parameter)
The **Check Digits Report** displays a management report that shows the check digits string associated with the currently loaded Master and Working keys.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Master Check Digits** - The string verifies the PIN Master keys when added to the keys to the terminal.

**Comm Check Digits** - The string verifies the PIN Working keys when sent by the Host processor.

**Last Contacted** - The date and time Triton Connect last contacted the terminal.

---

The **Check Digits Triple DES** displays a management report that shows the check digits strings associated with the currently loaded Master and Working keys for Triple DES encryption.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**PIN Master Key Left/Right** - The strings verify the PIN Master keys when added to the terminal.

**MAC Master Key Left/Right** - The strings verify the MAC Master keys when added to the terminal.

**PIN Working Key Left/Right** - The strings verify the PIN Working keys when sent by the Host processor.

**MAC Working Key** - The strings verify the MAC Working keys when sent by the Host processor.

**Last Contacted** - The date and time Triton Connect last contacted the terminal.
The *Coupon Report* provides information summarizing the types and numbers of coupons printed by the indicated terminal. Typically, this summary covers the period of time since the beginning operation of the terminal.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**.TCC File** - Name and location of the coupon file associated with the coupon graphic files listed under the Coupon heading.

<table>
<thead>
<tr>
<th>Terminal ID: TechWriter</th>
<th>Number Printed</th>
<th>Number Printed</th>
</tr>
</thead>
<tbody>
<tr>
<td>AU1</td>
<td>2</td>
<td>AU2</td>
</tr>
<tr>
<td>US3</td>
<td>5</td>
<td>US4</td>
</tr>
<tr>
<td>VI2</td>
<td>3</td>
<td>VI5</td>
</tr>
</tbody>
</table>

**Total Coupons Printed: 15**

**Total Coupons Printed** - Total number of coupons printed since the beginning operation of the terminal.

**Coupon** - File name of a Receipt Graphic file.

**Number Printed** - Total number of a Receipt Graphic printed since the beginning operation of the terminal.
The **Day Close Report** provides information summarizing the most current financial transactions performed by the indicated terminal. Typically, this summary covers the period of time since the last performed Day Close operation.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Transaction Date** - *Day Close* operation performed on this date.

**Transaction Time** - The time the terminal sends the close information.

**Business Date** - Business closing date for which the current *Day Close* operation is applicable.

**Host** - Total number of transactions of each type and a final Settlement value for those transactions recorded by the Host processor for Withdrawals, Inquiries, Transfers and Settlement values.

**Terminal** - Total number of transactions of each type and a final Settlement value for those transactions recorded by the terminal for Withdrawals, Inquiries, Transfers and Settlement values.

**Withdrawals** - The total number of withdrawals from the terminal including rejects since the last *Day Close* operation, as reported by the terminal and the Host.

**Inquiries** - Number of balance inquiries performed since the last *Day Close*, as reported by the terminal and the Host.

**Transfers** - Number of account transfer transactions performed by the terminal since the last *Day Close* operation, as reported by the terminal and the Host.

**Settlement** - Total monetary amount of all transactions performed since the last *Day Close*, as reported by the terminal and the Host.

**Host Totals** - The report displays the word *Received*, if data received from the Host or will leaves it blank.

---

**DENIED TRANSACTIONS REPORT**

The **Denied Transaction Report** provides the number of terminal transactions (of any type) denied by the Host Processor since the last *Day Close* operation.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Last Contacted Date/Time** - The date and time the terminal sends the Journal data.

**Number of Denied Transactions** - The number of terminal transactions of any type denied by the Host Processor since the last *Day Close* operation.

**Total Number of Denied Transactions** - The total number of transactions for all terminals shown in the report denied by the Host Processor since the last *Day Close* operation.
**Down Time Per Error**

The *Down Time Per Error* report shows a terminal’s detected error and how long it took to clear.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Error** - List of error codes and description detected by the terminal.

**Down Time** - In hours, minutes, and seconds, this feature records the amount of time from error detection to error cleared.

### EMV Data

<table>
<thead>
<tr>
<th>Terminal</th>
<th>5/2/2020</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EMV Data</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TID</td>
<td>EMV Enabled</td>
<td>Allow Magstripe</td>
</tr>
<tr>
<td>SAMPLE</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>TECH/STER</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Latch ICC** - With the EMV Processing enabled, this option enables latching in the EMV card reader.

**Store in Journal** - This option directs the terminal to record extra data received during an EMV transaction to the journal for disputed resolutions.

**Application Enabled** - The list shows the EMV Aids enabled on the ATM.

### ISO Numbers Report

The *ISO Numbers* report displays the ISO Numbers used by the listed terminals.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**ISO Numbers** - The ISO Numbers loaded in the indicated terminal. The terminal stores up to 100 Block ISO numbers; however, the terminal will accept only five numbers entered manually. Triton Connect management software allows the terminal to accept additional ISO numbers up to the 100 numbers limit.

**ISO Action** - The Independent Sales Organization, or ISO, numbers allow the terminal to block surcharging and to disable surcharge messages for financial institution’s ATM or Credit Card transactions. This report shows ISO actions the ATM will take.

**ISO Value** - The assign value to a specific ISO number

See the applicable terminal operations manual for additional information on the Block ISO feature.
The **Journal Data Report** provides a concise list of terminal activities, including customer transactions and machine-specific events and operations.

**Note**
The following note appears on the Report Manager screen: *Surcharges on Unsuccessful transactions will not appear in the Journal Data Report.*

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Rec #** - The Record Number counter increments after each transaction, machine operation or any other event tracked by the journal function of the terminal.

**Date** - The date the specified event took place.

**Time** - The time of day the specified event took place.

**Sequence Number** - The Sequence Number counter increments after each transaction performed by the terminal; such as, withdrawal, transfer, or balance inquiry. Some versions of terminal software allow the manual reset of the Sequence Number to zero.

**Transaction Type** - A short description of the specific type of customer transaction performed at the indicated date and time, if applicable.

**Journal Entry** - This column indicates the general type of event which took place at the specified date and time. The word “Transaction” refers to each customer transaction. Short, descriptive terms describe other machine operations and events, such as “Reset” in the case of an operation that re-initializes the terminal hardware and software.

**Primary Account #** - A sequence of numbers that typically consists of a combination of the Bank Identification Number and customer account number associated with the ATM, debit, or credit card used to make the transaction. Enable “Suppress Account Numbers” to show only the last four (4) digits.

**# of Surcharges** - The number of surcharges assessed for a cash transaction.

**Surcharge Amount** - The surcharge fee assessed for a cash withdrawal transaction, if any.

**Amount Dispensed** - The amount of cash dispensed to the customer during a withdrawal-type transaction.
Totals - These amounts represent the sum of all Surcharge Amount and Amount Dispensed values related to the specific terminal.

Grand Totals - These amounts represent the sum of all Surcharge Amount and Amount Dispensed values related to all the terminals shown in the Journal Data Report.

**JOURNALS DOWNLOADED**

<table>
<thead>
<tr>
<th>Triton Connect Journal Received Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Terminal ID:</strong></td>
</tr>
<tr>
<td>TSE1600</td>
</tr>
<tr>
<td>TSE1605</td>
</tr>
<tr>
<td>TSE1380</td>
</tr>
</tbody>
</table>

The Journal Downloaded report provides information on the first and most recent journals received.

Terminal ID - The name used to identify the terminal initially entered into the Triton Connect database.

Earliest Time Received - The date and time the journal first downloaded.

Latest Time Received - The date and time the journal last downloaded.

**JOURNALS NOT DOWNLOADED**

<table>
<thead>
<tr>
<th>Triton Connect Journal Received Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Terminal ID:</strong></td>
</tr>
<tr>
<td>TSE1600</td>
</tr>
<tr>
<td>TSE1605</td>
</tr>
<tr>
<td>TSE1380</td>
</tr>
</tbody>
</table>

The Journal Not Downloaded report provides a list of terminals for which no journals downloaded within the specified date range.

Terminal ID - The name used to identify the terminal initially entered into the Triton Connect database.

Earliest Time Received - The date and time the journal not first downloaded.

Latest Time Received - The date and time the journal not last downloaded.

**MOST COMMON STATUS MESSAGES**

<table>
<thead>
<tr>
<th>Most Common Status Message</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5/29/2020</strong></td>
</tr>
<tr>
<td><strong>Number of Occurrences</strong></td>
</tr>
<tr>
<td>469</td>
</tr>
<tr>
<td>43</td>
</tr>
<tr>
<td>28</td>
</tr>
<tr>
<td>13</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>7</td>
</tr>
</tbody>
</table>

The Most Common Status Messages report lists all the status message received over a specified time interval, listed in order of greatest number of occurrences. As a management tool, this report helps the user to pinpoint problem areas.

Status Messages Reported From - Shows the time interval which the status messages in the report occurred.

Number of Occurrences - The number of times the Status Message code occurred. The list presents the most common status message at the top of the list, followed by the next most common status message, and so on for all status messages logged over the specified time frame.

Status Message - Displays a code with a short description of the terminal's status.

Total Number of Status Messages - The total number of all status messages received over the time interval shown in the Status Messages Reported From block.

**SCHEDULED CLOSE REPORT**

<table>
<thead>
<tr>
<th>Triton Connect Scheduled Close Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Terminal ID</strong></td>
</tr>
<tr>
<td>SAMPLE</td>
</tr>
<tr>
<td>TSE1600</td>
</tr>
</tbody>
</table>

The Scheduled Close Report provides information on the Scheduled Day Close setup of each terminal.

Terminal ID - The name used to identify the terminal initially entered into the Triton Connect database.

Scheduled Close Time - The time the terminal will perform a scheduled Day Close.
**Last Contacted** - The date and time Triton Connect last contacted the terminal to perform a scheduled Day Close.

**TERMINAL CONFIGURATION REPORT**

<table>
<thead>
<tr>
<th>Terminal Configuration Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/27/2020</td>
</tr>
<tr>
<td>Terminal ID</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>SAMPSE</td>
</tr>
<tr>
<td>TECHWRITER</td>
</tr>
<tr>
<td>TG1000</td>
</tr>
</tbody>
</table>

Total Number of Terminals = 3

The *Terminal Configuration Report* provides information about each terminal entered in the Terminal Manager.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Location** - The data entered into the Triton Connect terminal database that describes the name of the store or other location where the physical terminal resides.

**Address** - The data initially entered into the Triton Connect terminal database that describes the physical location of the terminal, such as the street address, city, state and zip code of the store or other location.

**Phone Number** - This entry will include the contact phone number for dial-up terminals, or a TCP/IP address for Ethernet or wireless terminals. For more information, see Chapter 4, Call Monitor Connection Type.

**TERMINAL DOWN TIME REPORT**

<table>
<thead>
<tr>
<th>Terminal Down Time Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/27/2020</td>
</tr>
<tr>
<td>Terminal ID</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>TECHWRITER</td>
</tr>
<tr>
<td>AIR CASINO</td>
</tr>
</tbody>
</table>

Total Down Time: 2:17:03

The *Terminal Down Time Report* logs the number of down time hours for each terminal during a specified time range.

**Down Time From** - Shows the time frame of the monitored terminals listed in the report.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Down Time (In Hours)** - Displays the number of Down Time hours for the indicated terminal.

**Total Down Time** - Total number of down time hours logged during the specified time frame, for all the terminals listed in the report.

**TERMINAL FILES**

The *Terminal Files* report only applies to Z180 ATM's though (9100/9600/9700). It is basically a list of files (ad graphics, plug-ins, etc.) stored on the terminal flash.

**TERMINAL STATUS REPORT**

<table>
<thead>
<tr>
<th>Terminal Status Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/27/2020: 8:56 AM</td>
</tr>
<tr>
<td>Terminal ID</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>SAMPSE</td>
</tr>
<tr>
<td>TECHWRITER</td>
</tr>
<tr>
<td>TG1000</td>
</tr>
</tbody>
</table>

Total Terminals Reporting = 3

The *Terminal Status Report* provides information on the status of the terminal as of the last contacted date and time.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Location** - The data entered into the Triton Connect terminal database that describes the name of the store or other location where the physical terminal resides.
**Date/Time** - The date and time Triton Connect last contacted the terminal and downloaded the error status data.

**Error Description** - The most recent error codes and descriptions shown for the indicated terminal.

**TERMINAL STATUS MESSAGES REPORT**

<table>
<thead>
<tr>
<th>Terminal ID</th>
<th>Date/Time</th>
<th>Status Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE</td>
<td>2/27/2020 11:41:04AM</td>
<td>103 - Terminal did not answer Triton Connect</td>
</tr>
<tr>
<td></td>
<td>9/28/2020 8:32:13AM</td>
<td>103 - Terminal did not answer Triton Connect</td>
</tr>
<tr>
<td>TECHWRITER</td>
<td>3/11/2020 2:12:18PM</td>
<td>901 - Dispenser - Cassette is missing, Cash Dispenser Status 001 - No Errors</td>
</tr>
<tr>
<td></td>
<td>3/14/2020 3:00:29PM</td>
<td>901 - Dispenser - Cassette is missing, Cash Dispenser Status 001 - No Errors</td>
</tr>
<tr>
<td></td>
<td>3/15/2020 11:41:21AM</td>
<td>901 - Dispenser - Cassette is missing, Cash Dispenser Status 001 - No Errors</td>
</tr>
<tr>
<td></td>
<td>3/15/2020 11:46:39AM</td>
<td>103 - Terminal did not answer Triton Connect</td>
</tr>
<tr>
<td>TS1600</td>
<td>2/27/2020 11:39:17AM</td>
<td>103 - Terminal did not answer Triton Connect</td>
</tr>
<tr>
<td></td>
<td>2/27/2020 1:38:53PM</td>
<td>103 - Terminal did not answer Triton Connect</td>
</tr>
</tbody>
</table>

The Terminal Status Messages Report lists the type and number of status messages received from specified terminals over a user-defined time frame.

**Status Messages Reported From** - The time range of the data collected for this report.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Date** - The date and time Triton Connect received the indicated terminal's status message.

**Status Message** - The code number and a short description of the terminal's status at the date/time received.

**Total Number of Status Messages** - Shows the total number of status messages in the report.

---

The Terminal Text Messages report provides a list of information presented to the customer before, during, or after their transaction.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Message Type** - Messages displayed on the Terminal screen, printed receipt, or coupon.

**Message** - Specific information provided to the customer depending on the message type.

---

The Terminal Totals Report provides financial information accumulated from Day Close to Day Close as of the last contacted date and time. If the user does not perform Day Closes, the report will show the cumulative totals.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Debits** - The number of checking and savings account withdrawal transactions collected since the last Day Close operation.

**Credits** - The number of credit card withdrawal transactions performed since the last operation of a Day Close.
**Inquiries** - The number of balance inquiries performed by the terminal since the last *Day Close* operation.

**Transfers** - This is the number of account transfer transactions performed by the terminal since the last *Day Close* operation was performed.

**Debit Amount** - Total monetary value of all Debit transactions that have taken place.

**Credit Amount** - Total monetary value of all Credit transactions that have taken place.

**Totals** - Total of all values for all terminals listed in the Terminal Totals Report.

---

## TRITON CONTACT NUMBERS

**Triton Connect Phone Numbers and Call Back Report**

<table>
<thead>
<tr>
<th>Terminal ID</th>
<th>Last Contacted</th>
<th>Call Back</th>
<th>Primary</th>
<th>Backup</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCOI/WRITER</td>
<td>3/26/2020, 1:44:00 PM</td>
<td>Yes</td>
<td>100-204-0000</td>
<td>103-204-0001</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>103-204-0999</td>
<td>105-204-0999</td>
</tr>
<tr>
<td>TS/1500</td>
<td>1/1/2020, 12:01:00 AM</td>
<td>No</td>
<td>103-103-1032</td>
<td>103-103-1035</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>103-000-0000</td>
<td>Not Set</td>
</tr>
</tbody>
</table>

Terminal Count: 2

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Last Contacted** - The date and time Triton Connect last contacted the terminal to perform a scheduled *Day Close*.

**Call Back** - If enabled, Triton Connect will disconnect and wait for the terminal to call back via the Primary phone number or TCP/IP address. If the Primary does not connect, the terminal will use the Backup number or address.

**Primary** - The Primary phone number or TCP/IP address to Triton Connect and Alarm.

**Backup** - The Backup phone number or TCP/IP address to Triton Connect and Alarm.

---

## VERSION NUMBERS REPORT

The **Version Numbers Report** provides information on hardware versions for all terminals reporting information to Triton Connect.

**Terminal ID** - The name used to identify the terminal initially entered into the Triton Connect database.

**Model #** - The assigned model number of the indicated terminal.

**EPROM Version #** - The EPROM holds software downloading, initialization, testing, and low-level interface routines. The version number assigned to the EPROM chip currently installed in the terminal.

**Program Version #** - The version number assigned to the software currently loaded in the terminal. The terminal operating software downloaded either locally or remotely via Triton Connect.

**Table/Screen Version #** - The version number assigned to the software component that provides ATM user interface and associated terminal control functionality. X-Scale terminals have Screen file, While X2 and X3 have Table Files. Both files serve the same purpose.

**Printer Version #** - The version number assigned to the Printer. Availability of this data depends upon the version of ATM software running in the terminal.

**SPED Version #** - The version number assigned to the SPED firmware. Availability of this data depends upon the version of ATM software running in the terminal.

**Dispenser Version #** - The version number assigned to the Dispenser. Availability of this data depends upon the version of ATM software running in the terminal.

**Total Number of Terminals** - The total number of terminals listed on the Version Numbers Report.
CHAPTER 12 - SOFTWARE DOWNLOAD

INTRODUCTION

A Triton Connect feature performs remote software downloads to terminals. In this chapter, we'll show you how to access this function.

ACCESS THE SOFTWARE DOWNLOAD FUNCTION

Follow these steps to access the Software Download function.

1. Using the Supervisor Password, Navigate to the Terminal Manager > Utilities > Software Download. The Load Terminal Software screen appears.

2. Load Terminal Software screen appears.

3. Load Terminal Software screen displays similar in the overall appearance to other terminal data screens in Triton Connect. Most of the data fields serve only to help identify and locate the desired terminal. The Terminal ID list provides a quick way to select a terminal. If the list contains many terminals, use the Search or Filter features to locate a terminal or reduce the number of terminals displayed in the list.

4. Follow these steps to initiate a software download.

   1. Select the ID of the terminal you want to load with software. If applicable, select the Broadcast option to select multiple terminals.
   2. Click the Select File button and use the file brow-

DOWNLOADING SOFTWARE

The Load Terminal Software screen displays similar in the overall appearance to other terminal data screens in Triton Connect. Most of the data fields serve only to help identify and locate the desired terminal. The Terminal ID list provides a quick way to select a terminal. If the list contains many terminals, use the Search or Filter features to locate a terminal or reduce the number of terminals displayed in the list.

Follow these steps to initiate a software download.

1. Select the ID of the terminal you want to load with software. If applicable, select the Broadcast option to select multiple terminals.
2. Click the Select File button and use the file brows-

EPROM ACCESS CODE

Select the Send option to schedule a software download. Unless the database has the Access Code and if the terminal operates with Z-180 version 5.0 ATM software or greater, the program will prompt the user to enter the terminal's EPROM Access Code.
DOWNLOAD OPTIONS Z180 ATM ONLY

Above the **Send File** button on the **Load Terminal Software** screen list three download options to change the way the download normally performs.

**INCLUDE EEPROM PARAMETERS**

The Terminal’s EPROM stores Parameters, specify operational conditions, and provide necessary operating information for the terminal.

During initial software load at the factory, production loads the terminals with default parameter values. The user modifies these values during the installation of the terminal, to fit specific operational requirements.

**Caution**

With this option checked, the values contained in the software load file will erase the terminal’s existing parameters. The terminal will need a site-specific configuration, including re-enabling Triton Connect.

**RECOGNIZING TERMINAL TYPES**

If the terminal previously sent its parameters for storage in the database, Triton Connect automatically chooses the correct software download type.

If the terminal operates with a Z-180 version 5.0 software or greater, Triton Connect will attempt an unattended remote download.

**ERASE EEPROM PRIOR TO LOAD**

This option specifies the erasure of the terminal’s EEPROM prior to loading the parameters contained in the software load file. Check the **Include EEPROM Parameters** option to activate this option.

**Caution**

Erasing the EEPROM will disable the ATM and require the terminal’s reconfiguration at the ATM site before operations can resume.

FORCE TRICOMM DOWNLOAD

If an unsuccessful attempt to download the software to a terminal operating Z-180 version 5.0 software or greater, check the Force Tricomm Download option to force a download using the Tricomm protocol. This type of download will require the assistance of support personnel at the terminal location.

**Note**

Terminal’s with TCP/IP connection type will not allow a Forced Tricomm download and will display an error message.

**TRICOMM DOWNLOADS**

Use Tricomm, a separately available PC-based utility, to load terminal software. It typically resides on a PC or laptop computer near the terminal location and physically connected to the terminal by a serial cable (8-bit machines).

Tricomm-type downloads require the EPROM Access Code entered at the terminal. With access granted, use the special menu to configure the terminal to accept the software download.

For instructions on performing this type of download, see the operating instructions that came with the Tricomm utility or the ATM service manual.
**LOAD FILE FORMAT**

For Load File Formats, refer to the table below.

<table>
<thead>
<tr>
<th>EEE value</th>
<th>EEE meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>tlf</td>
<td>XScale</td>
</tr>
<tr>
<td>tlv</td>
<td>X2 CE 5</td>
</tr>
<tr>
<td>tr6</td>
<td>X2 CE 6</td>
</tr>
<tr>
<td>tr7</td>
<td>X3 CE 7</td>
</tr>
</tbody>
</table>

**TERMINAL SPECIFIC LOAD FILE SELECTION**

Navigate to the *Terminal Manager > Utilities > Software Download*.

Click the *Select File* button. The application will display an Open Load File dialog box. The file type displayed will depend on the Terminal ID selected. As an example, if the application identifies the terminal as an X2 terminal, the Open Load File screen displays load files with the .TLV or TR6 file extension.

If the version information identifies the terminal as an XScale or Z-180, the dialog will display the file formats with the .TLF extension.

**Note**

If the database does not have the selected terminal's parameters, the system will display a message prompting the user to download parameters for the selected X2 terminal.

**FILE FORMAT VALIDATION**

Select a load file with a tlf, tlv, tr6, or tr7 extension and press the *Open* button. The application will start the file validation process and if it identifies a valid tlf, tlv, tr6, or tr7 load file, the Open Load File dialog box will close and display the Software Download dialog screen.

The application will display an error message for invalid load file.

Acknowledge the error by pressing the *OK* button and the screen returns to the Software Download dialog screen.

**END OF SOFTWARE DOWNLOAD**
This feature is now available by selecting the Extended Parameters button under the Control tab.

This Applies to ALL ATMs except the Z180 ATM Series.

For the Z180 Series go to next page.
**Note**

The Ad Designer applies the Z180 ATM series only.

INTRODUCTION

The Ad Designer combines bit-mapped graphics and text together to create Ad Screens for non-PC based units. Download these Ad Screens for display on selected terminals via Triton Connect.

The Ad Designer editing utility imports and manipulates bit-mapped graphics (BMP format) to create Graphic Ad Screens. Additional tools enable the merging of text with bit-mapped images or creation of text-only Ad Screens.

**Note**

Terminals equipped with one or more Expansion Memory modules (96XX) can download Graphic Ad Screens. Text-only Ad Screens do not require additional storage memory.

Navigate to Terminal Manager > Utility > Ad Designer.

**Note**

The filename of the image must be no longer than eight characters (not including the period and file name extension).

AD SCREEN CHARACTERISTICS

The Ad Designer can only import and manipulate bit-mapped graphic images. It cannot create them. Use a third-party graphics application to create the graphic images for use as Ad Screens.

In creating your graphics, ensure the images conform to the following requirements.

- The images will use either 16-color or 256-color.
- The maximum image size limited to 320 pixels wide by 240 pixels high. The maximum size represents the dimensions of the terminal's LCD display screen.

The Windows Paint application creates bitmap files in a generic format fully compatible with the Ad Screen capabilities of the terminal. If the user uses another graphics program to create the bitmap images, Triton recommends opening and re-save the file using Windows Paint before processing the file with the Ad Designer to ensure maximum compatibility with the terminal.

AD SCREEN SIZE

The Ad Designer will not allow images larger than 320-by-240 pixels. If the user forgets the maximum size, click the Help option on the menu bar and the screen below opens.

This message box also shows the allowable color-depth values allowed for Ad Screen images: 16-color or 256-color.
Triton Connect will not transfer files to a terminal if those files have names that contain non-alphanumeric characters. Use only the characters A-Z (upper or lowercase) and the numbers 0-9. Any other characters will prevent Triton Connect from downloading the graphics to the terminal. Only the display schedule will be sent, resulting in the display of blank screens on the terminal at scheduled times.

**ACCESSING THE AD DESIGNER**

Follow this step to access the Ad Designer.

Navigate to the *Terminal Manager > Utilities > Ad Designer* option and the screen opens below.

Additional options enable the user to see the color depth (16-color or 256-color) of the image viewed in the display window, to view various help displays, and to restore warning messages.

**TEXT VS. GRAPHIC AD SCREENS**

Graphics Ad Screens will take priority over text-based screens. Terminals equipped with one or more optional Expansion Memory Modules and run Graphics Ad Screens, will not display text-based screens.

Terminals with no Graphics Ad Screens loaded, or the Ad Screen function turned off, will display Text Ad Screens, if loaded.

This behavior allows the user to design both graphic and text versions of Ad Screens, to broadcast to a group of terminals. Those terminals that support graphics will automatically display the graphics versions of the Ads, while terminals not equipped (or not enabled) to display graphics Ads will automatically display the text-based versions.

**DISPLAY WINDOW**

The Ad Designer manipulates Ad Screen contents, graphic and text entities, as discrete “objects.” This gives the user the ability to select individual components of an Ad Screen for various editing operations.

The Display Window provides a location to compose the Ad Screen. Place both text and graphic elements within the display area and position them as needed to create the final Ad Screen composition.

**AD DESIGNER FEATURES**

This section provides a brief outline of the functions of the Ad Designer.

**MENU**

The primary options available through the menu bar allow the user to open and save graphics files, place graphic images within the display area, clear the display area, and set the Ad Screen display duration of how long the terminal screen displays the Ad Screen.
The text-entry block below the display window allows the user to add any textual words or phrases to an existing graphic or to create a text-only Ad Screen.

The Redraw Screen button refreshes the display as needed during editing operations.

The Text Display Options enhances the Ad Screen text within the display.

- **Reverse.** Checking this option reverses the foreground and background color selections in the text object.

- **Transparent.** Checking this option, places the text directly on a BMP graphic without erasing the image behind the text. The text will appear to “float” over the underlying image.

- **Foreground Color.** The color box next to the button displays the current font color. To select a different color, click the **Foreground Color** button and select a color from the pallet of sixteen colors. The new color will apply to the next text entry.

- **Background Color.** The color box next to the button displays the current background color. To select a different color, click the **Background Color** button and select a color from a color pallet of sixteen colors. The new color will apply to the next text entry.

- **Font Size.** Click the down arrow in the list box and select a font size; Small, Medium, or Large.

**CREATING TEXT**

Because the Text Display Options provide only a basic set of configuration settings, consider using a separate graphics application to add text directly to your Ad Screen bitmaps.

Most commercial graphics programs contain many typeface and font size options, and offering a wider range of creative choices in the creation of your Ad Screens.
CREATING AN AD SCREEN

Follow the procedures below to create an Ad Screen.

1. Click the **Place BMP** option on the Menu Bar. Navigate to the folder containing the screen files.

   ![Open BMP File](image)

   The Ad Designer will evaluate the “color depth” of the image and will present one of two warning messages.

   **TURN WARNING MESSAGES ON AND OFF**

   The warning messages have a means of turning off the messages, so the appearance of these screens does not interrupt subsequent operations.

   Click the check box to turn off the display of that warning screen.

   ![Select 256-color BMP](image)

   ![Don't Select 256-color BMP](image)

   This warning screen gives the user the option to proceed with the selection of the 16-color bitmap image, or return to the file-selection dialog and select a 256-color bitmap image.

   If the terminal has a 16-color display, only a 16-color Ad Screen will work in this terminal, in which case, the user should click the **DON'T SELECT 256-color BMP** button. The selected image will appear in the display area.

   However, if the terminal uses a 256-color display, you may also wish to select another, 256-color image. This may be a version of the first, 16-color image, or a completely different image. In this case, click the **SELECT 256-color BMP** button. You will be presented with the file selection dialog, which will allow you to choose a 256-color image. Both images will be loaded into the display area. The first image (16-color) will be visible, while the second image (256-color) will be hidden. You can switch between images using the **Window** option on the menu bar.

   Of course, a 256-color display can also display a 16-color image (although there will be no improvement in the image), so if the terminal uses a 256-color display either 16-color or 256-color images may be used.

2. Select the BMP graphic by either double clicking on the desired BMP file name, or click on the file name to highlight it and then click the **Open** button.

   ![File Name](image)

   Select **Help** on the menu bar and click **Enable Messages** to turn all currently disabled warning messages back on.
FOR 256-COLOR IMAGES:

This warning screen the gives the user the option of proceeding with the selection of the 256-color bitmap image, or of opting to return to the file-selection dialog to select a 16-color bitmap image.

If the terminal has a 256-color display, choose the DON’T SELECT 16-color BMP button to proceed with the operation. The selected image will appear in the display area.

If the terminal uses a 16-color display, only a 16-color image will work in this terminal. In this case, choose the SELECT 16-color BMP button. You will then be presented with the file selection dialog, which will allow you to locate and select a 16-color image. Both images will be loaded into the display area. Use the Window option to select the image you wish to work on.

SWITCHING BETWEEN 16-COLOR AND 256-COLOR IMAGES

To determine the color depth of the image visible in the display area, select the Window option from the menu bar.

A check mark will appear next to the type of image displayed. If the display area has a second image, click the appropriate image type to view it.

3. The BMP graphic will appear in the display area. To move the graphic, click on the image while holding down the left mouse button and drag the graphic to the desired location. Note how the image is replaced by a black bounding-box during the dragging operation.

4. To place text with the graphic, type the text into the text box.

TEXT-ENTRY LIMITATIONS

The text entered does not wrap. Each line of text must be entered individually.

Using Small/Medium font selection, approximately 30 characters will fit on one line; using large font, approximately 20 characters. Ten to fifteen lines of text will fit vertically within the image display window, depending on the font size.

5. Next, use the Text Display Options to change the text characteristics as needed.
6. Move the mouse cursor to a location in the Display area where the text will appear on the Ad Screen and click the left mouse button. The first-time text is added to the image the following warning message will appear.
The screen offers a caution concerning the display of text on terminals with 256-color displays will not display correctly.

**PROBLEM WITH TEXT ON 256-COLOR DISPLAYS**

To avoid text display problems on 256-color displays, use a graphics application to add text directly to your Ad Screen bitmaps, also, create a 16-color Ad Screens with text in this way.

An advantage of this technique is that most commercial graphics programs enable you to select from many typeface and font size options, offering a wider range of creative choices in the creation of your Ad Screens.

Text and 16-color graphics combined in the Ad Designer will display on 16-color terminals correctly.

Click the **OK** button. The text appears on the screen. To move the text place the cursor over the text. Click and hold the left mouse button. Drag the text to the desired location and release.

Add additional text objects to the Ad Screen by repeating Steps 4-6. Can add up to 28 text objects to the bitmap, or place in a text-only Ad Screen.

**CREATING TEXT-ONLY AD SCREENS**

To create text-only Ad Screens, simply place the text you want in the display area and save the image (see Step 9).

The process creates a .TCG file containing the text of the Ad Screen.

7. To delete the graphic or a text object, place the mouse cursor on the item and click the right mouse button. A confirmation box will open.

The object receives a number upon its creation. The bitmap image receives object number 1 by default. Text objects receive numbers from 2 to 29.

To delete the selected object, click the **OK** button; otherwise, click the **Cancel** button and return to the display area window.

8. Select the **Display Duration** option from the menu bar

Choose a display duration for the Ad Screen. Terminal will display the Ad on its screen for the number of seconds selected. Ad Screens will repeatedly display on the terminal screen using a “looping” system.
9. Upon completion of the Ad Screen graphic, save it by selecting the File option on the menu bar, and click Save As.

Name the file and click the OK button. The software creates a Triton Connect Graphic (TCG) file format.

**Note**
A warning message opens for filenames greater than eight characters. Click the OK button. The Save As screen opens with the first eight characters highlighted. Accept the highlighted name or change the name with the limit of eight characters.

Use the Ad Graphics/File Manager tab in the Terminal Parameters area to download the Ads created in the Ad Designer.

Do not move, rename, or otherwise alter the original bitmap file created in the Ad Screen or Triton Connect cannot download the file to the terminal!

**ABOUT TCG FILES**

The .TCG file holds information about the layout, contents, and characteristics of an Ad Screen.

1. The .TCG file contains text added to the Ad Screen image, including all text-formatting information.
2. The .TCG file contains a pointer to the original bitmap image used in the creation of the Ad Screen.

3. The .TCG file contains the display duration parameter.

**GRAPHIC SIZES**

Graphics are displayed in designated fields in the display. Optimize display graphics by creating them in sizes that fit their intended use. Graphic dimensions are in pixels.

**X-SCALE UNITS (RL/FT5000/RT2000)**

- Full Screen - 636 X 476
- Logo - 310 X 85
- Transaction Ad - 636 X 260
- Banner - 205 X 56
- Welcome Ad - 310 X 385

- Coupon Graphic (Top or Bottom only) - 450 X 225 (.BMP only)
- Coupon Graphic (Top and Bottom) - 320 X 160 (.BMP only)
- Receipt Graphic - 480 X 120 (.BMP only)

**X2 UNITS (RL2000 OR X2-MIGRATED RL/FT5000/RT2000 (W/10.4” DISPLAY))**

- 5.7” Display (RL2000)
  - Full Screen - 636 X 476
  - Welcome Ad - 322 X 475
  - Transaction Ad - 636 X 475
  - Receipt Graphic - 480 X 120 (.BMP only)

- 8.0” Display (RL2000) / 10.4” Display
  - Header - 636 X 90
  - Welcome Ad - 310 X 385
  - Full Screen Ad - 636 X 476
  - Transaction Ad - 636 X 260
  - Receipt Graphic - 480 X 120 (.BMP only)

- Coupon Graphic (Top or Bottom only) - 450 X 225 (.BMP only)
- Coupon Graphic (Top and Bottom) - 320 X 160 (.BMP only)
- Applies for any X2 display size.
Graphic Examples

LOGO 310 x 85

BANNER 205 x 56

WELCOME AD 310 x 385

RECEIPT 430 x 120

HEADER (X2) 636 x 90

TRANSACTION AD 636 x 260

FULL SCREEN 636 x 476

End of Ad Designer
**CHAPTER 14 - COUPON UTILITY**

**INTRODUCTION**

The Coupon Utility manages the graphic images and displays parameters associated with the Coupon Selection feature of Triton Systems ATMs. The Coupon Selection feature available after an ATM transaction enables the customer to select a coupon from a graphical menu screen. The ATM’s receipt printer prints the selected coupon with a graphic image associated with it. Triton Connect downloads these bitmap images and displays the parameters to selected terminals.

The Coupon Utility imports and assigns bitmap graphics to the Coupon Selection Screen. The Utility assigns individual receipt coupon graphic images up to six menus selections, and establishes the display duration of the Coupon Selection Screen.

**Note**

Only ATMs with supporting software will have the Coupon Selection feature.

**ABOUT TCC FILES**

In the final step of the Triton Connect Coupon file creation, the process creates the .TCC file, a specially-formatted data file, which holds information describing the contents, displays duration of the Coupon Selection Screen, and contains pointers to the bitmap images of the Coupon Section Screen and Receipt Graphics.

Caution

Do not move, rename, or otherwise alter the original bitmap files associated with the .TCC file. To do so can prevent Triton Connect from downloading the files to the terminal.
ACCESSING THE COUPON UTILITY

Navigate to the Terminal Manager > Utilities > Coupon Utility option. The following screen opens.

COUPON UTILITY FEATURES

This section provides a brief outline of the features of the coupon utility.

The menu bar options allow the user to do the following:

1. **File.** Open and save Triton Connect Coupon (.TCC) files.
2. **Place BMP.** Place Coupon Selection Screen graphics into the display area.
3. **Clear Screen.** Clear the screen of the current Coupon Selection Screen and Receipt Graphic selections.
4. **Remove BMP.** Remove the Receipt Graphic associated with a Coupon Button.
5. **Window.** See the color depth (16-color or 256-color) of the Coupon Selection Screen image currently being viewed in the display window. This also allows you to switch between the 16-color or 256-color versions of the image.

COUPON IMAGE CHARACTERISTICS

The Coupon Utility cannot create bitmap images: it can only import them. You must use a third-party graphics application (such as the Paint utility included in Microsoft Windows) to initially create the images desired as the Coupon Selection Screen graphic and Receipt Graphic images.

COUPON SELECTION SCREEN

The Coupon Selection Screen image must conform to these specifications.

The image must be either 16-color or 256-color, or rejected.
The image must be 320 pixels wide by 240 pixels high, or rejected.

RECEIPT GRAPHICS

Each Receipt Graphic image must conform to the following requirements

The image must be monochrome (black and white) format. If the image is not monochrome, it will not be available for selection as a receipt graphic.
The image must be no larger than 380 pixels wide by 700 pixels high. If the dimensions of the image are greater than these limits the image will not be available for selection as a receipt graphic.
1. **Display Window.** Where the selected Coupon Selection Screen will appear.

2. **Menu** buttons. Buttons 1 through 3 and buttons 5 through 7 used to select a monochrome bitmap image for printing on the selected receipt coupon.

3. **More/Cancel** button. Represent the functions available to the customer at the ATM. The More button allows the user to switch to the next Coupon Selection Screen and set of Receipt Graphics menu selections. The Cancel button returns the customer to the previous Coupon Selection Screen, or to the ATM welcome screen (if currently on the first Coupon Selection Screen).

4. **Display Duration.** Used to select the length of Creating a Triton Connect Coupon file.

### HOW MANY MENU LEVELS

Each Triton Connect Coupon (.TCC) file created in the Coupon Utility can reference ONE Coupon Section Screen and up to SIX Receipt Graphic images. Download multiple .TCC files to a terminal will provide multiple Coupon Selection Screens to the customer. The number of .TCC files/graphics stored on the terminal depends upon the amount of available memory on the selected expansion memory card.

To conserve memory for use by the Ad Graphics, do not download more than two .TCC files per installed memory card.

For more information on downloading files to the terminal, see the Ad Graphics/Fill Manager topic in Chapter 8, Terminal Parameters.

### CREATING A TRITON CONNECT COUPON FILE

Follow this procedure to create a Triton Connect Coupon file:

1. Click the **Place BMP** selection on the Menu Bar. This displays a BMP file selection window. Use it to locate the bitmap file desired.

### LOCATION OF FILE

The files selection window allows the user to locate and select Coupon Selection Screen files. The selected file is automatically copied into the .BMP sub-folder of the Triton Connect installation folder.

2. Select the BMP graphic by either double clicking on the desired BMP file name, or by clicking on the file name to highlight it, then clicking the **Open** button.

3. The Coupon Utility will evaluate the color depth (number of colors in the image), and will present either of two messages, depending on whether image is 16-color or 256-color.

This screen gives the user the option to proceed with the selection of the 16-color bitmap image, or to return to the file selection dialog to select a 256-color bitmap image.

Take this opportunity to consider the type of terminal to display the image. If the terminal has a 16-color display, the 16-color Coupon Selection Screen is the only correct choice. If this is the case, click the **DON'T SELECT 256-COLOR BMP** button. The selected image will appear in the display area.

---

**Triton Connect Ad Designer (SuperVision)**

- **File**
- **Place BMP**
- **Clear Screen**
- **Remove BMP**
- **Window**

You have selected a 16-color BMP file. Because terminals with 256-color displays will only display 16-color BMP files at the lower, 16-color resolution, you may wish to select a 256-color version of this file to broadcast to terminals with 256-color displays.

Remember, if you choose not to select a 256-color version of this BMP file, only a 16-color BMP version will be broadcast and will be displayed at the lower, 16-color resolution on 256-color display terminals.

- **Select 256 color BMP**
- **Don't Select 256 color BMP**

[Select 256 color BMP]

[Don't Select 256 color BMP]

[Do not display this message again.]
However, if the terminal uses a 256-color display, you may also wish to select another, 256-color version of the first 16-color image, or a completely different image. If this is the case, choose the select 256-color bmp option. You will be presented with the file selection dialog, which will allow you to choose a 256-color image. Both images load into the display area. The display will show the first image (16-color), and hide the second image (256-color). You can switch between images using the Window option on the Menu Bar (see Switching Between 16-color and 256-color Images section below).

**TURNING WARNING MESSAGES ON/OFF**

The warning messages that appear when graphics or text are selected can be turned off, so subsequent operations are not interrupted by the appearance of these screens.

A check box appears at the bottom of each screen. This option allows the user to turn off the display of the warning screen. Click the check box to enable.

**Note**

To turn all currently disabled warning messages back on, close the Coupon Utility. On the Terminal manager screen, navigate Utility > Ad Designer > Help option. Click on the Enable Messages option.

A 256-color display can also display a 16-color image (although there will be no improvement in the image), so if the terminal uses a 256-color display either 16-color or a 256-color image may be used.

**FOR 256-COLOR IMAGES:**

This screen will give you the option of proceeding with the selection of the 256-color bitmap image, or of opting to return to the file selection dialog to select a 16-color bitmap image to work on as well.
If the terminal has a 16-color display, you will have to select a 16-color image instead since terminals with 16-color displays cannot display 256-color images correctly. In this case, click the SELECT 16-COLOR BMP button. The file selection dialog opens and allows you to locate and select a 16-color image. Both images load into the display area. Use the Window option to select the 16-color image to work on it.

If the terminal has a 256-color display and you do not wish to load another, 16-color bitmap, click the DON'T SELECT 16-COLOR BMP button to proceed with the operation. If you wish to load a 16-color image as well, click the SELECT 16-COLOR BMP button. Both images load into the display area. The display shows the first image (256-color), and hides the second image (16-color). You can switch between images using the Window option on the Menu Bar.

4. Choose a display Duration for the currently displayed Coupon Selection Screen. This is the number of seconds the terminal screen displays the image before returning to the terminal's customer welcome screen. The duration can be set from 10 through 255 seconds.

5. Now you will assign Receipt Graphic images to one or more Coupon Buttons. Buttons 1 through 3 and 5 through 7 can each have an associated graphic assigned. When the customer presses a Coupon Button on the terminal, the associated graphic prints on a receipt. The customer will only be able to select one coupon item per ATM transaction.

To begin, click a Coupon Button (1-3 or 5-7). A file selection window will appear. Use this window to locate and select a previously created graphic file that conforms to the specifications listed in the section on Image Characteristics. When viewing files, only images that are monochrome and 380x700 pixels will be visible. Once selected, the image filename will appear in the button caption, as in the following example.

6. Repeat Step 5 for any remaining Coupon Buttons you wish to assign.

7. Once the Coupon Selection Screen graphic, Receipt Graphic(s), and Display Duration have been set, save the settings by selecting the File option on the menu bar, then clicking Save As.

   A dialog box will appear. Enter a maximum eight-character name for the file and click the Save button. A file in the Triton Connect Graphic (.TCC) format will be created in the >BMP sub-folder of the Triton Connect installation folder.

8. Use the Ad Graphics/File Manager function to download the coupon file to selected terminals (see Chapter 8, Terminal Parameters, for details on this procedure).

   END OF COUPON UTILITY
CHAPTER 15 - SSL SUPPORT

INTRODUCTION

Triton Connect adds support for SSL for secure communications. To use this feature, a Certificate Authority (CA) such as VeriSign must sign a SSL certificate to support the ATM. If a suitable certificate exists on the Triton Connect server, the user may use it. A sample list of Certificate Authorities supported by the ATM provided below.

- VeriSign/RSA Secure Server
- VeriSign Class 1 Public Primary CA
- VeriSign Class 2 Public Primary CA
- VeriSign Class 3 Public Primary CA
- GTE Cybertrust ROOT
- Thawte Premium Server CA
- Thawte Server CA
- Entrust.net Secure Server CA
- Entrust.net Premium Secure Server CA, also known as Entrust.net CA (2048)

The actual list depends on what the user loads onto the ATM. Check with the ATM’s technical support for a list of supported CAs.

**Note**

To use SSL, configure both the ATM and Triton Connect to support SSL. If uncertain, please check with Triton’s Technical Support to verify if your ATM software version supports SSL.
CREATING A CERTIFICATE SIGNING REQUEST (CSR)

Use a Certificate Signing Request (CSR) to acquire a certificate. After an application generates a CSR, transmit the CSR to a Certificate Authority during the process of applying for a certificate. For Triton Connect, generate a CSR to obtain a new certificate for purposes such as initial setup or if the current certificate will soon expire. For the certificate to perform properly, the CSR’s Common Name field must match the value entered in the ATM as the Triton Connect host in the Triton Connect configuration screen. To create a CSR, perform the following steps.

1. Navigate to the Call Monitor > Settings > SSL Settings.

2. Click the Create CSR button.

3. Enter the value for the Common Name of the certificate. This value matches the Host address entered in the ATM’s Triton Connect Host address.

4. Click the Generate button.

5. Click the Copy Text button to copy the CSR. The Certificate Authority receives the CSR during the process of acquiring a SSL certificate. After the Certificate Authority completes any verification, the requestor will receive a signed CSR.

6. Click the Close button to close this window.
IMPORT CERTIFICATE SIGNING REQUEST

After the selected Certificate Authority processes the CSR and any other information they require, the requestor will receive a signed CSR by either an email with an attached file or download the form from the website. The user can copy and paste into the Triton Connect. Import the signed CSR into Triton Connect to complete the certificate acquisition process.

To import a CSR, perform the following steps.

1. Navigate to the Call Monitor > Settings > SSL Settings.

2. Click the Import CSR button.

3. From the Import Signed CSR window, either click the Paste Text button to paste the signed CSR into the window, or click on the Import Certificate from File button to browse for the certificate file.

4. After the signed CSR inserts into the window, click the Import button to proceed. If a problem occurs an error message appears.

5. If no problems, a success message appears and the window closes.
SELECT CERTIFICATE FOR SSL CONNECTIONS

Once the PC receives the certificate, the user must load the correct certificate into Triton Connect. To select the SSL certificate, perform the following steps.

1. Navigate to the Call Monitor > Settings > SSL Settings.

2. Click the Select Certificate button.

3. In the Certificate Browser window, highlight the desired certificate and click the Select button. This will select the certificate and close the Certificate Browser window.

SET PORT FOR SSL CONNECTIONS

Before Triton Connect can establish an SSL session with the ATM, configure the Inbound SSL Port. To access this screen, perform the following steps.

1. Navigate to the Call Monitor > Settings > TCP/IP Settings.
2. Set the Inbound SSL Port: to the desired port number. Triton Connect or other applications will use the port number. Click the OK button to accept the changes.

![TCP/IP Settings](image)

**ENABLE OR DISABLE SSL**

To change the SSL status, perform the following steps.

1. Navigate to the Call Monitor/Settings > SSL Settings menu.

![Triton Connect Call Monitor](image)

2. To enable SSL, check the Use SSL box. To disable SSL, uncheck the Use SSL box. Click the OK button to save the change and close the window.

![SSL Settings](image)

**ACCEPT SSL CONNECTION REQUESTS**

After performing all the above steps, configure Triton Connect to accept an SSL connection from the ATM, if the ATM uses SSL. Triton Connect automatically enables the callback feature. To allow Triton Connect to accept SSL connection, configure a Call Processor for TCP/IP as normal.

Triton Connect revision 6.1 and 6.2 provides the IP address of the client attempting to connect. If an incoming call uses SSL, the parameters will negotiate and appear in the Call Processor window as shown below.

![End of Terminal Parameters](image)
## TERMINAL PARAMETERS TABLE

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Store Message</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Coupon Random Message</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Coupon Level Message</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Welcome Message</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Marketing Message</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Exit Message</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### MESSAGES / COUPONS

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Master Key Check Digits</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Comms Key Check Digits</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Sequence No.</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>Last Authorization No.</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>Des Chip Loaded</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>Security Module Present</td>
<td>No</td>
</tr>
<tr>
<td>7</td>
<td>Demo Mode</td>
<td>No</td>
</tr>
<tr>
<td>8</td>
<td>Last Dispensed Status</td>
<td>No</td>
</tr>
<tr>
<td>9</td>
<td>Error Code</td>
<td>No</td>
</tr>
</tbody>
</table>

### STATUS

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Iso Numbers</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Terminal Owner</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Surcharge Owner</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Emv Settings</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### ISO STATUS

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Predial</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Modem Init. String</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Host Phone No.</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>Alt Host Phone No.</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>Use 8 Data Bits, No Parity, In Place Of 7 Data Bits, Even Parity For Host Communications</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Remote Key Transfer (Rkt)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### COMM

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Total Debit Transactions</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Total Credit Transactions</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Total Balance Inquiries</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>Total Transfers Done</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>Total Denied Transactions</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>Total Debit Amount</td>
<td>No</td>
</tr>
<tr>
<td>7</td>
<td>Total Credit Amount</td>
<td>No</td>
</tr>
</tbody>
</table>

### TEXT AD SCREENS (Z180 ONLY)

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Text Message</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Display Duration</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Selected Screen</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### AMOUNTS

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Document Value</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Total Transactions</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Cash Loaded</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>Reject Events</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>Dispensed Amounts</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>Cash Remaining</td>
<td>No</td>
</tr>
<tr>
<td>No.</td>
<td>Parameter Name</td>
<td>Changeable?</td>
</tr>
<tr>
<td>-----</td>
<td>----------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1</td>
<td>Document Value</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Total Transactions</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Cash Loaded</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>Reject Events</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>Dispensed Amounts</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>Cash Remaining</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Model No.</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Triton Controller (EPROM) Version No.</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Program Version No.</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>Screen (Table) Version No.</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>Additional Data Info.</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>View Config. Overview</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Files To Remain After 'Send Parameters</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Enable Advertisement Screens</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Overwrite Existing Files On Terminal</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Re-Format Memory Card 1</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Re-Format Memory Card 2</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Scheduling</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>View/Edit Ad (Ad Designer Function)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Change Terminal Master Password</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Change Terminal Admin Password</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>TERMINAL PARAMETERS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------</td>
<td></td>
</tr>
</tbody>
</table>
| **SURCHARGE (Z180 ONLY)** | *(SURCHARGE Screen Read-only)  
**(MODIFY SETTINGS) Button** |
<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Transaction Type</td>
<td>*No / **Yes</td>
</tr>
<tr>
<td>2</td>
<td>Surcharge Enabled</td>
<td>*No / **Yes</td>
</tr>
<tr>
<td>3</td>
<td>Surcharge Amount</td>
<td>*No / **Yes</td>
</tr>
<tr>
<td>4</td>
<td>Will/May</td>
<td>**Yes</td>
</tr>
<tr>
<td>5</td>
<td>Surcharge Percent</td>
<td>*No / **Yes</td>
</tr>
<tr>
<td>6</td>
<td>Display Surcharge Screen After Amount Selection Instead Of Before Selection</td>
<td>**Yes</td>
</tr>
<tr>
<td>7</td>
<td>Use “Greater” In Place Of “Lesser” In Surcharge Screens #7, #8, #10, And #11</td>
<td>*No / **Yes</td>
</tr>
<tr>
<td>8</td>
<td>Screen #</td>
<td>**Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>TRITON CONNECT SETTINGS</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>Parameter Name</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>1</td>
<td>Triton Connect Call Back</td>
</tr>
<tr>
<td>2</td>
<td>TC Max Retries</td>
</tr>
<tr>
<td>3</td>
<td>TC Redial Reply</td>
</tr>
<tr>
<td>4</td>
<td>Triton Connect Primary Phone Number</td>
</tr>
<tr>
<td>5</td>
<td>Triton Connect Backup Phone Number</td>
</tr>
<tr>
<td>6</td>
<td>Alarm Monitor Primary Phone Number</td>
</tr>
<tr>
<td>7</td>
<td>Alarm Monitor Backup Phone Number</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>TERMINAL PARAMETERS</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CONTROL</strong></td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>Parameter Name</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>1</td>
<td>Enable Schedule Close</td>
</tr>
<tr>
<td>2</td>
<td>Close Report Time</td>
</tr>
<tr>
<td>3</td>
<td>Enable Schedules Journal Call</td>
</tr>
<tr>
<td>4</td>
<td>Set Journal Call Time</td>
</tr>
<tr>
<td>5</td>
<td>Enable Call at Number of Journal Records Threshold</td>
</tr>
<tr>
<td>6</td>
<td>Set # Records Threshold</td>
</tr>
<tr>
<td>7</td>
<td>Enable Call at Low Cash Threshold</td>
</tr>
<tr>
<td>8</td>
<td>Set Low Cash Threshold</td>
</tr>
<tr>
<td>9</td>
<td>Stay in Service When Receipt Paper Low</td>
</tr>
<tr>
<td>10</td>
<td>Allow Heartbeat to be Enabled</td>
</tr>
<tr>
<td>11</td>
<td>Enable Heartbeat</td>
</tr>
<tr>
<td>12</td>
<td>Heartbeat Delay Period</td>
</tr>
<tr>
<td>13</td>
<td>Out of Service Settings</td>
</tr>
</tbody>
</table>

<p>| <strong>FORMAT</strong> |  |
|----------------|----------------|---|---|</p>
<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Currency Symbol</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Use “CHEQUING” in Place of “CHECKING”</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Format Transaction Receipt Latin American Style</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Use Date Format DDMMYY in Place of MMDDYY</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### (X3 ATM) EXTENDED PARAMETERS

<table>
<thead>
<tr>
<th>No.</th>
<th>Parameter Name</th>
<th>Changeable?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>FORMAT</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Currency Symbol</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Use “CHEQUING” in Place of “CHECKING”</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Format Transaction Receipt Latin American Style</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Use Date Format DDMMYY in Place of MMDDYY</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>MISC.</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Default Language</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Default Transaction</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Default Account</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Protocol Type</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Message Type</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>User List</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>Schedule Reboot</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>AD DATA (Z180 ONLY)</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Add Ad</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Remove Ad</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Activate Ad</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Activate Screen File</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Edit Schedule/Field</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Move Up/Down</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>COUPONING (Z180 ONLY)</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Coupon Type</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Min. Max. Levels</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Random Percentage</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Coupon Prompt</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Configure Printed Coupon Message, Graphic, Layout</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Configure Dispensed coupon Cassette and Number of Dis-</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>penses</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Enable Award based on ISO properties</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>OPTIONAL SCREENS</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Select Screen Type</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Optional Buttons</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Screen Screen</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>6(X3 ATM) EXTENDED PARAMETERS</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>ANTI-SKIM</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Metal Present Time (sec)</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Metal Absent Time (sec)</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Detection Voltage (mV)</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Warning Voltage (mV)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>DIFFERENTIAL VOLTAGE</strong></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Metal Present Time (sec)</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Metal Absent Time (sec)</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>Detection Voltage (mV)</td>
<td>Yes</td>
</tr>
<tr>
<td>8</td>
<td>Warning Voltage (mV)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>INTERNAL SENSOR</strong></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Enabled</td>
<td>Yes</td>
</tr>
<tr>
<td>10</td>
<td>Delta Card Insertion</td>
<td>Yes</td>
</tr>
<tr>
<td>11</td>
<td>Delta Periodic Polls</td>
<td>Yes</td>
</tr>
<tr>
<td>12</td>
<td>Delta Power Cycle, Low Temp</td>
<td>Yes</td>
</tr>
<tr>
<td>13</td>
<td>Delta Power Cycle, High Temp</td>
<td>Yes</td>
</tr>
<tr>
<td>14</td>
<td>Pol Period [sec]</td>
<td>Yes</td>
</tr>
<tr>
<td>15</td>
<td>Power Cycle Temp Threshold (C)</td>
<td>Yes</td>
</tr>
<tr>
<td>16</td>
<td>Maximum Humidity (%)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### END OF TERMINAL PARAMETERS TABLE